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Document History

i Note

Before you start reading, make sure you have the latest version of this installation guide, which

is available at https:/support.sap.com/sltoolset# | » System Provisioning ¥ Install a System using

Software Provisioning Manager » Installation Option of Software Provisioning Manager 1.0 .

The following table provides an overview on the most important document changes:

Version Date Description
4.5 2023-10-09 Updated version for software provisioning manager 1.0 SP39 (SL Toolset 1.0 SP39)
Windows operating systems no longer supported for software provisioning manager
1.0 SP39 and higher, according to SAP Note 2998013#% , have been removed.
44.1 2023-10-09 Updated version for software provisioning manager 1.0 SP38 (SL Toolset 1.0 SP38):
Last version containing information about no longer supported Windows operating
systems according to SAP Note 3346502 .
44 2023-05-26 Updated version for software provisioning manager 1.0 SP38 (SL Toolset 1.0 SP38)
4.3 2023-02-13 Updated version for software provisioning manager 1.0 SP37 (SL Toolset 1.0 SP37)
4.2 2022-10-10 Updated version for software provisioning manager 1.0 SP36 (SL Toolset 1.0 SP36)
Operating systems and CPU architectures no longer supported according to SAP
Note 2998013#% have been removed.
4.11 2022-10-10 Updated version for software provisioning manager 1.0 SP35 (SL Toolset 1.0 SP35):
Last version containing information about no longer supported operating systems
and CPU architectures according to SAP Note 2998013 .
4.1 2022-05-24 Updated version for software provisioning manager 1.0 SP35 (SL Toolset 1.0 SP35)
4.0 2022-02-14 Updated version for software provisioning manager 1.0 SP34 (SL Toolset 1.0 SP34)
3.9 2021-10-11 Updated version for software provisioning manager 1.0 SP33 (SL Toolset 1.0 SP33)
38 2021-06-21 Updated version for software provisioning manager 1.0 SP32 (SL Toolset 1.0 SP32)
37 2021-02-15 Updated version for software provisioning manager 1.0 SP31 (SL Toolset 1.0 SP31)
36 2020-10-05 Updated version for software provisioning manager 1.0 SP30 (SL Toolset 1.0 SP30)
35 2020-06-08 Updated version for software provisioning manager 1.0 SP29 (SL Toolset 1.0 SP29)
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Version

Date

Description

34

2020-01-20

Updated version for software provisioning manager 1.0 SP28 (SL Toolset 1.0 SP28)

3.3

2019-09-16

Updated version for software provisioning manager 1.0 SP27 (SL Toolset 1.0 SP27)

3.2

2019-05-27

Updated version for software provisioning manager 1.0 SP26 (SL Toolset 1.0 SP26)

31

2019-01-21

Updated version for software provisioning manager 1.0 SP25 (SL Toolset 1.0 SP25)

| Only valid for 'High Availability': HA (Windows)
® New Features

® High-availability system on Microsoft Cluster: Option to install the ASCS
instance distributed to local disks and a file share instead of a shared disk,
documented in: High Availability with Microsoft Failover Clustering

| End of 'High Availability': HA (Windows)

3.0

2018-09-17

Updated version for software provisioning manager 1.0 SP24 (SL Toolset 1.0 SP24)

| Only valid for 'High Availability": HA (Windows)

®* New Features

®* New Look and Feel of SL-Ul with Software Provisioning Manager 1.0 SP24,
Patch Level 05, documented in: New Features, Prerequisites for Running the
Software Provisioning Manager

| End of 'High Availability': HA (Windows)

29

2018-05-07

Updated version for software provisioning manager 1.0 SP23 (SL Toolset 1.0 SP23)

® New Features:
®* New Software Provisioning Manager Option Download Media for a
Maintenance Plan, documented in: New Features, Downloading the Media
for a Maintenance Planner Transaction
® Validity Check for SUM* . SAR Archive, documented in: New Features, Addi-
tional Parameters When Using a Stack XML File
* Information “enqueue server” versus “enqueue server 2", “enqueue replication
server” versus “enqueue replication server 2" added: High Availability with Mi-
crosoft Failover Clustering, System Based on SAP NetWeaver AS for ABAP 7.52
only: Switching to Enqueue Server 2 and Enqueue Replication Server 2
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Version

Date Description

2.8

2018-01-15 Updated version for software provisioning manager 1.0 SP22 (SL Toolset 1.0 SP22)

New Features:

Digital signature check for installation archives, documented in: New fea-
tures, Downloading SAP Kernel Archives (Archive-Based Installation) Ar-
chive-Based Installation for Diagnostics Agent, Downloading the SAP Kernel
Archives Required for the Dual-Stack Split (Without Operating System and
Database Migration), Downloading the SAP Kernel Archives Required for
Operating System and Database Migration

Software provisioning manager Log Files Improvements, documented in:
New Features, Useful Information about the Software Provisioning Manager,
Troubleshooting with the Software Provisioning Manager

Secure ABAP message server connection, documented in: New Features,
SAP System Parameters

Enabling IPv6, documented in: New Features, Prerequisites for Running the
Software Provisioning Manager

New Features section restructured: As of SP22, a dedicated subsection for each

new SP has been created. New features below SP22 remain in a common table.

The Java SDT GUI - which was in the SP21 version still available in parallel to the
SL-Ul - has been deprecated with SP22. As of SP22, SL-Ul is the only available
GUI of the software provisioning manager:

The following sections which were explicitely related to Java SDT GUI were
completely removed from this documentation: Performing a Remote Instal-
lation Remote Processing of the Software Provisioning Manager ( Java SDT
GUIl only), Starting the Java SDT GUI Separately, Running the Software
Provisioning Manager in Accessibility Mode (general accessibility informa-
tion was moved to Useful Information About the Software Provisioning Man-
ager).

The Java SDT GUI-specific information was removed from the common
software provisioning manager sections: Running the Software Provisioning
Manager, Useful Information About the Software Provisioning Manager, In-
terrupted Processing of the Software Provisioning Manager, Troubleshooting
with the Software Provisioning Manager, Deleting an SAP System or Single
Instances

New section Using the Step State Editor (SAP Support Experts Only) was added
to section Additional Information About the Software Provisioning Manager
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Version Date

Description

Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)

New Features:

Media Signature Check, documented in: New Features, Running the Soft-
ware Provisioning Manager, Preparing the Installation Media .

This feature implies that section Creating Kernel Archives from an Existing
SAP System has been deleted from this documentation because the re-
lated option in the software provisioning manager had to be removed.
Download Media for a Maintenance Plan, documented in: New Features,
Downloading Media for a Maintenance Plan

SAP Host Agent Upgrade , documented in: New Features, SAP System Pa-
rameters, Downloading SAP Kernel Archives (Archive-Based Installation)
Load tools are now available as LOADTOOLS . SAR in the Software Provision-
ing Manager archive, documented in: New Features, Downloading and Ex-
tracting the Software Provisioning Manager Archive

Simplified additional application server instance installation, documented
in: New Features, Preparing the Installation Media, Downloading SAP Kernel
Archives (Archive-Based Installation)

Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)

New Features:

New SAPUI5-based graphical user interface (GUI) “SL-UI", documented

in: Prerequisites for Running the Software Provisioning Manager, Running
the Software Provisioning Manager, Useful Information About the Software
Provisioning Manager

Option for choosing to install an embedded gateway during the ASCS
instance installation, documented in: Installation Options Covered by this
Guide, SAP System Parameters, Parameters for Additional Components to
be Included in the ASCS Instance , Post-Installation Checklist, SAP Gateway
Configuration

2.7 2017-09-11
2.6 2017-05-22
2.5 2017-02-07

Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)

New Features:

Verification of the integrity of data units in Software Provisioning Manager,

documented in: New Features, Downloading the Software Provisioning Manager

Archive

Archive-based Language Installation, documented in: Additional Parameters
When Using a Stack XML File
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Version Date Description

2.4 2016-10-07 Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18):

® New Features:
Option to choose installing an embedded SAP Web Dispatcher during the ASCS
instance installation, documented in: ASCS Instance with Embedded SAP Web
Dispatcher [page 30].
Using RMOSSWPM*SAR instead of SWPM*SAR for outdated OS versions not
supported by SAP kernel 740 and higher, documented in: |} Introduction

> Constraints ]

2.3 2016-06-06 Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17):

®* New Features:
“ Archive-Based Installation”, documented in:

®* New Features [page 18]
® Preparing the Installation Media [page 75]|} > Downloading Specific

Installation Archives (Archive-Based Installation) }

2.2 2016-02-15 Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16)
2.1 2015-10-12 Updated version for software provisioning manager 1.0 SPO9 (SL Toolset 1.0 SP15)
20 2015-09-14 Updated version for software provisioning manager 1.0 SPO9 (SL Toolset 1.0 SP14)
19 2015-04-27 Updated version for software provisioning manager 1.0 SPOS8 (SL Toolset 1.0 SP13)
18 2014-11-24 Updated version for software provisioning manager 1.0 SPO7 (SL Toolset 1.0 SP12)
17 2014-07-07 Updated version
16 2014-03-17 Updated version
1.5 2013-10-28 Updated version
14 2013-07-15 Updated version
1.3 2013-04-02 Updated version
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1 About this Document

This installation guide describes how to install an SAP system based on the application server ABAP of SAP
NetWeaver 7.3 EHP1 to 7.52 using the installation tool software provisioning manager 1.0 SP39, which is part of
SL Toolset 1.0 SP39.

This guide covers the SAP system products and releases listed in SAP Products Based on SAP NetWeaver 7.3
EHP1 to 7.52 Supported for Installation Using Software Provisioning Manager 1.0 [page 12].

i Note

As an alternative to using Software Provisioning Manager, you can install your system

with a completely automated end-to-end framework available using SAP Landscape
Management. For more information, see SAP Note 1709155# and https://help.sap.com/docs/
SAP_LANDSCAPE_MANAGEMENT_ENTERPRISE# .

For information about maintenance of SAP Business Suite and corresponding SAP NetWeaver versions, see
SAP Note 1648480 #% .

For information about supported operating system and database platforms for the SAP product you want to
install, see the Product Availability Matrix at http://support.sap.com/pam#

A\ Caution

Make sure you have read Before You Start [page 15] before you continue with this installation guide.

SAP Products Based on SAP NetWeaver 7.3 EHP1 to 7.52 Supported for Installation Using Software
Provisioning Manager 1.0 [page 12]
Here you can find a list of the SAP products based on SAP NetWeaver 7.3 EHP1 to 7.52 ABAP that are
supported for installation using Software Provisioning Manager 1.0, on the specific operating system
and database combination described in this guide.

Naming Conventions [page 12]
This section lists the naming conventions that are currently apply for the software provisioning
manager 1.0 and terms used in this documentation.

Constraints [page 13]
This section lists the naming constraints that are currently valid for the software provisioning manager
1.0 and this documentation.

Before You Start [page 15]
Make sure that you have read the release-specific “Master Guide" for your SAP Business Suite
application, SAP NetWeaver application , or SAP Solution Manager system before you continue with
this installation guide.

SAP Notes for the Installation [page 16]
This section lists the most important SAP Notes relevant for an installation using Software Provisioning
Manager

New Features [page 18]
This section provides an overview of the new features in software provisioning manager 1.0.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
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1.1

SAP Products Based on SAP NetWeaver 7.3 EHP1 to 7.52

Supported for Installation Using Software Provisioning

Manager 1.0

Here you can find a list of the SAP products based on SAP NetWeaver 7.3 EHP1 to 7.52 ABAP that are
supported for installation using Software Provisioning Manager 1.0, on the specific operating system and

database combination described in this guide.

SAP Product

Based on the following SAP NetWeaver Release

SAP Business Suite 7i 2016:

® EHP4 for SAP CRM 7.0 ABAP
® EHPS for SAP ERP 6.0 ABAP

®* EHPS8 for SAP ERP 6.0 ABAP including SAP S/4HANA
Finance 1605 SP0O3

® EHP4 for SAP SRM 7.0 ABAP
® EHPA4 for SAP SCM 7.0 ABAP

SAP NetWeaver 7.5
SAP NetWeaver 7.4 Support Release 2

SAP NetWeaver 7.3 EHP1

SAP Business Suite 7i 2013 Support Release 2:

® EHP3for SAP CRM 7.0 ABAP Support Release 2
® EHP7 for SAP ERP 6.0 ABAP Support Release 2

SAP NetWeaver 7.5

SAP NetWeaver 7.4 Support Release 2

SAP NetWeaver 7.3 EHP1
® EHP7 for SAP ERP 6.0 ABAP including SAP Simple Fi-
nance 1.0 /1503
® EHP3for SAP SRM 7.0 ABAP Support Release 2
® EHP3for SAP SCM 7.0 ABAP Support Release 2
SAP NetWeaver 7.5 SAP NetWeaver 7.5

SAP Solution Manager 7.2 Support Release 2

SAP NetWeaver 7.4 Support Release 2

AS ABAP 7.4, OEM version 1.0

SAP NetWeaver 7.4 Support Release 2

SAP NetWeaver 7.4 Support Release 2

SAP NetWeaver 7.4

1.2 Naming Conventions

This section lists the naming conventions that are currently apply for the software provisioning manager 1.0

and terms used in this documentation.

* The software provisioning manager 1.0 is the successor of the product- and release-specific delivery of

provisioning tools, such as “SAPinst".

Before you perform an installation from scratch or a target system installation in the context of a system
copy, we strongly recommend that you always download the latest version of the software provisioning

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
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manager 1.0 which is part of the Software Logistics Toolset 1.0 (“SL Toolset” for short). For more
information, see Preparing the Installation Media [page 75].

This way, you automatically get the latest version with the latest fixes of the tool and supported
processes. For more information about the software provisioning manager 1.0 as well as products

and releases supported by it, see SAP Note 1680045#% and https://wiki.scn.sap.com/wiki/display/SL/
Software+Provisioning+Manager+1.0+and+2.0 ¥

The “SAPinst” tool has been renamed to “software provisioning manager”, but the terms “SAPinst” and
“sapinst” are still used in:

* The name of the technical framework of the software provisioning manager. For more information
about the current SAPinst Framework version, see SAP Note 3207613#% (SAPinst Framework 753
Central Note).

¢ Texts and screen elements in the the software provisioning manager's SL-Ul

* Names of executables, for example sapinst.exe

* Names of command line parameters, for example SAPINST_STACK_XML

* ‘“usage type”, “technical usage”, and “product instance”
As of software provisioning manager 1.0 SPO7 (SL Toolset 1.0 SP12), the term “product instance” replaces
the terms “ usage type” and “technical usage”. For more information, see SAP Note 1970349 ¥ .
For more information, see New Features [page 18].

¢ “SAP system” refers to SAP system based on the application server of 7.3 including Enhancement Package
1/ Application Server ABAP 74 / SAP NetWeaver 74 / SAP NetWeaver 7.5 / SAP NetWeaver Application
Server for ABAP 7.51 innovation package / SAP NetWeaver Application Server for ABAP 7.52 .

* “Diagnostics Agent” refers to the SAP Solution Manager Diagnostics Agent which is the remote component
of End-to-End Root Cause Analysis. It allows having a connection between SAP Solution Manager and
managed systems, and then to collect information from the managed systems for reporting purposes.

* Profiling for High Availability

[ Only valid for 'High Availability": HA (Windows)

The profile bars with the wording Only valid for: HA (Windows) — for example, as in this section — refer

to content that is only valid if you are installing a high-availability (HA) system with Microsoft Failover
Clustering. The Windows Server Failover Clustering feature was previously called Microsoft Cluster Service
(MSCS). For practical reasons we are continuing to use the abbreviation MSCS in the profile bars and in
some sections of this guide.

l End of 'High Availability': HA (Windows)

* “SAP liveCache” refers to “SAP MaxDB liveCache”.
* “SAP liveCache client” refers to “SAP MaxDB liveCache client”.

1.3 Constraints

This section lists the naming constraints that are currently valid for the software provisioning manager 1.0 and
this documentation.

¢ Effective immediately, the software provisioning manager no longer supports the deprecated Windows
operating system versions 2998013 listed in SAP Note 2998013 #r .
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i Note

* |f your current operating system is listed as deprecated in SAP Note 2998013 %%, we strongly
recommend that you migrate to a supported platform.

* If you continue to run Software Provisioning Manager on the deprecated Windows operating
system versions listed in SAP Note 2998013, you do so at your own risk and without support
from SAP. The software provisioning manager 1.0 SP39 and higher will still run on the deprecated
Windows operating system versions listed in SAP Note 2998013#% but it may run into an error.
When you start the software provisioning manager, you will see a warning like the following:
“Platform Support : Support for SAP JVM on Windows Server 2012 (R2) ends October 31th, 2023.
See SAP note 2998013.” If you run into an issue, you must use the “frozen” software provisioning
manager 1.0 SP38 software and the related installation guide. For more information, see SAP Note
3346502¢ .

Effective immediately, the software provisioning manager no longer supports the deprecated operating
system versions 2998013 listed in SAP Note 2998013 #r .

i Note

* |f your current operating system is listed as deprecated in SAP Note 2998013 %, we strongly
recommend that you migrate to a supported platform.

* If you continue to run Software Provisioning Manager on the deprecated operating system versions
listed in SAP Note 29980134, you do so at your own risk and without support from SAP. The
software provisioning manager 1.0 SP36 and higher will still run on the deprecated operating
system versions listed in SAP Note 2998013 but it may run into an error. When you start
the software provisioning manager, you will see a warning like the following: “Platform Support :
Support for SAP JVM on Windows Server 2008 (R2) ends January 14th, 2022. See SAP note
2998013." If you run into an issue, you must use the “frozen” software provisioning manager 1.0
SP35 software and the related installation guide. For more information, see SAP Note 3220901 ¥ .

End of support for SAP products based on SAP NetWeaver 7.10, 7.11, 7.20, 7.30, 740 SR1
i Note

SAP products based on SAP NetWeaver 7.10, 7.11, 7.20, 7.30, 740 SR1 (with the exception of SAP
Solution Manager 7.2 ABAP, which will continue to be supported ) are only supported in mainstream
maintenance until the end of 2020. Extended maintenance will not be provided.

For more information, see SAP Note 2980160 #& .

You can download the last published version of the guide set for the last Software Provisioning
Manager 1.0 SP30 for out-of-maintenance products (SWPM10RMSP30_<Version>.SAR) from SAP
Note 2980160#% . The guide set attached to SAP Note 2980160#% covers only the SAP product
versions which have reached end of maintenance.

The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System
ID <SAPSID>, common startup framework, common database), is no longer supported in SAP systems
based on SAP NetWeaver 7.5. So if you want to install a new SAP NetWeaver 7.5 Process Integration (PI)
system which is based on SAP NetWeaver 7.5, do not use the documentation Installation Guide - SAP
Systems Based on the Application Server ABAP+Java of SAP NetWeaver on <OS>: <DB>. Instead, use
the Installation Guide - SAP Systems Based on the Application Server ABAP of SAP NetWeaver on <OS>:
<DB> to install the ABAP stack with its own <SAPSID> and the Installation Guide - SAP Systems Based
on the Application Server Java of SAP NetWeaver on <OS>: <DB> to install the Java stack with its own
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<SAPSID>. For more information, see the implementation sequence in the Master Guide - SAP NetWeaver
7.5 at http:/help.sap.com/netweaver#r | » <Release> » Installation and Upgrade 3.

* Not all SAP NetWeaver releases or SAP Business Suite applications that are available in Software
Provisioning Manager 1.0 and are described in this installation guide have already been released. Always
check the list of supported products [page 12] and SAP Note 1680045#% to ensure that the installation
options you want to perform are already supported. For information about supported operating system
and database platforms, see the Product Availability Matrix at http://support.sap.com/pam# .

* Note that a complete system installation from scratch is not available for every product. For some products
- such as SAP NetWeaver 7.5 - a complete new system installation from scratch is only provided for the
highest support release. If there are one or more support releases, then a complete system installation is
only available for the highest of these support releases. As for the lower support releases, only options for
system copy and additional application server instances are provided.

* Your operating system platform must be 64-bit.

¢ Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 ¥ .

1.4 Before You Start

Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP
NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

The “Master Guide" is the central document leading you through the overall implementation process for your
SAP system installation. It contains crucial information about the overall implementation sequence, that is
activities you have to perform before and after the installation process described in this installation guide.

You can find a printed version of this guide in your installation package or you can download the latest version
from https://help.sap.com.

The following table lists the “Master Guide” of the SAP system application for which you can use this
installation guide, along with the available quick link or path to the appropriate download location:

Document Internet Address

Master Guide — SAP NetWeaver AS for ABAP 7.52  http://help.sap.com/nw752abap

| ¥ Installation and Upgrade 3

Master Guide — SAP NetWeaver AS for ABAP 7.51  http://help.sap.com/nw75labap P

innovation package
|} > Installation and Upgrade ]

Master Guide — SAP NetWeaver 7.5 http://help.sap.com/nw75 P

| ¥ Installation and Upgrade 3
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Document

Internet Address

Master Guide — SAP Solution Manager 7.2

http://help.sap.com/solutionmanager i

|} > 7.2 <SP> > Installation and Upgrade ]

Master Guide SAP Supply Chain Management

70 <Including SAP Enhancement Package

<Number> Powered by SAP NetWeaver

http://help.sap.com/scm P

|# » <rRelease> ¥ Installation and Upgrade 3

Master Guide (Including Upgrade Information)
- SAP Customer Relationship Management 7.0
<Including SAP Enhancement Package

<Number>

http://help.sap.com/crm P

|# » <rRelease> ¥ Installation and Upgrade 3

Master Guide (Including Upgrade Information)
- SAP Supplier Relationship Management 7.0
<Including SAP Enhancement Package
<Number>

http://help.sap.com/srmr

|} > <Release> > Installation and Upgrade }

Master Guide - SAP Enhancement Package
<Number> for SAP ERP 6.0

http://help.sap.com/erp

|} > <Release> > Installation and Upgrade }

Master Guide — SAP Enhancement Package 1 for

SAP NetWeaver 7.3

http://help.sap.com/nw731#

|} > Installation and Upgrade ]

1.5 SAP Notes for the Installation

This section lists the most important SAP Notes relevant for an installation using Software Provisioning

Manager

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most

recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at https:/

support.sap.com/notes .

SAP Notes for the Installation

SAP Note Number Title

Description

1680045
ager 1.0

Release Note for software provisioning man-

software provisioning manager 1.0 with installa-

tion and system copy for SAP NetWeaver-based

systems
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SAP Note Number

Title

Description

1710950 i Inst. SAP Systems Based on SAP NetWeaver Windows-specific information about the SAP sys-
7.1 and higher: Windows tem installation and corrections to this documen-
tation
2365014 P Installation of SAP Systems Based on SAP Platform-specific information about the SAP sys-
NetWeaver: SAP MaxDB tem installation (ABAP and Java) and corrections
to this documentation
820824 FAQ: SAP MaxDB/liveCache technology Frequently asked questions (FAQ) on SAP MaxDB
2384179 P Planned support of Windows Server 2016 for Windows Server 2016-specific information for the
SAP products SAP system installation
2751450 P SAP Systems on Windows Server 2019 Windows Server 2019-specific information for the
SAP system installation
3143497 P SAP Systems on Windows Server 2022 Windows Server 2022-specific information for the
SAP system installation
73606 P Supported Languages and Code Pages Information on possible languages and language
combinations in SAP systems
1067221 P Composite SAP Note for heterogeneous instal- This SAP Note and its related SAP Notes de-
lation scribe the released operating system and data-
base combinations for heterogeneous SAP sys-
tems landscapes.
789220 M Support Package levels for SAP NetWeaver in-  Information about the ABAP Support Package
stallations/upgrades levels and kernel patch levels contained in the
current SAP NetWeaver release
819722 Support Package levels for SRM installa- Information about the ABAP Support Package
tions/upgrades levels and kernel patch levels contained in the
current SAP SRM release
774615 P Support Package levels of ERP/ECC installa- Information about the ABAP Support Package
tions/upgrades levels and kernel patch levels contained in the
current SAP ERP release
837413 " Support Package levels for CRM installa- Information about the ABAP Support Package
tions/upgrades levels and kernel patch levels contained in the
current SAP CRM release
850038/ Support Package levels for SCM/APOQ installa-  Information about the ABAP Support Package

tions/upgrades

levels and kernel patch levels contained in the
current SAP SCM release
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SAP Note Number

Title Description

1990240 ¥ Support of mixed landscapes (Unicode and Temporarily your system landscape is mixed with
Non-Unicode) Unicode and Non-Unicode systems. You have

third party software in your system landscape
which does not support Unicode at all. You won-
der whether such a heterogeneous system land-
scape is supported without restrictions.

886535Mr Downloading multispanning archives Downloading multispanning archives

1553465 M Installation requirements for SAP kernels on Information about VCredist version

Windows (C++ runtime environment, VCredist
versions)

1.6 New Features

This section provides an overview of the new features in software provisioning manager 1.0.

Make sure that you also read the Release Notes for your SAP product at https:/help.sap.com# [ <Search
your SAP Product> » <Select your SAP Product Version>» What's New 1.

Feature

Description

Availability

Separate SAP Glob-
alhost

During the installation of an SAP system distributed over several
hosts, you can now specify that the SAP Global directories are
installed on a host different from the ASCS instance host. For
more information, see SAP Note 3349121 #%r .

software provisioning manager
1.0 SP39 (SL Toolset 1.0 SP39)

New SAPinst Frame-

work Version 753

The SAPinst framework patch level has been upgraded from ver-
sion 749 (SAP Note 2393060 " SAPinst Framework 749 Central

Note) to 753. For more information, see SAP Note 3207613 SA-
Pinst Framework 753 Central Note.

software provisioning manager
1.0 SP36 (SL Toolset 1.0 SP36)

Installation require-
ments for SAP ker-
nels on Windows
(C++ runtime envi-
ronment, VCredist
versions)

Manual subsequent installation of the VCredist files by custom-
ers may be required during the installation of SAP kernels that
are based on specific versions. For more information, see Require-
ments for the SAP System Hosts [page 40].

software provisioning manager
1.0 SP34 (SL Toolset 1.0 SP34)

Switch from
7.21_EXT Kernel to
7.22_EXT Kernel

Kernel 7.21 has reached end of maintenance. In addition, some
issues have been fixed with the new 7.22_EXT kernel media.

software provisioning manager
1.0 SP31 (SL Toolset 1.0 SP31)

Configuring the
Number of Work
Processes during
the Installation

You can now enter the number of work processes interactively
when performing an installation in custom mode.

For more information, see Basic Installation Parameters [page
471.

software provisioning manager
1.0 SP30 (SL Toolset 1.0 SP30
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Feature

Description

Availability

High-availability sys-
tem on Microsoft
Cluster: Option to
install the ASCS in-
stance in a file share
on a local disk.

As an alternative to the “classic” way to install the ASCS instance
on a shared disk, you can now choose to install the ASCS instance
in a file share on a local disk. For more information, see High
Availability with Microsoft Failover Clustering [page 188].

software provisioning manager
1.0 SP25 (SL Toolset 1.0 SP25)

New Look and Feel
of SL-UlI

As of version 1.0 SP24 Patch Level (PL) 5, the software provision-
ing manager comes with a new look and feel of the SL-Ul. For
more information, see https://blogs.sap.com/2018/11/10/new-
Iook—for—software—provisioning—manager/i‘hr.

software provisioning manager
1.0 SP24, PLO5 (SL Toolset 1.0
SP24)

New software pro-
visioning manager
Option Download
Software Packages
for Maintenance
Planner Transaction

If you perform an installation using a Stack XML file,

you can now download media according to a Mainte-

nance Plan. For more information, see Installation Using a
Stack XML File [page 36], Downloading Software Pack-

ages for a Maintenance Planner Transaction [page 86],

and https://blogs.sap.com/2018/06/01/software-provisioning-
manager-new-option-for-standalone-download-service/ P

software provisioning manager
1.0 SP23 (SL Toolset 1.0 SP23)

Validity Check for
SUM*_SAR Archive

If you perform an installation using a Stack XML file and choose
to extract the SUM* . SAR archive, the validity of this archive is

now checked by the software provisioning manager. For more
information , see entry Extract the SUM* . SAR Archive in Additional
Parameters When Using a Stack XML File [page 61].

software provisioning manager
1.0 SP23 (SL Toolset 1.0 SP23)

Secure ABAP Mes-
sage Server Con-
nection

The software provisioning manager now uses secure connections
to the ABAP message server of the SAP system being installed.
For more information, see the ABAP Message Server Port entry
within the Ports table in SAP System Parameters [page 48].

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

software provision-
ing manager Log
Files Improvements

software provisioning manager log files are now available immedi-
ately after software provisioning manager has been started, that
is before a product has been selected on the Welcome screen.
For more information, see Useful Information about Software Pro-
visioning Manager [page 102] and Troubleshooting with Software

Provisioning Manager [page 113].

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

Digital Signature
Check of Installation
Archives

The digital signature of installation archives is checked auto-
matically by software provisioning manager during the Define
Parameters phase while processing the Software Package Browser
screens. As of now software provisioning manager only accepts
archives whose digital signature has been checked. For more in-
formation, see Downloading SAP Kernel Archives (Archive-Based

Installation) [page 83] .

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)
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Feature

Description

Availability

LOADTOOLS.SAR
archive in software
provisioning man-
ager enabled for
NUC

The load tools in

SWPM10SP<Support_Package_ Number>_<Version_Number>
_SAR are now also enabled for an installation using non-Unicode
(NUC) SAP kernel version 7.40 or higher.

For more information, see Downloading and Extracting the Soft-
ware Provisioning Manager 1.0 Archive [page 80]

i Note

This feature enhances feature LOADTOOLS . SAR archive

in Software Provisioning Manager of software provision-

ing manager 1.0 SP21 (SL Toolset 1.0 SP21) (see entry
LOADTOOLS. SAR archive in software provisioning manager
below in this table).

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

Enabling IPv6

You can now set up a new SAP system or SAP system instance
using Internet Protocol Version 6 (IPv6).

For more information, see Prerequisites for Running Software Pro-

visioning Manager [page 93].

software provisioning manager
1.0 SP22 (SL Toolset 1.0 SP22)

Media Signature
Check

The digital signature of media is checked automatically by the
software provisioning manager during the Define Parameters
phase while processing the Media Browser screens. The software
provisioning manager only accepts media whose digital signature
has been checked.

For more information, see Preparing the Installation Media [page
75] and Running the software provisioning manager [page 95].

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

SAP Host Agent Up-
grade During the In-
stallation (Optional)

During the Define Parameters phase of the installation, software
provisioning manager prompts you whether you want to upgrade
an existing version of the SAP Host Agent on the installation host.
If there is no SAP Host Agent on the installation host, it is installed
automatically without prompt. For more information, see the Gen-
eral Parameters table in SAP System Parameters [page 48] .

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

Simplified Addi-
tional Application
Server Instance In-
stallation

During an additional application server installation, SAP kernel
archives are only prompted if they cannot be retrieved from the
primary application server instance of the existing SAP system.
For more information, see Preparing the Installation Media [page
75].

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)
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Feature

Description

Availability

LOADTOOLS.SAR
archive in software
provisioning man-
ager

An up-to-date version of the load tools - such as R3load,
R3szchk, R31dctl, SAPuptool - which were available so far only
in the SAPEXEDB . SAR archive of the kernel media, has now been
made available in the software provisioning manager archive. For
more information, see SAP Note 2472835/ . For an installation
using Unicode kernel version 7.40 or higher, the load tools from
the

SWPM10SP<Support_Package Number>_<Version_Number>
_SAR are used automatically.

For more information, see Downloading and Extracting the Soft-
ware Provisioning Manager 1.0 Archive [page 80]

software provisioning manager
1.0 SP21 (SL Toolset 1.0 SP21)

SL-Ul with SAPINST
749

With the new software provisioning manager framework version
SAPINST 7.49, you can now use the new SAPUI5-based graphical
user interface (GUI) “SL-Ul". For more information, see Useful In-
formation about Software Provisioning Manager [page 102], Run-
ning Software Provisioning Manager [page 95] .

software provisioning manager
1.0 SP20 (SL Toolset 1.0 SP20)

Option toinstall an
SAP Gateway in an
ASCS instance

You can now install an SAP Gateway in an ASCS instance. You can
choose this option while running the ASCS instance installation.

For more information, see ASCS Instance with Embedded Gate-
way [page 32]

software provisioning manager
1.0 SP20 (SL Toolset 1.0 SP20)

Verification of Integ-
rity of Data Units in
software provision-
ing manager

The integrity of data units extracted from the software provision-
ing manager archive is verified. For more information, see Down-
loading and Extracting the Software Provisioning Manager 1.0 Ar-
chive [page 80].

In addition, check SAP Note 1680045 "% whether additional infor-
mation is available.

software provisioning manager
1.0 SP19 (SL Toolset 1.0 SP19)

Archive-based Lan-
guage Installation

If you perform an installation using a Stack XML file, you can now
add language archives to the download basket and use them for
language installation. This feature is currently restricted to the
latest products only. For more information, see Additional Param-
eters When Using a Stack XML File [page 61]

software provisioning manager
1.0 SP19 (SL Toolset 1.0 SP19)

Option to install an
SAP Web Dispatcher
in an ASCS instance

You can now install an SAP Web Dispatcher in an ASCS instance.
You can choose this option while running the ASCS instance in-
stallation.

For more information, see ASCS Instance with Embedded SAP
Web Dispatcher [page 30]

software provisioning manager
1.0 SP18 (SL Toolset 1.0 SP18)

Archive-Based In-
stallation

You can now download the required installation archives instead
of the complete SAP kernel installation media. For more informa-
tion, see section Downloading Specific Installation Archives (Ar-
chive-Based Installation) in Preparing the Installation Media [page
75].

software provisioning manager
1.0 SP17 (SL Toolset 1.0 SP17)
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Feature

Description Availability

Diagnostics Agent

The Diagnostics Agent is no longer installed automatically with software provisioning manager
the SAP system. The Install Diagnostics Agent check box on the 1.0 SP10 (SL Toolset 1.0 SP16)
Install Diagnostics Agent screen is no longer available.

You now have to install the Diagnostics Agent always separately.
We recommend that you install it prior to the installation of your
SAP system(s).

For more information, see the Diagnostics Agent Installation
Strategy attached to SAP Note 1365123 #%, to SAP Note
1833501#%, and to SAP Note 1858920#% and the attached Diag-
nostics Agent Setup Guide.

System Provision-
ing for SAP
NetWeaver 7.5 and

SAP NetWeaver 7.5-

based Products

All system provisioning tasks (installation, system copy, system software provisioning manager
rename) are available for the new SAP NetWeaver 7.5 release. 1.0 SPO9 (SL Toolset 1.0 SP15)

The Dual Stack option, which integrates an AS ABAP and AS
Javain a single system (common System ID <SAPSID>, common
startup framework, common database), is no longer supported in
SAP systems based on SAP NetWeaver 7.5.

® After upgrading to SAP NetWeaver 7.5 PI, you first have to
split the still existing dual stack-system before you can use
SAP NetWeaver 7.5 Pl productively.
For more information, see the Upgrade Master Guide - SAP

NetWeaver 7.5 at: http://help.sap.com/nw75 |} > Installation

and Upgrade }

® SAP NetWeaver 7.5 is Unicode only

® The primary application server instance direc-
tory has been renamed from Zusr/sap/<SAPSI1D>/
DVEBMGS<Instance_Number>to /usr/sap/<SAPSID>/
D<Instance_Number>.
For more information, see SAP Directories [page 163].

® Declustering and depooling of tables during the installation
is enabled by default. For more information, see SAP Note
1892354 F%r .

System Provisioning All system provisioning tasks (installation, system copy, system software provisioning manager

for SAP Solution rename) are available for the new SAP Solution Manager 7.2 1.0 SPO9 (SL Toolset 1.0 SP15)
Manager 7.2 release. Compared to previous SAP Solution Manager releases,
SAP Solution Manager 7.2 is no longer provided as a classical
dual-stack system (ABAP system with Java Add-in), but consists
of a separate ABAP and Java stack.
Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1 to 7.52 on Windows: SAP MaxDB
22 PUBLIC About this Document


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1365123
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1833501
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1858920
http://help.sap.com/nw75
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1892354

Feature Description Availability

Windows Domain You can now specify an optional organizational unit (OU) within software provisioning manager
Organizational Units the Windows domain where you want software provisioning man- 1.0 SPO9 (SL Toolset 1.0 SP14)
ager to create the SAP system accounts.

For more information, see SAP System Parameters [page 48].

Creating Kernel Ar-  You can reuse the binaries of a dedicated SAP system for a new software provisioning manager
chives from existing  SAP system installation or target system installation in the con- 1.0 SPO9 (SL Toolset 1.0 SP14)
SAP System text of a system copy by creating *.SAR archives based on the

*_Ist files from the executable (exe) directories of the source

SAP system.

i Note

This feature is only available for Unicode systems.

A Caution

This feature has been deprecated with Software Provisioning
Manager 1.0 SP21 (SL Toolset 1.0 SP21) and the related op-
tion has been removed from the Welcome screen. This depre-
cation has been accomplished to ensure compliancy with the
new feature “Media Signature Check” of Software Provision-
ing Manager 1.0 SP21 (SL Toolset 1.0 SP21) described above
in this table.

Installation Usinga  You can start software provisioning manager using a Stack XML software provisioning manager
Stack XML File file generated by the Maintenance Planner. The configuration pa- 1.0 SPO7 (SL Toolset 1.0 SP12)
rameters in this file can then be used by software provisioning
manager to improve the integration with SUM and to simplify the
process of installation for a new system on target software level.

For more information, see Installation Using a Stack XML File
[page 36].

Adaptive Installation You can assign virtual host names to SAP system instances during software provisioning manager
the input phase of the installation directly on the screens where 1.0 SPO7 (SL Toolset 1.0 SP12)
you define the instance parameters.

For more information, see SAP System Parameters [page 48].

Feedback Evaluation SAP SE's aim is to provide fast and efficient procedures. To eval-  software provisioning manager
Form uate the procedure you just carried out, we need information 1.0 SPO7 (SL Toolset 1.0 SP12)
generated by the tool during process execution and your experi-
ence with the tool itself. A new evaluation form contains a simple
questionnaire and XML data generated during the procedure.

Port 4239 is used for displaying the feedback evaluation form.
For more information, see Prerequisites for Running Software Pro-
visioning Manager [page 93].
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Feature Description Availability

Option Verify Signed The digital signature ensures that the signatory of a digital docu-  software provisioning manager
Media ment can be identified unambiguously and signatory’s name is 1.0 SPO6 (SL Toolset 1.0 SP11)
documented together with the signed document, the date, and
the time.

For more information, see SAP Note 1979965 #% .
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2 Installation Options Covered by this
Guide

This section shows the installation options covered by this installation guide. You have to decide what exactly
you want to install because the steps you have to perform vary according to the installation option you choose.

After you have decided on the installation option that you want to use, continue with Planning [page 35].
Standard System [page 25]
Distributed System [page 26]
High Availability System [page 27]
Additional Application Server Instance [page 27]

Splitting off an ABAP Central Services Instance from an Existing Primary Application Server Instance [page
29]

ASCS Instance with Embedded SAP Web Dispatcher [page 30]
ASCS Instance with Embedded Gateway [page 32]

2.1 Standard System

You can install a standard system on a single host.

There are the following instances:

¢ ABAP Central services instance (ASCS instance)
Contains the ABAP message server and the Standalone Enqueue Server
In a standard
* Optionally, you can install the ASCS instance with an embedded SAP Web Dispatcher. For more
information, see ASCS Instance with Embedded SAP Web Dispatcher [page 30].
* Optionally, you can install the ASCS instance with an embedded gateway. For more information, see
ASCS Instance with Embedded Gateway [page 32].
* Database instance (DB)

* Primary application server instance (PAS instance)
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Host

Primary ABAP Central
Application Services

Server Instance
Instance (PAS) (ASCS)

Database Instance (DB)

ABAP
Schema

Standard ABAP System
2.2 Distributed System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and
stopped at the same time.

In a distributed system, every instance can run on a separate host.
A distributed system consists of the following instances:

¢ ABAP Central services instance (ASCS instance)
Contains the ABAP message server and the Standalone Enqueue Server

* Optionally, you can install the ASCS instance with an embedded SAP Web Dispatcher. For more
information, see ASCS Instance with Embedded SAP Web Dispatcher [page 30].

* Optionally, you can install the ASCS instance with an embedded gateway. For more information, see
ASCS Instance with Embedded Gateway [page 32].

* Database instance (DB)
The ABAP stack uses its own database schema in the database.

* Primary application server instance (PAS)
The following figure assumes the following:

* The ASCS and primary application server instance run on the SAP global host.
* You can also install the primary application server instance on a separate host.
® The global transport directory resides on a separate SAP transport host.

* During the installation of an SAP system distributed over several hosts, you can now specify that the SAP
Global directories are installed on a host different from the ASCS instance host. For more information, see
SAP Note 3349121 /% .

Optionally, you can install one or more additional application server instances. For more information, see
Installation of an Additional Application Server Instance [page 27].
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SAP Global Host

ABAP
Central
Services
Instance
(ASCS)

Database Instance Host with Global Primary Application
Host Transport Directory Server Instance Host
(SAP Trans Host,
Optional)

Primary Application
Server Instance

\‘\____’_/’
(PAS)

Distributed ABAP System

2.3 High Availability System

For more information about the system components you have to install and how to distribute them on the
specific hosts, see System Configuration with Microsoft Failover Clustering [page 191].

2.4 Additional Application Server Instance

You can install one or more additional application server instances for an existing SAP system. Additional
application server instances are optional and can be installed on separate hosts.

An additional application server instance can run on:

* The host of any instance of the existing SAP system
* Onadedicated host

i Note

We do not recommend installing additional application server instances on the SAP global host.

i Note

If you want to install an additional application server instance on an existing SAP system, you must perform
a domain installation. You must also make sure that your existing SAP system was installed as a domain
installation. For more information, see Domain or Local Installation [page 46].
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Additional Application Server Instance for a Standard System

The following figure shows additional application server instances that are running on dedicated hosts.

Global Host with PAS, ASCS, and

DB

ABAP
Central
Services

Primary
Application
Server

Instance
(ASCS)

Instance
(PAS)

Database Instance (DB)

ABAP
Schema

Additional Application
Server Instance Host

Additional

Application Server
Instance (AAS)

Additional Application Server Instance for a Standard ABAP System

For more information, see Standard System [page 25].

Additional Application Server Instance for a Distributed System

The following figure shows additional application server instances that are running on dedicated hosts.
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SAP Global Host

ABAP
Central
Services
Instance
(ASCS)

Database Instance Host with Global Primary Application Additional
Host Transport Directory Server Instance Host Application Server
(SAP Trans Host, Instance Host
Optional)

- Primary
Application Server

ABAP

Schema

Additional

Instance (PAS)

Application Server
Instance (AAS)

Additional Application Server Instance for a Distributed ABAP System

For more information, see Distributed System [page 26].

| Only valid for 'High Availability': HA (Windows)

Additional Application Server Instance for a High-Availability System

In a high-availability system, you require, apart from the primary application server instance, at least one
additional application server instance. For more information about how to install and distribute the application
servers in an HA configuration, see section System Configuration with Microsoft Failover Clustering [page 191].

| End of 'High Availability': HA (Windows)

2.5 Splitting off an ABAP Central Services Instance from an
Existing Primary Application Server Instance

The ABAP central services instance (ASCS instance) consists of the essential enqueue and message system
services only. This has been standard for the Java stack and is now also standard for the ABAP stack.

The benefit of having a separate ASCS instance is mainly in the area of high-availability. This approach
concentrates the possible single points of failure of a system into a single instance and, therefore, restricts
failure to a single instance.

Every newly installed SAP system based on SAP NetWeaver 7.3 and higher is automatically installed with an
ASCS instance, even if you install all SAP system instances on one host (standard system).
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However, if you upgraded your SAP system from a release based on a SAP NetWeaver release lower than 7.3,
your SAP system might not yet have a separate ASCS instance.

The section Splitting Off an ABAP Central Services Instance from an Existing Primary Application Server
Instance [page 173] describes how you can move the message server and the enqueue work process from
an existing primary application server instance to a newly installed ABAP central services instance (ASCS
instance).

2.6 ASCS Instance with Embedded SAP Web Dispatcher

You can install an SAP Web Dispatcher embedded in the ASCS instance. If you select this option, an SAP Web
Dispatcher is installed running within the ASCS instance. No separate SAP Web Dispatcher instance and no
dedicated <SAPSID> are created for the SAP Web Dispatcher.

- Recommendation

The embedded SAP Web Dispatcher is subject to a number of limitations. For more information, see SAP
Note 3115889 . It is a convenience option for small systems, but is not recommended for production
systems. The general recommendation is to install a standalone SAP Web Dispatcher instead.

i Note

We only recommend this option for special scenarios. For more information, see SAP Note 908097 # . The
embedded SAP Web Dispatcher is subject to a number of limitations. For more information, see SAP Note
3115889 . It is a convenient option for small systems, but is not recommended for production systems.
The general recommendation is to install a standalone SAP Web Dispatcher instead. For an SAP Web
Dispatcher installation, a standalone installation (see below) continues to be the default scenario.
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ASCS Instance with Embedded SAP Web Dispatcher

The SAP Web Dispatcher is located between the Web client (browser) and your SAP system that is running the
Web application.

It acts as single point of entry for incoming requests (HTTP, HTTPS), defined by the IP address, port, and URL,
and forwards them in turn to the application server (AS) of the SAP system.

The SAP Web Dispatcher receives information about the SAP system that it needs for load distribution (load
balancing) from the message server and application server via HTTP.

Installation of “Standalone” SAP Web Dispatcher with its own <SAPSID> and
Instance

If you want to install an SAP Web Dispatcher for another system - that is not for the system for which you

use the ASCS instance and with its own SAP system ID and instance number - you have to install SAP Web
Dispatcher separately as described in the documentation Installation of Installation of SAP Web Dispatcher

for SAP Systems Based on SAP NetWeaver 7.0 to 7.52 on <OS> which you can find at https://support.sap.com/
sltoolset | » Installation Option of Software Provisioning Manager 1.0 ¥ Installation Option of Software
Provisioning Manager 1.0 ¥ Installation Guides - Standalone Engines and Clients - Software Provisioning
Manager 1.0 » SAP Web Dispatcher 3.
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More Information

For more information about the architecture and the functions of SAP Web Dispatcher, see the SAP Web
Dispatcher documentation in theSAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

* SAP NetWeaver 7.3 including Enhancement Package |} Application Help > Function-Oriented View > Application
1

http://help.sap.com/nw731

® SAP NetWeaver 74
http://help.sap.com/nw74

® SAP NetWeaver 7.5
http://help.sap.com/nw75Fr

® SAP NetWeaver Application Server for ABAP 7.51
innovation package

https://help.sap.com/nw75labap
SAP NetWeaver AS for ABAP 7.52

https://help.sap.com/nw752abap

Server > Application Server Infrastructure > Components of

SAP NetWeaver Application Server » SAP Web Dispatcher |

Related Information

Parameters for Additional Components to be Included in the ASCS Instance [page 63]

2.7 ASCS Instance with Embedded Gateway

You can install a gateway embedded in the ASCS instance. If you select this option, a gateway is installed within
the ASCS instance.

i Note

No separate standalone gateway instance and no dedicated <SAPSID> are created for the gateway.
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Server

Gateway

SAP Gateway Integrated in ASCS Instance
Gateway Embedded in the ASCS Instance

The gateway enables communication between work processes and external programs, as well as
communication between work processes from different instances or SAP systems.

- Recommendation

A gateway embedded in the ASCS instance is recommended, for example, when you set up a Microsoft
Failover Cluster.

You can also install a standalone gateway instance. For more information, see the documentation Installation
Guide — Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver 7.1 to

7.5x at https://support.sap.com/sltoolset# | » Installation Option of Software Provisioning Manager 1.0 »
Installation Guides - Standalone Engines and Clients - Software Provisioning Manager 1.0 » Standalone Gateway

Instance .

A\ Caution

In Microsoft Failover Cluster installations, do not install a standalone gateway on cluster nodes. Instead,
follow the instructions in SAP Note 1764650 #r .

For more information on how to configure a standalone gateway in an ASCS instance for High-Availability, see
SAP Note 1010990 # .
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Related Information

High Availability with Microsoft Failover Clustering [page 188]
Parameters for Additional Components to be Included in the ASCS Instance [page 63]
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3 Planning

3.1 Planning Checklist

This section includes the planning steps that you have to complete for the following installation options.

* Standard, distributed, or high-availability system

* Additional application server instance

Detailed information about the steps are available in the linked sections.

Prerequisites

1. You have planned your SAP system landscape according to the Master Guide available at the appropriate
download location as described in Before You Start [page 15].

2. You have decided on your installation option (see Installation Options Covered by this Guide [page 25]).

Standard, Distributed, or High-Availability System

i Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing
a standard system, you can ignore references to other hosts. Since an SAP system on IBM Db2 for
z/0S system is always a distributed constellation, we only offer two installation options: standard or
high-availability.

1. Installation Using a Stack XML File [page 36]:
If you want to install an SAP ABAP system along with the required Support Package stack and ABAP
Add-Ons in one implementation run, you need to plan the desired installation target using the maintenance
planner at https://apps.support.sap.com/sap/support/mp#.
In the maintenance planner, a stack XML file with the desired Support Package stack and Add-On
information is generated, which you then hand over to the software provisioning manager by calling it with
command line parameter SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>. Included
constraints and defaults defined in the stack XML file are then used for the initial installation by Software
Provisioning Manager and for the application of Support Package stacks and Add-Ons by the Software
Update Manager (SUM).

- Recommendation

We recommend that you perform the installation using a stack configuration file for all new products
such as SAP S/4AHANASAP on Premise.
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2. Installation Using a Stack XML File [page 36]:

If you want to install an SAP Process Integration 7.5 system or an SAP Solution Manager 7.2 system
comprising ABAP and Java, both the ABAP and the Java system must be installed with the identical
Support Package (SP) level.

You check the hardware and software requirements [page 38] on every installation host.

You plan how to set up user and access management [page 45].

You identify Basic SAP System Installation Parameters [page 47].

You decide whether you want to perform a domain or local installation [page 46].

For the database installation, you decide on how to distribute your system components [page 641].
You decide on the transport host to use [page 65].

© 0N O AW

You decide whether you want to integrate LDAP Directory Services in your SAP system [page 159].

10/ only valid for High Availability': HA (Windows)
To install a high-availability system with Microsoft Failover Clustering, you perform the HA-specific
planning steps [page 189].
| End of 'High Availability': HA (Windows)

11. Optionally, you decide whether you want to install multiple components in one database (MCOD) [page
171].
12. Continue with Preparation [page 67].

Additional Application Server Instance

1. You check the hardware and software requirements [page 38] for every installation host on which you
want to install one or more additional application server instances.

2. You identify Basic SAP System Installation Parameters [page 47].
3. Continue with Preparation [page 67].

3.2 Installation Using a Stack XML File

The option to perform an installation using a Stack XML file (also called “up-to-date installation™ or “UDI"
for short) improves the process of provisioning an up-to-date SAP system by creating a unified consumption
experience and a direct close collaboration between the involved tools, namely:

* The Maintenance Planner

* software provisioning manager (the “software provisioning manager” for short)

¢ Software Update Manager (abbreviated as “SUM™)

The software provisioning manager then can take over more default settings that are already predefined in the
Maintenance Planner.

- Recommendation

We recommend that you perform the installation using a Stack XML file for new products, such as SAP
S/AHANA or SAP Solution Manager 7.2.
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Restrictions

You cannot perform a target system installation in the context of a system copy as an installation with a Stack
XML file.

Prerequisites

You must have an S-User with the authorization to access and use the Maintenance Planner at https://
apps.support.sap.com/sap/support/mp .

For additional information about involved tools and supported SAP system releases, see SAP Note
2277574 .

Features

An installation using a Stack XML file provides the following features:

You can use a Stack XML file generated by the Maintenance Planner at https:/
apps.support.sap.com/sap/support/mp# . The parameters contained in the Stack XML file can then

be processed by software provisioning manager to get better integrated with SUM and to simplify the
process of installation for a new system on a target software level. This makes IT administration easier by
reducing the efforts in Total Cost of Ownership (TCO). For more information, see the Best Practice Guide
to Planning Landscape Changes at https://support.sap.com/en/tools/software-logistics-tools/landscape-
management-process.htm| .

When processing a Stack XML file, software provisioning manager can take over more default settings
that are already predefined in the Maintenance Planner and offers more possibilities for automation
as compared to when running without it. For more information about the benefits by comparing the
existing process with the new improved process, see Up-To-Date Installation at https://blogs.sap.com/
2016/10/21/up-to-date-installation-2/ .

i Note

The procedure and the screenshots provided in the linked document are only an example to show
how an up-to-date installation works in general for an example SAP product, and what the benefits are.
This document is not intended to serve as a detailed instruction for an up-to-date-installation of any
supported SAP product.

You can also run an installation using a Stack XML file in unattended mode as described in System
Provisioning Using an Input Parameter File [page 103] .

You can use software provisioning manager to directly download the installation software from SAP by
providing the Maintenance Plan to software provisioning manager while running software provisioning
manager option Download Software Packages for Maintenance Planner Transaction.

For more information, see Downloading Software Packages for a Maintenance Planner Transaction [page
861].
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Integration

For the additional input parameters that you need to specify, see Additional Parameters When Using a Stack
XML File (Optional). You can find the link to this section in Related Information below.

If you want to install an SAP Process Integration 7.5 system or an SAP Solution Manager 7.2 system comprising
ABAP and Java, consider the following additional requirements:

Both the ABAP and the Java system must be installed with the identical Support Package (SP) level.
The SAP system ID (SAPSID) of the ABAP system must be different from the SAPSID of the Java system.

The installation with Stack XML file must be run separately, first for the ABAP system, then for the Java
system.

The Software Update Manager (SUM) is started by the software provisioning manager at the end of the
installation process. A browser window opens with a link to Ul of the SUM that is already running. Follow the

instructions on the SUM dialogs and in the SUM Guide at https://support.sap.com/sltoolset# [ » System

Maintenance 3.

Each section in this guide describing steps that are completely or at least partially automatized when using a
Stack XML files is marked with an appropriate note at the beginning. These are the following sections:

Planning Checklist [page 35]

Additional Parameters When Using a Stack XML File [page 61]

Downloading Software Packages for a Maintenance Planner Transaction [page 86]
Running Software Provisioning Manager [page 95]

Configuring the Change and Transport System [page 128]

Applying the Latest Kernel and Support Package Stacks [page 132]

Installing Additional Languages and Performing Language Transport [page 138]

3.3 Hardware and Software Requirements

Ensure that your hosts meet the hardware and software requirements for your operating system and the SAP
instances. Otherwise you might experience problems when working with the SAP system.

Prerequisites

38

Make sure that the host name meets the requirements listed in SAP Note 611361 .
Contact your OS vendor for the latest OS patches.
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Procedure

1. Check the Product Availability Matrix at http://support.sap.com/pam#& for supported operating system
releases.

2. Check the hardware and software requirements using:
* The Prerequisite Checker:

¢ Standalone (optional) before the installation process
For more information, see Running the Prerequisites Check Standalone [page 39].

* Integrated in the installation tool (mandatory) as part of the installation process
For more information, see Running Software Provisioning Manager [page 95].

* The hardware and software requirements tables in Requirements for the SAP System Hosts [page 40]
3. If you want to install a production system, the values provided by the Prerequisite Checker and the
hardware and software requirements checklists are not sufficient. In addition, do the following:
* Youusethe Quick Sizer tool available at http://sap.com/sizing .
* You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing
depending on:
* The set of applications to be deployed
* How intensively the applications are to be used

* The number of users

3.3.1 Running the Prerequisites Check in Standalone Mode
(Optional)

This section describes how to run the prerequisites check in standalone mode. Running the prerequisites
check in standalone mode is optional.

Context

When you install an SAP system, the software provisioning manager automatically starts the prerequisites
check and checks the hardware and software requirements in the background. As an optional step during
planning, you can also run the prerequisites check in standalone mode to check the hardware and software
requirements for your operating system and the SAP instances before the actual installation.

- Recommendation

We recommend that you use both the prerequisites check and the requirements tables for reference.
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Procedure

1. Download and unpack the Software Provisioning Manager archive to a local directory as described in
Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 80].

2. Make either the separate SAPEXE<Version>.SAR archive or the complete kernel medium available as
described in Preparing the Installation Media [page 75] .

3. Start the software provisioning manager as described in Running Software Provisioning Manager [page
95].

4. On the Welcome screen, choose [# <SAP_Product> » <Database> » Preparations  Prerequisites
Check 3.

5. Follow the instructions in the software provisioning manager dialogs and enter the required parameters.

i Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

After you have finished, the Parameter Summary screen appears. This screen summarizes all parameters
that you have entered and that you want to have checked. If you want to make a change, select the relevant
parameters and choose Revise.

6. To start the prerequisites check, choose Next.

Results

The Prerequisite Checker Results screen displays the results found. If required, you can also check the results in
file prerequisite_checker_results.html, which you can find in the installation directory.

Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 80]
Preparing the Installation Media [page 75]

3.3.2 Requirements for the SAP System Hosts

This section provides information about the hardware and software requirements for the:

* ABAP central services instance (ASCS)
¢ Database instance

* Primary application server instance
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* Additional application server instance

i Note

The additional application server instance is optional in a non-HA system, but mandatory in an HA
system.

° [ Only valid for 'High Availability": HA (Windows)
High Availability only: Enqueue Replication Server instance (ERS)
l End of 'High Availability': HA (Windows)

* SAP Host Agent

[ Only valid for 'High Availability': HA (Windows)

General Requirements for a High-Availability System

* You must validate your failover cluster configuration by running the command test-clusterina
PowerShell.
The Failover Cluster Validation Report must not show any errors.

* The cluster nodes of the cluster must be connected by a private and public network:

* The public network enables communication from the cluster nodes of the cluster to other resources in
the local area network (LAN).

® The private network enables internal communication between the cluster nodes. In particular, it
enables the Cluster Service running on all cluster nodes to regularly exchange messages on the state
of the cluster nodes so that the failure of resources is quickly detected.

* Each of the cluster nodes in the cluster must have its own local disks and have access to shared disks that
can be reached by the cluster nodes via a shared bus.
For more information about the distribution of components to local and shared disk, see Distribution of
SAP System Components to Disks for Failover Clustering [page 196].

¢ All disk controllers must be able to support hardware-based RAID.

A Caution

You cannot use a host with a domain controller as a cluster node.

| End of 'High Availability': HA (Windows)

Hardware and Software Requirements

The following tables show the hardware and software requirements. Most of the requirements are valid for
every installation host whereas some requirements are instance-specific and are marked accordingly.

i Note

* The listed values are sufficient for development systems or quality assurance systems but not for
production systems.

* If you install several SAP instances on one host, you need to add up the requirements.
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* For up-to-date information on the released and supported operating system versions for your SAP

product and database, see the Product Availability Matrix (PAM) at:
http://support.sap.com/pam .

Hardware Requirements

Hardware Require-

ment Requirement How to Check
Minimum disk * Database software: To check disk space:
1GB
space G 1. Open PowerShellin
® ABAP central services instance (ASCS) (not including paging file): elevated mode, and
5 GB (x64) enter the following
8 GB (IA64) command:

® Inaddition, you require 4 GB (x64), or 8 GB (IA64) per addi-
tional platform.

® Ifyouinstall the ASCS instance with an embedded SAP Web
Dispatcher, for the installation as such you require at least 1 GB
of hard disk space in addition. For production use of the SAP
Web Dispatcher, you need to reserve at least 5 GB.

® |Ifyouinstall an SAP Gateway with the ASCS instance, you re-
quire at least 1 GB of hard disk space in addition.

® For the SAP data:
23GB

Distribute the space for the SAP data across at least three physically

separate disks

° [Only valid for 'High Availability": HA (Windows)
High Availability only: Enqueue replication server instance (ERS)
(not including paging file):
5GB (x64)
8 GB (1A64)
l End of 'High Availability': HA (Windows)

® Primary application server instance (not including paging file):
5GB (x64)
8 GB (IA64)

® Inaddition you require 4 GB (x64), or 8 GB (IA64) per additional

platform.
® Additional application server instance (not including paging file):
2.5GB (x64)
5GB (IA64)
® SAP Host Agent:
256 MB
® Temporary disk space for every required installation medium that

you have to copy to a local hard disk:
Upto 6 GB

get-volume

2. Check the value
SizeRemaining of the
disk you want to in-
stall on.
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Hardware Require-
ment

Requirement

How to Check

Minimum RAM

* Allinstances, except SAP Host Agent:
4GB
If you install the ASCS instance with an embedded SAP Web Dis-

patcher, see SAP Note 2007212#% for memory consumption in pro-

ductive use.

¢ SAP Host Agent:
0.5GB

To check RAM:

Open PowerShell in ele-
vated mode, and enter the
following command:

Get-WmiObject
Win32_ComputerSys
tem

Paging file size

For more information, see SAP Note 1518419 %% .

To check paging file size:

For more information, see
Checking and Changing
the Paging File Settings
on Windows Server [page
169]

Processing units

For application server instances and database instances:

The number of physical or virtual processing units usable by the operat-
ing system image must be equal to or greater than 2.

For an ASCS instance running on a separate host: One physical or
virtual processing unit usable by the operating system image might be
sufficient.

Examples of processing units are processor cores or hardware threads
(multithreading).

In a virtualized environment, ensure that adequate processor resources
are available to support the workloads of the running SAP systems.

Suitable backup
system
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Software Requirements

Software Requirement

Requirement

How to Check

Windows operating sys-
tem

® 64-bit version of one of the following Win-
dows Server Editions:
® Windows Server Standard Edition

® Windows Server Datacenter Edition

A Caution

For up-to-date information on the re-
leased and supported operating sys-
tem versions for your SAP product
and database, see the Product Avail-
ability Matrix (PAM) at http://sup-
port.sap.com/pam P

A Caution

Make sure that you install the English
language pack so that your support re-
quests can be handled quickly.

® Forany version of Windows Server, you need
the latest supported service pack

To check your Windows version:

Open PowerShell in elevated mode, and enter
the following command:

Get-WmiObject
Win32_OperatingSystem | select
caption

[ Only valid for "High Availability': HA (Windows) |

i Note

You must add the operating system fea-
ture Failover Clustering on all cluster no-
des.

| End of 'High Availability': HA (Windows)

SAP kernel releases and

versions

SAP kernel 740 and higher: IP Multicast Configu-
ration

Make sure that you have applied the operating
system patches required for IP Multicast Config-
uration.

For more information, see SAP Note 1931675 # .

For more information about release and road-
map information for the SAP Kernel versions,
and how this relates to SAP system sup-

port packages - including important notes on
downward compatibility and release dates -
see the central SAP Kernel notes:

Important information
about the delivery of
Microsoft Visual C++
redistributables (VCred-
ist) versions with soft-
ware provisioning man-
ager 1.0

The software provisioning manager 1.0 no lon-
ger delivers any VCredist versions that are no
longer in maintenance by the manufacturer Mi-
crosoft. SAP cannot therefore assume mainte-
nance responsibility for these 3rd party compo-
nents At the time of delivery, this affects VCred-
ist 2005 and 2010. As a result, a manual sub-
sequent installation of the VCredist files by the
customer may be required during the installation
of SAP kernels that are based on these specified
versions. For more information, see SAP Note
1553465 Har - Installation requirements for SAP
kernels on Windows (C++ runtime environment,
VCredist versions)
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Software Requirement

Requirement

How to Check

Windows regional set-
tings

English (United States) must be set by default.
For more information about localized Windows
versions, see SAP Note 362379 .

You can install additional languages but the
default setting for new users must always be
English (United States).

Choose |} Start > Control Panel > Clock,

Language, and Region > Language }

Minimum Web Browser

Make sure that you have at least one of the fol-
lowing web browsers installed on the host where
you run the software provisioning manager GUI:

® Microsoft Internet Explorer 11 or higher
® Microsoft Edge
® Mozilla Firefox

® Google Chrome

Always use the latest version of these web
browsers.

You need a web browser to be able to run the
SL-Ul, and to display the Evaluation Form and
send it to SAP.

Choose |} Start > Control Panel > Programs
and Features 1

3.4 Planning User and Access Management

You have to plan how to configure user and access management for the SAP system to be installed.

Before you add a newly installed SAP system to your system landscape, you must decide which kind of user
management you want to use:

* Central User Administration (CUA)
* An LDAP directory as the data source for user data

Procedure

To specify the initial data source of the User Management Engine (UME), proceed as described in Specifying
the Initial Data Source of the User Management Engine [page 93].
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More Information

For more information about configuring the user management of your SAP system to be installed, see the SAP
Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package
1

http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74$' Configuration of User and Role Administration > Directory

|} Application Help > SAP NetWeaver Library: Function-
Oriented View » Security # Identity Management ¥ User
and Role Administration of Application Server ABAP >

® SAP NetWeaver 7.5 Services > LDAP Connector }
http://help.sap.com/nw75#
® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

3.5 Domain or Local Installation

Before you install the SAP system, you have to decide whether you want to perform a domain or local
installation, since this affects how the user account information is stored and accessed.

For more information about the differences between a local and domain installation, go to |+ Start » Help and
Support 3 and search for What is the difference between a domain and a workgroup?.

Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain
controller and is accessible to all hosts in the system.

You have to perform a domain installation if one of the following applies:

* Youinstall a distributed system.

° [ Only valid for 'High Availability: HA (Windows)
You install a high-availability system with Microsoft Failover Clustering.
l End of 'High Availability': HA (Windows)

* Youuse a common transport host for several SAP systems running on different computers.
Local Installation

In alocal installation, all Windows account information is stored locally on one host and is not visible to any
other hosts in the system.

If the SAP system is to run on a single machine (standard system), you can perform a local installation.
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i Note

If your SAP system was installed as a local installation and you want to later change to a domain
installation, you can use the system rename option. For more information, see the System Rename Guide
for your SAP system at:

https://support.sap.com/sltoolset# | System Provisioning 3

More Information

Required User Authorization for Running Software Provisioning Manager [page 70]

3.6 Basic Installation Parameters

The software provisioning manager prompts for input parameters during the Define Parameters phase of the
installation.

You can install your SAP system either in Typical or Custom mode:

* Typical
If you choose Typical, the installation is performed with default settings. This means that the software

provisioning manager prompts you only for a small selection of installation parameters. These parameters

include at least the following:
¢ SAP system ID and database connectivity parameters
* Master password
¢ SAP system profile directory — only for systems with instances on separate hosts
* SAP systems based on SAP NetWeaver 7.40 and higher: Individual encryption key for the secure
storage
For more information about the installation parameters, see the corresponding tables below in this

document. If you want to change any of the default settings, you can do so on the Parameter Summary
screen.

* Custom

If you choose Custom, you are prompted for all parameters. At the end, you can still change any of these
parameters on the Parameter Summary screen.

i Note

You cannot change from Custom to Typical mode or from Typical to Custom mode on the Parameter
Summary screen.

i Note

* If you want to ASCS Instance with Embedded SAP Web Dispatcher [page 30], you must choose
Custom. Otherwise, you are not prompted for the SAP Web Dispatcher installation parameters [page
63] during the Define Parameters phase of the ASCS instance installation.
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* If youwant to ASCS Instance with Embedded Gateway [page 32], you must choose Custom. Otherwise,
you are not prompted for the SAP Gateway installation during the Define Parameters phase of the
ASCS instance installation.

® | Only valid for 'High Availability': HA (Windows) |
High Availability only: If you decide to install an SAP Web Dispatcher or a Gateway in the ASCS
instance, note that a failure of the SAP Web Dispatcher or the Gateway causes failover of the ASCS
instance to another cluster node. The failover cluster monitors all processes that are started by the
SAP start service (sapstartsrv.exe). For an ASCS instance this is: msg_server .exe (message server),
enserver .exe (enqueue server), gwrd.exe (Gateway), and sapwebdisp.exe (SAP Web Dispatcher).
To prevent failover, see SAP Note 2375999 ¥ .

| End of 'High Availability': HA (Windows) |

The tables in the sections below list the basic SAP system installation parameters that you need to specify
before installing your SAP system. For all other installation parameters, use the tool help on the software
provisioning manager screens.

Related Information

SAP System Parameters [page 48]

SAP System Database Parameters [page 59]

Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 60]
Additional Parameters When Using a Stack XML File [page 61]

Parameters for Additional Components to be Included in the ASCS Instance [page 63]

3.6.1 SAP System Parameters

The tables in this section lists the basic SAP system installation parameters that you need to specify before
installing your SAP system. For all other installation parameters, use the tool help on the software provisioning
manager screens.

General Parameters

Parameter Description

Unicode System  Every new installation of an SAP system is Unicode.
SAP systems based on SAP NetWeaver 7.5 or higher are Unicode only.

If you install an additional application server instance in an existing non-Unicode system (that has been
upgraded to the current release), the additional application server instance is installed automatically
as a non-Unicode instance. The software provisioning manager checks whether a non-Unicode system
exists and chooses the right executables for the system type.
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Parameter

Description

SAP System ID
<SAPSID>

The SAP system ID (<SAPSID>) identifies the entire SAP system.

The software provisioning manager prompts you for the <SAPS1D> when you execute the first installa-
tion option to install a new SAP system.

If there are further installation options to be executed, the software provisioning manager prompts you
for the profi le directory. For more information, see the description of the parameter SAP System
Profile Directory.

> Example

This prompt appears when you install the ASCS instance, which is the first instance to be installed in
a distributed system.

A Caution

Choose your SAP system ID carefully since renaming requires considerable effort.

Make sure that your SAP system ID:

® Isunique throughout your organization. Do not use an existing <SAPSID> when installing a new
SAP system.

® Consists of exactly three alphanumeric characters

® Contains only uppercase letters

® Has aletter for the first character

® Does not include any of the reserved IDs listed in SAP Note 1979280 #r .

® If you want to install an additional application server instance, make sure that no Gateway instance
with the same SAP System ID (SAPSID) exists in your SAP system landscape.
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Parameter Description

SAP System In-  Technical identifier for internal processes. It consists of a two-digit number from 00 to 97.

stance Numbers
The instance number must be unique on a host. That is, if more than one SAP instance is running on the

same host, these instances must be assigned different numbers.

If you do not enter a specific value, the instance number is set automatically to the next free and valid
instance number that has not yet been assigned to the SAP system to be installed or to SAP systems
that already exist on the installation host.

| Only valid for 'High Availability': HA (Windows)
i Note

If you install the central instance and the dialog instances on the cluster nodes of a Microsoft
failover cluster, SAPinst by default assigns the same instance number.

If you install the central instance and the dialog instances on hosts that are not part of a Microsoft
failover cluster, we recommend that you use the same instance number for them. If the instance
number is already used on other hosts, you have to assign a different instance number for the
central instance and the dialog instances.

| End of 'High Availability': HA (Windows)

To find out the instance numbers of SAP systems that already exist on the installation host, look for
subdirectories ending with <Instance Number> of local \usr\sap\<SAPSID> directories.

For more information, see SAP Directories [page 163].

A Caution

Do not use 43, and 89 for the instance number because:

® 43is part of the port number for high availability

® 89is part of the port number for Windows Terminal Server
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Parameter Description
Virtual Host Virtual host name (network name) of the SAP<SAPSID> cluster group
Name

You can assign a virtual host name to an SAP instance in one of the following ways:

® You can assign a virtual host name for the instance to be installed, by specifying it in the
<Instance Name> Host Name field of the <Instance Name> /nstance screen. Then this instance
is installed with this virtual host name.

® Alternatively you can assign virtual host names also by starting the software provisioning manager
with the SAPINST_USE_HOSTNAME property. For more information, see Running Software Provi-
sioning Manager [page 95].

After the installation has completed, all application servers can use this virtual host name to connect to
the instance. If you do not provide the virtual host name, the instance is installed automatically using
the physical host name (= Windows host name) of the host where you run the software provisioning
manager.

You must have already reserved the virtual host name (network name) and its IP address on a DNS
server before you run the software provisioning manager. For more information, see Using Virtual Host
Names [page 72].

i Note

Fully qualified host names, I1Pv4, IPv6 are not accepted as virtual host names.

SAP Process
Integration (PI)
7.5, SAP Solu-
tion Manager
7.2:

Application
Server Gateway
Communication
Setup

Java system on a host If you want to install the primary application server instance of the different
from the host of the primary application server instance of the ABAP system, then you must specify the
host of the Java primary application server instance during the Define Parameters phase of the primary
application server instance installation of the ABAP system.

This is to set up the connection between the ABAP and the Java system.

SAP System Pro-
file Directory

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

The software provisioning manager retrieves parameters from the SAP system profile directory of an
existing SAP system.

SAP profiles are operating system files that contain instance configuration information.

The software provisioning manager prompts you to enter the location of the profi le directory when
the installation option that you execute is not the first one belonging to your SAP system installation,
for example if you are installing a distributed system or an additional application server instance to an
existing SAP system. See also the description of the parameters SAP System ID and Database ID.
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Parameter Description

Destination drive Base directory for the SAP system.

i Note

If you install a subsequent SAP system, the saploc share already exists and you cannot select the
installation drive. The software provisioning manager uses the installation drive where the saploc
share points to.
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Parameter

Description

Master Password Common password for all users that are created during the installation:

® Operating system users (for example <sapsid>adm, SAPService<sapsid>)

A Caution

If you did not create the operating system users manually before the installation, the software
provisioning manager creates them with the common master password (see Operating System
Users). In this case, make sure that the master password meets the requirements of your
operating system.

® ABAP users: SAP*, DDIC, and EARLYWATCH.

® Secure Store key phrase
SAP systems based on SAP NetWeaver 7.4 and Higher: For more information, see line Key Phrase
for Secure Store Settings and line Individual Encryption Key for the Secure Storage in this table.

i Note

If a user already exists, you are prompted to confirm the password for this user.

Basic Password policy
The master password must meet the following requirements:

® |t canbe 8to 30 characters long
® It must contain at least one letter (a-z, A-Z)
® |t must contain at least one digit (0-9)

® |t must not contain \ (backslash) or ** (double quote).
Additional restrictions depending on Windows:

® Ifauser already exists, you are prompted to confirm the password for this user.

® Depending on the configuration of the password policy, additional restrictions might apply.
Additional restrictions depending on SAP MaxDB:

® ltcanbe 8to 18 characters long
Windows only: When installing MaxDB in an MSCS environment, do not use a password more
than 9 characters long for the MaxDB control user. Otherwise the database installation on an
additional node will fail.

® It must not begin with a digit or an underscore

® It can only contain the following characters: @, _, #, $, a-z, A-Z, 0-9

Depending on the installation option, additional restrictions may apply.

-> Recommendation

The Master Password feature can be used as a simple method to obtain customer-specific pass-
words for all newly created users. A basic security rule is not to have identical passwords for differ-
ent users. Following this rule, we strongly recommend individualizing the values of these passwords
after the installation is complete.

For more information, see Ensuring User Security [page 140].
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Parameter

Description

Message Server
Access Control
List

You can specify if you want to have a message server Access Control List (ACL) created.

The ACL is created as a file in the /<sapmnt>/<SAPSID>/global directory. If it exists, it defines the
hosts from which the message server accepts requests.

A Caution

Only trigger the creation of this file if you do not plan to install any additional instances for this
system. With the creation of this ACL, you overwrite existing settings and prevent instances from
being installed on additional hosts. If you decide to install an additional instance later, you need
to remove this file manually before the installation and create it again after the installation of the
additional instance.

For more information, see the information about ms/acl_info in SAP Notes 1495075%% and
826779 .

SAP systems
based on SAP
NetWeaver 7.4

and Higher only:

Individual En-
cryption Key for
the Secure Stor-

You can set a randomly generated individual encryption key for the secure storage in the file system and
the secure storage in the database. If you skip this step, the system is installed with a default key which
provides obfuscation only, but it can be changed later.

® For more information on the secure storage in the file system, see the SAP Library - depending on
the SAP NetWeaver release your SAP system is based on - at:
http://help.sap.com/nw74
http://help.sap.com/nw75

age https://help.sap.com/nw75labap #r
https://help.sap.com/nw752abapl‘§r
|} Application Help > Function-Oriented View > Security > System Security > System Security for
SAP NetWeaver AS ABAP Only # Secure Storage in the File System (AS ABAP) 4
® For more information on the secure storage in the database, see the SAP Library - depending on the
SAP NetWeaver release your SAP system is based on - at:
http://help.sap.com/nw74
http://help.sap.com/nw75
https://help.sap.com/nw75labap
https://help.sap.com/nw752abap
|} Application Help > Function-Oriented View > Security > System Security > System Security for
SAP NetWeaver AS ABAP Only > Secure Storage (ABAP) > Key Management > Using Individual
Encryption Keys } Generating Encryption Keys }
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Parameter

Description

DNS Domain If you want to use HTTP-based URL frameworks such as Web Dynpro applications, you have to specify
Name for SAP the DNS domain name for the SAP system.
System
Y The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN), which is con-
figured in profile parameter SAPLOCALHOSTFULL. FQDN is the fully qualified domain name for an IP
address. It consists of the host name and the domain name:
<Host_Name>.<Domain_Name>
The DNS Domain Name is needed to define the URLs for the ABAP application servers. It is appended to
the server name to calculate the FQDN.
» Example
If your application server host is called kirk .wdf.sap . com, the DNS Domain Name is
wdf.sap.com.
SAP Host Agent  If there already exists an SAP Host Agent on the installation host, the software provisioning manager
Upgrade (Op- asks you if you want to upgrade it to a newer patch level version. If you want the existing version to be
tional) upgraded, you must provide the new target version of the SAPHOSTAGENT<Version>.SAR archive.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page 83]
Ports
Parameter Description
ABAP Message Server Port A Caution

The message server port number must be unique on the host where the message
server for the SAP system is running. If there are several message servers running on
one host, the message server ports must all be unique.

If you do not specify a value, the default port number is used.
ABAP Message Server Port

There is an external messagev server port and an internal message server port.

The ABAP message server uses both the internal and the external message server ports.
The default profile contains the configuration for both message server ports.

The external message server port uses the parameter rdisp/msserv with default value
36<ABAP_Message_Server_Instance_Number>.

The internal message server port uses the parameter rdisp/msserv_internal with
default value 39<ABAP_Message_Server_Instance_Number>.

During the installation of an SAP system from scratch or an additional application server
instance to an existing SAP system , the message server is configured to only accept secure
connections. The DEFAULT.PFL profile parameter system/secure_communication
is set to ON (system/secure_communication = ON) if the kernel supports secure

connections to the message server. For more information, see SAP Note 2040644 # .
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Operating System Users

Parameter Definition

Password of Operating System Users The passwords of the operating system users must comply with the Windows
password policy. The software provisioning manager processes the passwords of
operating system users as follows:

® If the operating system users do not exist, SAP creates the following users:
® <sapsid>adm
This user is the SAP system administrator user. It is a member of the
local Administrators group.
® SAPService<SAPSID>
This user is the Windows account to run the SAP system. Itis not a
member of the local Administrators group.
® sapadm
The SAP Host Agent user sapadm is used for central monitoring serv-
ices. The software provisioning manager creates this user by default as
alocal user although it is not a member of the local Administrators
group.
If required, you can change this user to become a domain user on the
Parameter Summary screen. For more information, see Performing a
Domain Installation Without Being a Domain Administrator [page 168].
For security reasons, however, SAP strongly recommends you to create
this user as a local user.
The software provisioning manager sets the master password for these
users by default. You can overwrite and change the passwords either by
using the parameter mode Custom or by changing them on the Parameter
Summary screen.
® |If the operating system users already exist, the software provisioning man-
ager prompts you for the existing password, except the password of these
users is the same as the master password.

A Caution

Make sure that you have the required user authorization [page 70] for these
accounts before you start the installation.

Windows Domain Organizational Units ~ You can choose the organizational units (OUs) within the Windows domain where
you want to create the SAP system accounts.

By default, the software provisioning manager creates the domain

users SAPService<SAPSID>, <SAPSID>adm, and the domain group
SAP_<SAPSID>_Globaladmin in the domain Users container. Here you can
specify an optional organizational unit where the software provisioning manager
creates these domain users and group. The user who performs the installation
needs read and write permissions to this organizational unit.

The OU feature is only available when you select Custom mode in SWPM
and choose Use Domain of current user. For more information, see SAP Note

2247673 .
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User Management Engine Parameters

Parameter

Definition

Java Administrator User

i Note

This user is only created during the installation of the

application server ABAP for an SAP NetWeaver 7.5 Proc-

ess Integration (PI) system or for an SAP Solution Man-
ager 7.2 system.

The software provisioning manager creates this user in the
ABAP system.

After the installation, this user is available both in the ABAP
and in the Java system.

The software provisioning manager sets the user name
J2EE_ADMIN and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.

Java Guest User

i Note

This user is only created during the installation of the

application server ABAP for an SAP NetWeaver 7.5 Proc-

ess Integration (PI) system or for an SAP Solution Man-
ager 7.2 system.

This user is for employees who do not belong to a company
or who have registered as company users and who are wait-
ing for approval. Guest users belong to the default group
Authenticated Users.

The software provisioning manager creates this user in the
ABAP system.

After the installation, it is available both in the ABAP and in
the Java system.

The software provisioning manager sets the user name
J2EE_GUEST and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.

For more information about supported UME data sources
and change options, see SAP Note 718383 .

Communication User

i Note

This user is only created during the installation of the

application server ABAP for an SAP NetWeaver 7.5 Proc-

ess Integration (PI) system or for an SAP Solution Man-
ager 7.2 system.

The software provisioning manager creates this user in the
ABAP system.

After the installation, it is available both in the ABAP and in
the Java system

This user is used for the communication between the ABAP
system and the Java system.

The software provisioning manager sets the user name
SAPJSF and the master password by default.

If required, you can choose another user name and pass-
word according to your requirements.

For more information about supported UME data sources
and change options, see SAP Note 718383 #4 .
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System Landscape Directory

Parameter

Definition

SLD Destination for the System

The System Landscape Directory (SLD) registers the systems and the installed software

of your entire system landscape.
You can choose between the following options:

® Register in existing SLD

Choose this option to register the SAP system you are installing in an existing SAP

System Landscape Directory (SLD) by specifying the SLD connection parameters

listed below in this table.
® No SLD destination

Choose this option if you do not want to register the SAP system you are installing

in an existing SAP System Landscape Directory (SLD).

You then have to configure the SLD destination manually after the installation has

finished.

For more information, see Performing Post-Installation Steps for the ABAP Application

Server [page 134]

SLD Host

The host name of the existing SLD.

SLD HTTP(S) Port

HTTP port of the SAP system based on AS Java on which the System
Landscape Directory (SLD) resides. The following naming convention applies:
5<Primary_Application_Server_Instance_Number>00.

< Example

If the primary application server instance number of the AS Java on which the

System Landscape Directory (SLD) resides is 01, the SLD HTTP Port is 50100.

SLD Data Supplier User and

The existing SLD Data Supplier user and password of the existing SLD

password
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3.6.2 SAP System Database Parameters

Parameters Description

Database ID <DBSI1D> The <DBSID> identifies the database instance. The software provisioning manager prompts
you for the <DBSID> when you are installing the database instance.

The <DBSID> can be the same as the <SAPSID>.

A Caution

Choose your database ID carefully. Renaming is difficult and requires you to reinstall the
SAP system.

® If you want to install a new database:
Make sure that your database ID:

® Is unique throughout your organization

® Consists of exactly three alphanumeric characters

® Contains only uppercase letters

® Has aletter for the first character

*  Does not include any of the reserved IDs listed in SAP Note 1979280 ¥ .

®* MCOD only: If you want to use an existing database system, enter exactly the database
ID of the existing database to which you want to add the system.
For more information, see Installation of Multiple Components in One Database [page
171].

i Note

If you are installing liveCache OneDB, <DBS1D> is valid for both liveCache and SAP
MaxDB, which are both installed in the same database.

Database schema SAP<SAPSID>

Database Users Database System Administrator: superdba
Database Manager Operator: control

i Note

When installing SAP MaxDB in an MSCS environment, do not use a password more than 9
characters long for the SAP MaxDB control user. Otherwise the database installation on
an additional node will fail.

Database file systems ® Drive for global programs
® Drive for global data
® Drive for instance-dependent software
® Drive for instance-dependent data

® Drives for SAP data and log volumes
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3.6.3 Additional Parameters when Installing SAP Process

Integration 7.5 or SAP Solution Manager 7.2

The parameters in this section are only required if you want to install SAP Process Integration 7.5 or SAP

Solution Manager 7.2.

Parameter

Description

When Using a Stack XML File:

SAP System ID <SAPSID>

When Installation Using a Stack XML File [page 36], in addition
to the requirements listed in using a stack configuration file

[page 48] |} > General Parameters > SAP System ID } make

sure that the SAP system ID (SAPSID) of the ABAP system must
be different from the SAPSID of the Java system.

Communication Port for ABAP

For a secure communication of connected SAP systems to the
ABAP stack you have to define the HTTPS port that is to be
configured in the application server instance profile. Further
post-installation steps [page 137] are required to fully enable
HTTPS communication. For more information about HTTPS ena-

blement, see SAP Note 510007 ¥ .

In addition you can configure an HTTP port. However, this is
not recommended for productive SAP systems due to security

reasons.

- Recommendation

If you are about to install an SAP NetWeaver 7.5 Process
Integration system and you intend to run automated con-
figuration using the Central Technical Configuration (CTC)
Wizard after the installation, it is strongly recommended
that you configure the ABAP communication port for ABAP
already during the installation process, because you can only
run the CTC Wizard if the ABAP port is either completely
configured for HTTPS or optionally for HTTP. For more infor-
mation, see PI: Configuring the Process Integration System
After the Installation in Installation of SAP Systems Based on
the Application Server Java of SAP NetWeaver 7.5 and SAP
Solution Manager 7.2 SR2 Java on Windows: <Database>.

Application Server Gateway Communication Setup

If you want to install the primary application server instance of
the Java system on a host different from the host of the primary
application server instance of the ABAP system, then you must
specify the host of the Java primary application server instance
during the Define Parameters phase of the primary application
server instance installation of the ABAP system.

This is to set up the connection between the ABAP and the Java
system.
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3.6.4 Additional Parameters When Using a Stack XML File

The parameters in this section are only required if you use a Stack XML file generated from the Maintenance
Planner.

Parameter Description

SAP Process Integration (PI) 7.5, SAP Solution  In addition to the requirements listed in SAP System Parameters [page

Manager 7.2: 48] |} > General Parameters > SAP System ID 1 make sure that the
SAP System ID <SAPSID> SAP system ID (SAPSID) of the ABAP system must be different from
the SAPSID of the Java system.

Transport Domain The ABAP Transport Management System (TMS) must be configured
before ABAP correction packages can be applied. You can also run the
configuration or even reconfigure the TMS after the installation has
finished.

To be able to transport changes between the SAP systems in your sys-
tem landscape, you need to configure the Transport Management Sys-
tem (TMS) for all SAP systems in your system landscape and configure
one transport domain controller. To start the TMS in your ABAP system
for later reconfiguration, call transaction STMS. At least one transport
landscape with this system as transport domain controller is required
before you can apply corrections, support packages, or upgrades to the
SAP system.

The name of the Transport Domain must not contain blank characters.
You cannot change the name afterwards without reconfiguring the
transport domain controller and thereby the entire Transport Domain.

By default use DOMAIN_<SAPSID> for the Transport Domain of a single
transport landscape with this system as transport domain controller.

Directory with Transport Files Location of the ABAP transport files that are to be included after the
ABAP load during the installation. All transport files in this directory are
imported with the transport control program (tp).

Location of SPAM/SAINT Update Archive A SPAM/SAINT update contains updates and improvements to the
Support Package Manager (SPAM) and the Add-On Installation Tool
(SAINT). Provide the full path to the SPAM/SAINT update archive.

SPAM/SAINT is delivered with the ABAP load. SAP recommends that
you always use the latest version of SPAM/SAINT before applying Sup-
port Packages.
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Parameter Description

Decide whether you want to prepare for the Soft- ~ With the Software Update Manager (SUM), you can apply support pack-
ware Update Manager run at the end of the instal- ages stacks at the end of the installation.

lation ® Do not start SUM automatically

¢ Start SUM automatically at the end of the installation
Choose to start SUM automatically, if you want to have the SUM
STARTUP script called in the default <Update Diirectory>/SUM/
directory at the end of the installation.

Extract the SUM*_SAR Archive If you choose to extract the SUM*_SAR archive, the provided archive is
validated and extracted to the default update directory:

Windows: <Installation Drive>\usr\sap\<SAPSID>\

SUMHTTP port If you are running several SAP system updates on the same host, you
have to use different port numbers for each update. You can adjust the
default SUM HTTP port by entering the required port number in the
SUM HTTP Port field. When doing so you set the SUM GUI Port number
to (=<HTTP port number+2>). Dependencies See also the Soft-
ware Update Manager documentation at: https://support.sap.com/en/

tools/software-logistics-tools/software-update-manager.htm|

SUM Batch Input File You can specify a batch file with some default values for the up-
date. SUM then starts with parameter batchfile=<XML file with
input parameters>.

Enter the full path to the existing batch file.

Placeholders like @PARAMETER_VALUEQ® inside the file are replaced by
values known from the installation.

Install Additional SAP System Languages A set of default languages is delivered with the ABAP load. From the
language media delivered with your product version or - if already pro-
vided by the Maintenance Planner for the respective product - using
language archives, you can select additional languages that you want to
have installed during SAP system installation.

If you want to install additional languages, you must provide the direc-
tory with the additional language packages for the ABAP installation
load, for example with subdirectories like DATA_UNITS/ES.

For more information, see Installation Using a Stack XML File (Optional) [page 36].

Related Information

Installation Using a Stack XML File [page 36]
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3.6.5 Parameters for Additional Components to be Included
in the ASCS Instance

You only need to specify the following parameters during the ASCS instance installation if you perform an
embedded installation of additional components.

i Note

You must choose Custom parameter mode. Otherwise you are not prompted for the parameters related to
these additional components during the Define Parameters phase.

Parameters

Description

Install a gateway embedded in the ASCS
instance

When processing the screens for the ASCS instance installation, you are
prompted to mark this checkbox on the screen Additional Components to be
Included in the ASCS Instance.

Install an SAP Web Dispatcher embed-
ded in the ASCS instance

When processing the screens for the ASCS instance installation, you are
prompted to mark this checkbox on the screen Additional Components to be
Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the
additional parameters required for the SAP Web Dispatcher installation on the
subsequent screens:

Message Server Host

The name of the host on which the message server is located (profile parameter
rdisp/mshost)

Message Server HTTP Port

HTTP port of the message server (profile parameter ms/server_port_<xx>)

Password for the Internet Communication Management (ICM) user

In order to use the web administration interface for the Internet Communication
Manager (ICM) and SAP Web Dispatcher, an administration user webadm is
created by the software provisioning manager.

You have to assign a password for this user.

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 30]
ASCS Instance with Embedded Gateway [page 32]
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3.7 Distribution of SAP System and SAP MaxDB
Components to Disks

When you install the SAP system, the installation tools prompt you to enter drive letters for the main
components of the system. This lets you distribute components to disks in the system as required. How you do
this significantly affects system throughput and data security, so you need to plan it carefully.

The best distribution depends on your environment and must reflect factors such as the size of the
components involved, security requirements, and the expected workload.

When you work out the assignment of components to disks, you first need to obtain an overview of

the main components and their corresponding directories. On the basis of sample configurations and the
recommendations provided in this documentation, you can then choose the best setup for your particular
system.

In most situations, SAP systems are installed on RAID arrays to guarantee data redundancy. Therefore, this
documentation focuses on RAID subsystems and drives.

Features

The following graphic shows how you can distribute the main directories created during the installation to
Redundant Arrays of Independent Disks (RAID). The distribution is suitable for an average-sized production
system. Keep in mind that this is only an example and that no single solution fits all environments.

RAID 5
Array 1: DB Data

Kernel
Transport Directory

RAID 1or0

RDBMS Executables
Array 2: Logs

Array 3: Mirrored Logs

RAID Distribution

This configuration is suitable for the main host of a standard system (system with all instances running on the
same host) or the database server of a standalone database system. You can assign the components on the
left to any of the arrays shown. You do not necessarily have to place the transport directory on the primary
application server host.
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Array 1 <DRIVE>:\sapdb\<DBSID>\sapdata\DISKDOO1

<DRIVE>:\sapdb\<DBSID>\sapdata\DISKD999

Array 2 <DRIVE>:\sapdb\<DBSID>\saplog\DISKLOO1

<DRIVE>:\sapdb\<DBS ID>\saplog\DISKL999

<DRIVE>:\usr\sap

Array 3 <DRIVE>:\sapdb\<DBSID>\saplog\M_DISKLOO1

<DRIVE>:\sapdb\<DBSID>\saplog\M_DISKL999

This setup has the following key features:

* Security of the Logs
The security of the logs is crucial. The logs record all the changes made to the database and so provide
the information that is necessary to recover a damaged database. Therefore, it is important that they are
stored securely and that you never lose them at the same time as the database data. By placing the redo
logs on a different array to the database data, you can make sure that they are not lost if the array with the
database data is severely damaged.

® Performance
You can reduce /0 bottlenecks by placing the original logical log on a different array than the mirrored log.
Original and mirrored logs are written in parallel. If they are located on the same array, this results in a high
level of write activity that has to be handled by the same controller. By separating original and mirrored
logs, you can distribute the write activity to two different arrays, so reducing 170 bottlenecks.

* RAID
By using RAID 1 arrays for the original and mirrored logs, you obtain high data security and good
performance. The data is written to a primary disk and duplicated identically to a second disk. If one
disk fails, the data is still intact on the second disk.
The use of RAID 5 for the database ensures fault tolerance. The data is striped over all the disks in the
array together with parity information. If one disk fails, the parity information is used to automatically
reconstruct the data lost on the damaged disk.

3.8 SAP System Transport Host

The transport host contains the transport directory used by the SAP transport system to store transport data
and change SAP system information, such as software programs, write dictionary data, or customizing data.
If you have several SAP systems it depends on your security requirements whether you want them to share a
transport directory or whether you use separate directories.
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When you install an SAP system, you have to decide which transport host and directory you want to use for
your SAP system:

Use the transport directory that the software provisioning manager creates during the installation of the
SAP system by default on the global host.
The software provisioning manager by default creates the transport directory on the global host in
\usr\sap\trans.
Use a transport directory located on a host other than the default host:

* You can use an existing transport directory and host in your SAP system landscape.

* You can set up a new transport directory on a different host.
In either case, you must prepare this host for use by the new SAP system [page 73].

More Information

66

SAP Directories [page 163]
See the SAP Library at:

Release SAP Library Path

® SAP NetWeaver 7.3 including Enhancement
g |+ Application Help # Function-Oriented View # Solution Life Cycle

Package 1

http://help.sap.com/nw731 M Management > Software Logistics > Change and Transport System
e SAP NetWeaver 74 » Change and Transport System — Overview ¥ Basics of the

http://help.sap.com/nw74 P Change and Transport System > Transport Management System —
®* SAP NetWeaver 7.5 Concept }

http://help.sap.com/nw75
® SAP NetWeaver Application Server for
ABAP 7.51 innovation package
https://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap
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4 Preparation

4.1 Preparation Checklist

This section includes the preparation steps that you have to perform for the following installation options:

¢ Standard, distributed, or high-availability system
* Additional application server instance

Detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

i Note
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a

standard system, you can ignore references to other hosts.

1. Disable the Windows Server [page 68] firewall operating system users and groups on each host.
2. You perform basic preparations on Windows [page 68].

w

You check that you have the required user authorization for running the software provisioning manager
[page 70].
. If required, you prepare the SAP system transport host [page 73] for your SAP system.

4
5. You install the SAP front-end software [page 75] on the desktop of the user.

6. You check that the required installation media [page 75] are available for each installation host.
7.

| Only valid for 'High Availability': HA (Windows)

To install a high-availability system with Microsoft Failover Clustering, you also perform the HA-specific
preparation steps [page 189].

| End of 'High Availability': HA (Windows)

8. You continue with Installation [page 91].

Additional Application Server Instance

You have to perform the following preparations on the host where you install the additional application server
instances:

1. Disable the Windows Server firewall [page 68] operating system users and groups on each host.

2. You perform basic preparations on Windows [page 68].

3. You check that you have the required user authorization for running the software provisioning manager
[page 70].
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If required, you prepare the SAP system transport host [page 73].
You install the SAP front-end software [page 75] on the desktop of the user.
You check that the required installation media [page 75] are available on each installation host.

N o o s

You continue with Installation [page 91].

4.2 Disabling the Windows Server Firewall on Windows
Server

The Windows firewall — which is turned on by default on all Windows versions — is configured to allow only
a small set of Windows-specific inbound IP connections. By default, outbound connections are not limited to
rules and are therefore not restricted by the firewall.

The firewall settings apply to local policies. For domain policies that override local policies, other rules might
apply.

To avoid any problems with non-configured TCP/IP ports that are used by the SAP system, you need to disable
the firewall on all Windows hosts before you install the SAP system with the software provisioning manager. We

recommend that you secure network access to the SAP application servers with a real physical firewall or use a
router Access Control List (ACL).

Procedure

[ Only valid for 'High Availability": HA (Windows)

i Note

In a high-availability system, you have to disable the firewall on all failover cluster nodes.

l End of 'High Availability': HA (Windows)

Open PowerShell in elevated mode, and enter the following command:

Set-NetFirewallIProfile -enabled false

4.3 Performing Basic Windows Preparation Steps

Use

This section informs you about basic preparation steps that you have to perform before you install the SAP
system, including the following:

* Deactivate the file and directory attribute caches
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¢ Checking the Windows file system
¢ Checking the Windows domain structure (domain installation only)

¢ Deciding whether you want to use organizational units (OUs) in the Windows domain (domain installation

only)

Procedure

Deactivate the File and Directory Attribute Caches
You need to set the following three file and directory attribute caches to O:
For more information, see 3358301 # .

Perform as follows:

1. Open PowerShell

2. Enter the following three commands:
¢ Set-SmbClientConfiguration -FileInfoCacheLifetime O
¢ Set-SmbClientConfiguration -FileNotFoundCacheLifetime O
¢ Set-SmbClientConfiguration -DirectoryCachelLifetime O

Checking the Windows File System

You need to check which Windows file system you are using on hosts where you want to install the SAP system.

You should use the Windows file system ReFs or NTFS. Older Windows Server versions must use NTFS.

i Note

Do not install the SAP system on a FAT partition.

Perform the check as follows:

¢ Use PowerShell:

1. Open PowerShell in elevated mode, and enter the following command:
get-volume

2. Check that the value FileSystem is ReFs or NTFS.
¢ Use Windows Explorer:
Open the Windows Explorer.
2. Select the relevant disk.
3. Choose |r Properties » General 3.
The system displays the type of file system in use.
4. Check that the file system is NTFS.

Checking the Windows Domain Structure
i Note
You do not need this step for a local installation.

For a domain installation, we recommend that you check that all SAP system hosts are members of a single
Windows domain. We recommend this for all SAP system setups.
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We assume that you are familiar with checking Windows domain structures. For more information, see the
Windows documentation.

In Windows, you can implement either of the following domain models for the SAP system:

* Extradomain
In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second
domain exists for the user accounts.
In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user
accounts must form the root domain and the SAP domain must be a child domain of this.

* Single domain
In this model, the SAP system, and the user accounts are included in a single domain.

A Caution

You cannot create local users and groups on the host that is used as domain controller. Therefore, we do
not support running an SAP instance (including the database instance) on the host where the domain
controller is installed.

Deciding Whether to Use Organizational Units (OUs) in the Windows Domain
i Note

You do not need this step for a local installation.

For a domain installation, the software provisioning manager needs to create certain OS users for SAP and
database operations in the Windows domain, also called the “Active Directory” (AD). These users are created
by default in the AD container “Users”.

Depending on a customer's AD landscape and security policy, there are certain restrictions on where to store
users and groups in AD. Contact the administrator of your AD infrastructure to understand where to store all
SAP and database-related domain users and domain groups.

The SAP software provisioning manager offers to define an existing OU in AD to create all needed SAP and
database users in this OU.

There are many different scenarios and prerequisites concerning how to use OUs. For more information, see
SAP Note 2247673, which explains these issues in detail and shows some examples of how to use them.

A Caution

The software provisioning manager does not create OUs. The software provisioning manager does not
move existing domain users or groups. The software provisioning manager does not delete existing users,
groups, OUs, nor any other object in a Windows domain.

The only exception to this rule is the Uninstall option in the software provisioning manager.

4.4 Required User Authorization for Running Software
Provisioning Manager

Although the software provisioning manager automatically grants the rights required for the installation to the
user account used for the installation, you have to check whether this account has the required authorization
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to perform the installation. The authorization required depends on whether you intend to perform a domain or
local installation. If necessary, you have to ask the system administrator to grant the account the necessary
authorization before you start the installation. If you attempt the installation with an account that does not
have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

A\ Caution

Do not use the user <sapsid>adm or the built-in administrator account for the installation of the SAP
system.

Domain Installation

For a domain installation the account used for the installation needs to be a member of the local
Administrators group. In many old installation guides, you find the information that the account must be a
member of the Domain Admins group. The account can be either a member of the Domain Admins group or
belong to the Domain Users group and have the necessary rights to create/modify objects in the domain.

For a list of the required permissions, see Performing a Domain Installation without being a Domain
Administrator [page 168].

All machines in the system must belong to the same domain. In a domain installation, the user information is
stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends that you
perform a domain installation to avoid authorization problems.

A Caution

* If youinstall a distributed system as a local installation, this can lead to authorization problems for
the operating system users <sapsid>adm and SAPService<SAPSID>. It can also lead to problems
with the transport directory, which is usually shared by several SAP systems. SAP does not support
distributed SAP systems running with local user accounts.

* | Only valid for 'High Availability': HA (Windows) |
In a high-availability configuration, you always have to perform a domain installation.

| End of 'High Availability': HA (Windows) |

* For performance and security reasons, SAP does not support an SAP system installation on a domain
controller.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.

2. If required, obtain these rights by asking the system administrator to enter the account as a member of the
domain Admins group.

Local Installation
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For a local installation the account used for the installation needs to be a member of the local
Administrators group of the machine involved. In a local installation, all Windows account information is
stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

A Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your
SAP system. The built-in account only has restricted network access rights that are required by the
software provisioning manager. If you renamed the built-in account Administrator, do not create a new
account named Administrator.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. Ifrequired, obtain these rights by asking the system administrator to enter the account as a member of the

local Administrators group.
Related Information

Performing a Domain Installation Without Being a Domain Administrator [page 168]

4.5 Using Virtual Host Names

You can use one or more virtual TCP/ 1P host names for SAP servers within an SAP server landscape to hide
their physical network identities from each other. This can be useful when quickly moving SAP servers or
complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

* Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

* Make sure that you configured the Windows operating system properly to use virtual host names. For more
information, see SAP Note 1564275
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Context

[ Only valid for 'High Availability": HA (Windows)
A Caution
High Availability only:

* Only use virtual host names if this is explicitly stated in the parts of this installation guide specific to
high availability. Otherwise, use the physical host name.

* Do not start the software provisioning manager with the command line parameter
SAPINST_USE_HOSTNAME=<virtual hostname> on failover cluster nodes.

l End of 'High Availability: HA (Windows)

Procedure

1. Assign the required virtual host names to the instance to be installed by specifying them in one of the
following ways:

¢ By starting the software provisioning manager with the SAPINST_USE_HOSTNAME property. For more
information, see Running Software Provisioning Manager [page 95].

* Alternatively by specifying vitual host names in the <Instance Name> Host Name field of the
<Instance Name> Instance screen.
For more information, see the Virtual Host Name parameter description in SAP System Parameters [page
48] and SAP Note 962955 .
2. Toinstall a non-high-availability system, proceed as described in SAP Note 1564275#% .

46 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data
and metadata.

Context

When you install an SAP system, the software provisioning manager by default creates the transport directory
on the global host in \usr\sap\trans.

If you do not intend to use the directory structure of the system you are going to install, but want to use another
new transport directory on another host, or an existing transport directory in your system landscape, you need
to prepare that transport host:

* |If the directory structure already exists, you must set up its security to allow the new system to write to it.
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* Ifit does not yet exist, you must create the core directory structure and a share to export it for other
computers as well as set the security on it.

The transport directory \usr\sap\trans is used by the Change and Transport System (CTS). The CTS helps
you to organize development projects in the ABAP Workbench and in Customizing, and then transport the
changes between the SAP systems in your system landscape. For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

*  SAPNetWeaver 7.3 including Enhancement |} Application Help > SAP NetWeaver Library: Function-Oriented
Package 1
http://help.sap.com/nw731#

® SAP NetWeaver 74

http://help.sap.com/nw74 % Overview > Basics of the Change and Transport System > Transport

View # Solution Life Cycle Management » Software Logistics
> Change and Transport System > Change and Transport System —

® SAP NetWeaver 7.5 Management System — Concept ]
http://help.sap.com/nw75 "
® SAP NetWeaver Application Server for ABAP 7.51
innovation package
http://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52
http://help.sap.com/nw752abap ¥

Procedure

1. If the transport directory does not yet exist, do the following:

a. Create the directory \usr\sap\trans on the host to be used as the transport host.

b. Share the usr\sap directory on the transport host as SAPMNT and set the permission for Everyone to
Full Control for this share.

This enables the software provisioning manager to address the transport directory in the standard way
as \\SAPTRANSHOST\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

A\ Caution

Remove the Full Control to Everyone permission after you have finished the installation and only grant
Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the systems that are
part of your transport infrastructure. The software provisioning manager assigns the appropriate rights
with the help of an additional SAP_Local Admin group. For more information, see Automatic Creation
of Accounts and Groups [page 182].
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4.7 Installing the SAP Front-End Software

Before you start the installation, make sure that the SAP front-end software is installed on at least one
computer in your system environment to be able to log on to the SAP system after the installation has finished.

Procedure

1. Check SAP Note 147519#% for the recommended SAP front-end release.

2. Install the SAP front-end software required for your SAP system release as described in the
documentation SAP Frontend Installation Guide - <Release> at: https://wiki.scn.sap.com/wiki/display/
ATopics/SAP+GUI+Family #

4.8 Preparing the Installation Media

This section describes how to prepare the installation media.
Installation media are available as follows:

* The software provisioning manager 1.0 archive containing the software provisioning manager software
You always have to download the latest version of the software provisioning manager 1.0 archive.
For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive
[page 80].

* The media containing the software to be installed. These are the following:

* Kernel media:
You can make them available in one of the following ways:

* Make yourself familiar with current SAP Kernel releases and SAP's Kernel strategy:
Central SAP Notes
2083594+ - SAP Kernel Versions and SAP Kernel Patch Levels
3116151 - SP Stack Kernel Schedule Forecast
1744209¢% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546 - Release Roadmap for Kernel 74x and 75x
1802333#% - Finding information about regressions in the SAP kernel
19466 - Downloading SAP kernel patches
2966761#F - Overview of SAP Kernel Correction Archives
2966621# - Overview of Kernel-Related Software Components
953653 # - Rolling Kernel Switch
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The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise
Landscapes provides SAP recommendations on how to patch the SAP kernel.

* Download the SAP Kernel Archives (SAR files) from the SAP Software Download Center - this is
the recommended way.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page
83].
If you are performing an Installation Using a Stack XML File [page 36], you can directly download
the artefacts (SAR archives) as specified in the Maintenance Plan.

* Use the physical installation media as part of the installation package.
For more information, see Media Required for the Installation - Listed by SAP System Instance
[page 76].

* Download the complete kernel media from the SAP Software Download Center.
For more information, see Downloading Complete Installation Media [page 88].

* RDBMS and export media.
You can make them available in one of the following ways:

* Use the physical installation media as part of the installation package.

¢ Download the complete kernel media from the SAP Software Download Center.
For detailed information about how to obtain these media, see Media Required for the Installation - Listed
by SAP System Instance [page 76].

Media Required for the Installation - Listed by SAP System Instance [page 76]
This section provides a list of the media required for the installation, listed by SAP system instance to
be installed.

4.8.1 Media Required for the Installation - Listed by SAP
System Instance

This section provides a list of the media required for the installation, listed by SAP system instance to be
installed.

The digital signature of installation media is checked automatically by the software provisioning manager
during the Define Parameters phase while the Media Browser screens are processed (see also Running
Software Provisioning Manager [page 95] ). The software provisioning manager only accepts media whose
digital signature has been checked.

For more information about which kernel version to use, see the following information sources::
Central SAP Notes
2083594 ¢ - SAP Kernel Versions and SAP Kernel Patch Levels
3116151#% - SP Stack Kernel Schedule Forecast
1744209%% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546#% - Release Roadmap for Kernel 74x and 75x
1802333 - Finding information about regressions in the SAP kernel
19466#% - Downloading SAP kernel patches
2966761#F - Overview of SAP Kernel Correction Archives
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2966621 - Overview of Kernel-Related Software Components

953653 - Rolling Kernel Switch

The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise Landscapes

provides SAP recommendations on how to patch the SAP kernel.

In addition, check the Product Availability Matrix at: http:/support.sap.com/pam#.

For more information about release and roadmap information for the SAP Kernel versions, and how this relates
to SAP system support packages - including important notes on downward compatibility and release dates -
see the central SAP Kernel notes:

Proceed as follows to make the media available:

1. Identify the required media for your installation [page 25] as listed below.

SAP Instance

Installation Required Software Packages from Installation Media

ABAP Central ® Software Provisioning Manager 1.0 archive

services in- ¢ UCor NUC Kernel (folder K_<Version>_<N or U>_<0S>)where Umeans Unicode and N

stance (ASCS means non-Unicode.

instance)
i Note
Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Database in- * Software Provisioning Manager 1.0 archive

stance ¢ UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where Umeans Unicode and N

means non-Unicode.

i Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Database software

Installation Export (folders EXP*)

i Note

For an MCOD system you require the database client software instead of the database software
and the database patches (if available).
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SAP Instance
Installation

Required Software Packages from Installation Media

Enqueue Repli-
cation Server

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where U means Unicode and N
means non-Unicode.

i Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Primary appli-
cation server in-
stance

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where U means Unicode and N
means non-Unicode.

i Note

Every new installation of an SAP system is Unicode. You can only use the non-Unicode ker-
nel if you perform the system copy for a non-Unicode SAP system that has been upgraded
to the current release.

Installation Export (folders EXP*)
SAP SCM only: SAP MaxDB liveCache

Database Client Software

Additional appli-
cation server in-
stance

Software Provisioning Manager 1.0 archive

UC or NUC Kernel (folder K_<Version>_<N or U>_<0S>) where U means Unicode and N
means non-Unicode.

i Note

If you install an additional application server instance in an existing non-Unicode system,
the additional application server instance is created automatically as a non-Unicode in-
stance. The software provisioning manager checks whether a non-Unicode system exists
and chooses the right executables for the system type.

SAP SCM only: SAP MaxDB liveCache

Database Client Software

SAP Host Agent (Separate Installation Only)

SAP Instance Installation Required Media

SAP Host Agent (separate installation only)

¢ Software provisioning manager 1.0 archive

® UC Kernel (folder K_<Version>_U_<0S>) where U
means Unicode.

2. Make the installation media available on each installation host as follows:

1. Download and unpack the latest version of Software Provisioning Manager as described in
Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 80].
2. Make the kernel media available.
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You can do this in one of the following ways:

Download the dedicated kernel archives - this is the recommended way.
For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page
83].

i Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 36]), you

have the installation media defined when generating the Landscape Plan. The media link
provided in the Landscape Plan guides you to the location in the SAP Software Download
Center at https://launchpad.support.sap.com/#/softwarecenter# where you can download
the installation media required for your SAP product, operating system and database.

Using the software provisioning manager, you can also directly download the artefacts (SAR
archives) as specified in the Maintenance Plan. For more information, see Downloading
Software Packages for a Maintenance Planner Transaction [page 86].

Use the physical kernel medium from the installation package.
You can do this in one of the following ways:

* Copy the required media folders directly to the installation hosts.

* Mount the media on a central media server that can be accessed from the installation hosts.

A\ Caution

* If you copy the media to disk, make sure that the paths to the destination location of the
copied media do not contain any blanks.

* If you perform a domain installation and do not want to copy the media but use network
drives for mapping the installation media, make sure that the <sapsid>adm user has
access to the UNC paths of the network drives.

If the user does not yet exist, you have to create the user manually before you install the
SAP system.

Download the kernel medium from the Software Download Center.
For more information, see Downloading Complete Installation Media [page 88].

i Note

Even if you use the complete kernel media, the software provisioning manager might prompt you
during the provisioning process for additional archives (*SAR files) due to special Patch Level
(PL) requirements depending on categories such as the product, operating system, and database
platform at the end of this section.

For example: The software provisioning manager might require a certain PL of <X> of the
SAPEXEDB. SAR (for DBTYPE <Y>), but this PL of the SAPEXEDB . SAR is not contained in

the SAP kernel media . In this case you have to download the required PL from https:/
launchpad.support.sap.com/#/softwarecenter® following the instructions in Downloading SAP
Kernel Archives (Archive-Based Installation) [page 83].

i Note

If you perform an additional application server installation, kernel archives -
such as SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, IGSEXE<Version>.SAR,
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igshelper<version>.sar - are only prompted if they cannot be retrieved from the primary
application server instance or the ASCS instance of the existing SAP system.

3. Make the RDBMS and export media. available.
You can do this in one of the following ways:

* Copy the required media folders directly to the installation hosts.
* Mount the media on a central media server that can be accessed from the installation hosts.

A\ Caution

¢ If you copy the media to disk, make sure that the paths to the destination location of the
copied media do not contain any blanks.

* If you perform a domain installation and do not want to copy the media but use network drives
for mapping the installation media, make sure that the <sapsid>adm user has access to the
UNC paths of the network drives.

If the user does not yet exist, you have to create the user manually before you install the SAP
system.

3. If you want to perform target system installation in the context of a heterogeneous system copy you need
a migration key. You can generate it at https:/support.sap.com/migrationkey #r .

Related Information

Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 80]
Downloading SAP Kernel Archives (Archive-Based Installation) [page 83]
Downloading Software Packages for a Maintenance Planner Transaction [page 86]
Downloading Complete Installation Media [page 88]

4.8.11 Downloading and Extracting the Software
Provisioning Manager 1.0 Archive

You must always download and extract the software provisioning manager 1.0 archive from the SAP Software
Download Center because you must use the latest version.

Prerequisites

* Make sure that you use the latest version of the SAPCAR tool when manually extracting the software
provisioning manager archive. You need the SAPCAR tool to be able to unpack and verify software
component archives (*.SAR files). *SAR is the format of software lifecycle media and tools that you can
download from the SAP Software Download Center.
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i Note

An older SAPCAR version might extract archive files in a wrong way and this could prevent the software
provisioning manager from working consistently.

Proceed as follows to get the latest version of the SAPCAR tool:

1. Go to https://launchpad.support.sap.com/#/softwarecenter#r|p » SUPPORT PACKAGES &
PATCHES » By Category » SAP TECHNOLOGY COMPONENTS » SAPCAR 1.

2. Select the SAPCAR for your operating system and download it to an empty directory.

3. Evenif you have the latest SAPCAR already available, we strongly recommend that you verify its digital
signature anyway, unless you downloaded it directly from https://launchpad.support.sap.com/#/
softwarecenter/# yourself. You can do this by verifying the checksum of the downloaded SAPCAR
tool:

1. Depending on what operating system you are using, compute a hash of the downloaded SAPCAR
tool, using the SHA-256 algorithm used by SAP .

2. Now verify the digital signature of the downloaded SAPCAR tool by comparing the hash with the
checksum (generated by SAP using the SHA-256 algorithm) from the Content Info button in the
Related Info column on the right-hand side of the place where you downloaded the SAPCAR tool.

4. To improve usability, we recommend that you rename the executable to sapcar.

For more information about SAPCAR, see SAP Note 212876 .

Context

An up-to-date version of the load tools - such as R31oad, R3szchk, R31dctl, SAPuptool

- which were available so far only in the SAPEXEDB_<. . .>.SAR archive of the kernel

media, has now been made available in the software provisioning manager archive (software
provisioning manager10SP<Support_Package_Number>_<Version_Number>_SAR), in a sub-
archive named LOADTOOLS. SAR, located in the COMMON/LOADTOOLS folder. For an installation

using kernel version 740 or higher, the load tools from the software provisioning
manager10SP<Support_Package Number>_<Version_Number>.SAR are used automatically instead
of the loadtools available in the SAPEXEDB_<. . .>.SAR archive of the kernel media. There

is no action required from your side, the software provisioning manager uses the

relevant loadtools automatically once you run it from the extracted software provisioning
manager10SP<Support_Package Number>_<Version_Number>.SAR archive. For more information, see
SAP Note 2472835 .

Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive
SWPM10SP<Support_Package Number>_<Version_Number>.SAR from:

https://support.sap.com/sltoolset# | » System Provisioning # Download Software Provisioning
Manager 3
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2. Using the latest version of SAPCAR, you can verify the digital signature of the downloaded
SWPM10SP<Support_Package_ Number>_<Version_Number>.SAR archive as follows:

a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:

1. Goto https://launchpad.support.sap.com/#/softwarecenter|l SUPPORT PACKAGES &
PATCHES 3 and search for “sapcryptolib”.
2. Select the archive file for your operating system and download it to the same directory where you
have put the SAPCAR executable.
3. Use the following command to extract the SAPCRYPTOL IB archive to the same directory where
you have put the SAPCAR executable:
SAPCAR —xvT sapcryptolibp_84.sar —R <target directory>
4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/cribag.p7s# and move
it to the same directory.
b. Verify the digital signature of the downloaded
SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive by executing the
following command:

i Note
Check SAP Notes 2178665% and 1680045#% whether additional information is available.

<Path to SAPCAR>\sapcar.exe -tvVf<Path to Download
Directory>\SWPM10SP<Support_Package_Number>_<Version_Number>_.SAR -crl <file
name of revocation list>

3. Unpack the Software Provisioning Manager archive to a local directory using the following command:

<Path to SAPCAR>\sapcar.exe -xvf <Path to Download
Directory>\SWPM10SP<Support_Package_Number>_<Version_Number>_SAR -R <Path to
Unpack Directory>

i Note

Make sure that all users have at least read permissions for the directory to which you unpack the
Software Provisioning Manager archive.

O\ Caution

Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not
unpack it to the same folder as other installation media.
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4.8.1.2 Downloading SAP Kernel Archives (Archive-Based
Installation)

Instead of downloading the complete SAP kernel media, we recommend that you download the SAP kernel
archives specificly required for your installation option. During the installation, you can either specify the path
to each archive separately, or provide the path to a download basket with all downloaded archives.

i Note

If you are performing an installation using a Stack XML file, you can use the service Downloading Software
Packages for a Maintenance Planner Transaction [page 86].

Context

The digital signature of installation archives is checked automatically by the software provisioning manager
[page 95] during the Define Parameters phase while processing the Software Package Browser screens. The
software provisioning manager only accepts archives whose digital signature has been checked. After scanning
the archives and verifying the digital signature, an info file is written where you can find detailed information
about matching and non-matching archive files. You can access this info file by choosing the info file link in the
Archive Scanning Result section of the Software Package Browser screen. The info file contains only the results
of the latest archive scan.

Procedure

1. Download and unpack the latest version of software provisioning manager as described in Downloading
and Extracting the Software Provisioning Manager 1.0 Archive [page 80].

2. Make yourself familiar with current SAP Kernel releases and SAP's Kernel strategy:
Central SAP Notes
2083594+ - SAP Kernel Versions and SAP Kernel Patch Levels
3116151 - SP Stack Kernel Schedule Forecast
1744209#% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546/ - Release Roadmap for Kernel 74x and 75x
1802333 - Finding information about regressions in the SAP kernel
19466/ - Downloading SAP kernel patches
2966761#F - Overview of SAP Kernel Correction Archives
2966621# - Overview of Kernel-Related Software Components
953653 # - Rolling Kernel Switch
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The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise
Landscapes provides SAP recommendations on how to patch the SAP kernel.

3. To get all downloadable software component archives required for your SAP product, go to
https://launchpad.support.sap.com/#/softwarecenter# | » SUPPORT PACKAGES & PATCHES » By
Category 3

You can also search for dedicated software component archives by choosing [F » SUPPORT PACKAGES &
PATCHES » By Downloads » Search 3

4. Choose the required software component, release, and technical stack:

* |f you want to install AS ABAP for SAP SAP S/4HANA Frontend , choose [+ SAP NetWeaver and
complementary products » AS ABAP FOR S/AHANA FRONTEND » AS ABAP <Release> FOR S/4
HANA <Release> J

* If you want to install SAP NetWeaver AS for ABAP 7.52, choose [ SAP NetWeaver and complementary
products » NW AS ABAP INNOVATION PKG » NW AS ABAP 752 1

* |f you want to install SAP NetWeaver AS for ABAP 7.51 innovation package, choose [r SAP NetWeaver
and complementary products » NW AS ABAP INNOVATION PKG » NW AS ABAP 7.51 INNOVATION
PKG 3

* If you want to install AS ABAP FOR OOEM, choose |» SAP NetWeaver and complementary products
» SAP NETWEAVER ABAP FOR OOEM J

* If you want to install the ABAP part of an SAP Process Integration 7.5 system, choose
| SAP NetWeaver and complementary products » SAP NetWeaver ¥ <Release> j» Application Server
ABAP 3

* |fyou want to install an SAP NetWeaver ABAP system, choose |# SAP NetWeaver and complementary
products » SAP NetWeaver » <Release> » [For releases lower than 7.5: Entry by Component]

» Application Server ABAP 3

* If you want to install an SAP Business Suite system based on SAP NetWeaver, choose |» SAP
Application Components » <SAP CRM | SAP ERP | SAP SCM | SAP SRM> » <Release> » Entry
by Component » <ABAP Product Instance> 3

5. Choose the required package:

i Note

If you perform an additional application server installation, kernel archives

- such as SAPEXE<Version>.SAR, SAPEXEDB<Version>_SAR, IGSEXE<Version>.SAR,
igshelper<version>.sar - are only prompted if they cannot be retrieved from the primary
application server instance or the ASCS instance of the existing SAP system.

A\ Caution

* Make sure that you always use the highest available patch level unless special patch levels are
specified for the relevant package in SAP Note 168004 5#% .

* Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>_.SAR of the
same SAP kernel release and extension.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on Windows: SAP MaxDB
84 PUBLIC Preparation


http://help.sap.com/disclaimer?site=https%3A%2F%2Fsupport.sap.com%2Fdeployment-strategies-kernel-abap.pdf
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fsoftwarecenter
http://help.sap.com/disclaimer?site=https://me.sap.com/notes/1680045

6. Ifyo
7.22

http

»» Example

|f SAPEXE<Version>.SAR is of version 64-BIT UNICODE, then SAPEXEDB<Version>.SAR
must also be of version 64-BIT UNICODE.

SAPEXE<Version>.SAR
|l SAP KERNEL <Version><UC | NUC> » <Operating System> » #DATABASE INDEPENDENT 3

i Note

SAP KERNEL <Version> <NUC> is only available for SAP systems based on SAP NetWeaver 7.4 or
lower.

SAPEXEDB<Version>.SAR
Choose the version corresponding to the SAPEXE<Version>.SAR from [+ SAP KERNEL <Version>
<UC | NUC> » <Operating System> » <DATABASE> 1

i Note

SAP KERNEL <Version> <NUC> is only available for SAP systems based on SAP NetWeaver 7.4 or
lower.

igsexe<Version>.sar

| SAPIGS <Version> j» <Operating System> 3
You require the igshelper<Version>._sar.

Choose | SAP IGS HELPER ¥ # OS independent 3
SAPHOSTAGENT<Version>.SAR

| SAPHOST AGENT 7.22 » <Operating System> 1

- Recommendation

It is highly recommended that you always choose the highest SP version of the
SAPHOSTAGENT<SP-version>.SAR archive.

i Note

The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host
Agent available on the installation host or you specified during the Define Parameters phase
that you want to upgrade an existing version of the SAP Host Agent already available

on the installation host. In the latter case, you must specify a higher version of the
SAPHOSTAGENT<Version>.SAR .Otherwise, the existing SAP Host Agent is not upgraded.

u want to install an SAP system based on SAP NetWeaver 7.3 EHP1 - that is you have to use SAP kernel
- download the latest patch level of SAPCRYPTOLIB <Version>.SAR from the following path:

s://launchpad.support.sap.com/#/softwarecenter# | Support Packages and Patches j By

Category ¥ Additional Components » SAPCRYPTOLIB » COMMONCRYPTOLIB<Version> » <Operating
System> J

7. Make the RDBMS and the export media available - either by using physical media as described in Media
Required for the Installation - Listed by SAP System Instance [page 76] or by downloading them as
described in Downloading Complete Installation Media [page 88].
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Related Information

Downloading Software Packages for a Maintenance Planner Transaction [page 86]

4813 Downloading Software Packages for a Maintenance
Planner Transaction

The software provisioning manager is now enabled to download all software packages that have been defined in
a Maintenance Planner Transaction.

i Note

This feature is only available if you perform an installation using a stack configuration file.

Prerequisites

Plan your new SAP system including the required Support Package level (applicable for SAP S/4 HANA, SAP
NetWeaver, SAP Business Suite, and SAP Financials) as available in the Maintenance Planner and run sapinst
SAPINST_STACK_XML=<Stack XML file>inorder to benefit from an automated installation process.

Procedure

1. Specify a download directory for the artifacts (SAP archives) to be downloaded.

2. Start the software provisioning manager as described in Running Software Provisioning Manager [page
95].

3. Onthe Welcome screen, choose | * Generic Options ¥ Download Software Packages for Maintenance
Planner Transaction 3

4. Follow the instructions on the software provisioning manager screens.
The software provisioning manager prompts you for the following input parameters:

* Maintenance Planner Transaction ID
You can find the Maintenance Planner Transaction ID by one of the following ways:

* IntheMP_Plan_<Transaction ID>_<Generation Date>_.pdf file which you can download
during the Completed step in the Maintenance Planner by choosing the Download PDF button.

* From the Transaction ID column in the list of transactions displayed in the Transactions panel in the
maintenance planner.

* From the parameter mopz-transaction-id in the Stack XML file MP_Stack_<Transaction
ID>_<Generation Date>.xml which you can download during the Download Files step in the
Maintenance Planner by choosing the Download Stack XML button.
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i Note

If you started the software provisioning manager using a Stack XML file, the Maintenance Planner
Transaction ID is only displayed.

* Your S-UserlID and password
You call Software Provisioning Manager with command line parameter
SAPINST_STACK_XML=<Absolute_Path_To Stack XML_File> to get the Maintenance Planner
Transaction ID extracted from the Stack XML file.
You must perform this option directly after creating the Maintenance Planner Transaction, because the
contained download links usually expire soon.
Ensure the following for your S-User:

1. You have download permissions for all artifacts on https://launchpad.support.sap.com/#/
softwarecenter®rto be able to download them.

2. Consider the SAP Support Portal and the SAP ONE Support Launchpad password policies#r: Your
password must be the same for both of them. If the passwords are not the same, you will lock the
S-User in the SAP Support Portal. The password must meet all of the following requirements:

Must be exactly eight characters long

Contains at least one upper-case letter (A-Z)

Contains at least one lower-case letter (a-z)

Contains at least one decimal digit (0-9)

Contains at least one of the following special characters: '1N@ $% / ({[]}) +-*=7?"'~#
_is>

Must not start with ? or !

Must not contain any blanks

Must not begin with three identical characters

Must be different from the last five passwords you have already used

Only one password change is allowed per day

If required, request a change of your SAP Support Portal Password and of your SAP ONE Support
Password at https://support.sap.com/en/my-support/users.htm| .

* Location of download folder for the installation software packages to be downloaded

* If you have a proxy configured in your network, provide the proxy host and port.

5. You get alist of all downloadable artifacts (SAP archives) as specified in the Stack XML file along with their

file size.

You can still deselect downloadable artifacts (SAP archives) that you do not need to be downloaded.

6. Choose Next to start the download.

If you get a download error, this is the result of an unsuccessful network connection. Check your network
connection and proxy configuration. If the download of some artifacts finishes without any error, but still
with a status other than OK, you must do one of the following:

¢ Create an up-to-date Maintenance Plan and perform again the download of the files which were not
downloaded successfully. In case of an error, the software provisioning manager skips the download of
the artifact (SAR archive) in question and continue with the next one in the list.

* Download the still missing files directly from the SAP Software Center at https:/
launchpad.support.sap.com/#/softwarecenter #r.
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Results

You have downloaded the artifacts (SAP archives) required for your SAP system installation with the software
provisioning manager - corresponding to the archives listed in section Downloading SAP Kernel Archives
(Archive-Based Installation) [page 83] - and for applying the required kernel and support packages using
Software Update Manager (SUM) after the installation has completed.

SAP BW/4HANA 1.0 SR1 only: RDBMS and export media are not covered by this feature. You have to provide
them either as physical media or download them from the SAP Software Center as described in Downloading
Complete Installation Media [page 88].

4.8.1.4 Downloading Complete Installation Media

This section describes how you can download complete media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading
and Extracting the Software Provisioning Manager 1.0 Archive [page 80].

2. Create a download directory on the host where you want to run the software provisioning manager.

3. You identify the required media as listed in Media Required for the Installation - Listed by SAP System
Instance [page 76] .

4. l|dentify all download objects that belong to one medium according to one of the following:

i Note

Installation media might be split into several files. In this case, you have to reassemble the required files
after the download.

¢ Download path or location:
¢ To download the complete kernel media, go to https://launchpad.support.sap.com/#/
softwarecenter/# | » SUPPORT PACKAGES & PATCHES » By Category  ADDITIONAL
COMPONENTS » SAP KERNEL » SAP KERNEL 64-BIT UNICODE » SAP KERNEL <Version> 64-
BIT UNICODE » <Select your 0S> 1.

* Select | #DATABASE INDEPENDENT 3 to download the database-independent parts of the
kernel.

«* Example

SAPEXE_1110-80002623.SAR
Kernel Part I (753) (*)

SAPEXE_1118-80002612.SAR

* Select|r <Your DB> Jto download the database-independent parts of the kernel.
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5. Download the objects to the download directory.

6. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.
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«» Example

SAPEXEDB_1110-80002623.SAR
Kernel Part Il (753) (*)

i Note

You can only download complete kernel media for kernel release 7.22, which can only be used
for provisioning of SAP products based on SAP NetWeaver 7.3 EHP1. For all remaining SAP
products, you have to download kernel media from https://launchpad.support.sap.com/#/

softwarecenter/# as described in Downloading SAP Kernel Archives (Archive-Based

Installation) [page 83].

* To download the remaining media required for your SAP product, you can use one of the following

navigation paths:

* https:/launchpad.support.sap.com/#/softwarecenter#r|p INSTALLATIONS & UPGRADES

% By Category » SAP NETWEAVER AND COMPLEMENTARY PRODUCTS ¥ <Product>

» <Product Release> J

* https:/launchpad.support.sap.com/#/softwarecenter#e|p INSTALLATIONS & UPGRADES

» By Alphabetical Index (A-Z) » <First Letter of Product> } <Product> }» <Product

Release> J
Material number

All download objects that are part of an installation medium have the same material number and an

individual sequence number:

<Kernelpart>_<Sequence Number>-<Material Number>

«* Example

SAPEXE_1110-80002623.SAR
Kernel Part I (753) (*)
SAPEXE_1111-80002623.SAR
Kernel Part I (753) (*)
SAPEXE_1112-80002623.SAR
Kernel Part I (753) (*)

«* Example

SAPEXEDB_1110-80002623.SAR
Kernel Part Il (753) (*)
SAPEXEDB_1111-80002623.SAR
Kernel Part Il (753) (*)
SAPEXEDB_1112-80002623.SAR
Kernel Part Il (753) (*)

Title

All objects that are part of an installation medium have the same title, such as
<Solution><Media_Name><0S> or <Database>RDBMS<0S> for database media.
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In the unpacking directory, the system creates a subdirectory with a short text describing the medium and
copies the data into it. The data is now all in the correct directory, the same as on the medium that was
physically produced. For more information, see SAP Note 1258173 .

A\ Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation
media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for
archive-based installation.
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5 Installation

5.1 Installation Checklist

This section includes the installation steps for the following:

¢ Standard system
¢ Distributed system
* High-availability system

¢ Additional application server instance

Detailed information about the steps are available in the linked sections.

Standard System

I i Note

1. You check the prerequisites [page 93] and run the software provisioning manager [page 95] to install the
SAP system.

i Note

In a standard system, all mandatory instances are installed on one host in one installation run.

2. You continue with Post-Installation [page 116].

Distributed System

1. Onthe ASCS instance host, you check the prerequisites [page 93] and run the software provisioning
manager [page 95] to install the ABAP central services instance.

i Note

If you want to install an ASCS instance with embedded SAP Web Dispatcher [page 30] or with
embedded SAP Gateway [page 32] or both, you must choose the Custom parameter mode.

When processing the screens for the ASCS instance installation, you are prompted to mark the
corresponding checkbox on the screen Additional Components to be Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters
required for the SAP Web Dispatcher installation on the subsequent screens.
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2. Onthe database instance host, you check the prerequisites [page 93] and run the software provisioning
manager [page 95] to install the database instance.

3. Onthe primary application server instance host, you check the prerequisites [page 93] and run the
software provisioning manager [page 95] to install the primary application server instance.

4. If required, you install I to <N> additional application server instances on the respective hosts, as described
later in this section.

5. You continue with Post-Installation [page 116].

| Only valid for 'High Availability': HA (Windows)

High-Availability System

1. Toinstall a high-availability system with Microsoft Failover Clustering, you perform the HA-specific
installation steps [page 189].

2. You continue with Post-Installation [page 116].

| End of 'High Availability': HA (Windows)

Additional Application Server Instance

You perform the following steps on each host where you install the additional application server instances.

1. You check the prerequisites [page 93] and run the software provisioning manager [page 95] to install the
additional application server instances.

| Only valid for 'High Availability": HA (Windows)

A Caution

In a high-availability system, you must install at least one additional application server instance.

| End of 'High Availability': HA (Windows)

2. You continue with Post-Installation [page 116].
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5.2 Specifying the Initial Data Source of the User
Management Engine

During the installation of your SAP system, you have to specify the initial data source of the User Management
Engine (UME).

Prerequisites

You have planned how you want to configure user and access management for your SAP system to be installed
as described in Planning User and Access Management [page 45].

Procedure

Using Central User Management

1. You install your SAP system as described in this installation guide.

2. Add the system to Central User Administration (CUA). For more information, see Configuring User
Management [page 139].

Using an LDAP directory as Source for User Data

1. You install your SAP system as described in this installation guide.

2. Configure the user management of the newly installed SAP system to use an LDAP directory.
For more information, see Configuring User Management [page 139].

5.3 Prerequisites for Running Software Provisioning
Manager

Make sure you fulfil the following prerequisites before running the software provisioning manager.

* For the SL-Ul, make sure that the following web browser requirements are met:
* You have one of the following supported browsers on the device where you want to run the SL-Ul:
* Google Chrome (recommended)
* Mozilla Firefox
* Microsoft Edge
* Microsoft Internet Explorer 11 or higher.
Always use the latest version of these web browsers.

* Ifyou copy the SL-UI URL manually in the browser window, make sure that you open a new Web
browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private
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browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the
SL-UL

A Caution

The software provisioning manager uses a self-signed certificate, which is used temporarily only

while the software provisioning manager is running. This certificate is not trusted by the browser
unless it is imported manually by the user running the software provisioning manager. This behavior

is intentionally designed in this way because - unlike ordinary public web servers - the software
provisioning manager has different usage patterns. You must configure your browser do trust the
self-issued certificate of the software provisioning manager after carefully performing the “thumbprint”
verification described in Running Software Provisioning Manager [page 95] . For more information
about adding trusted certificates, see the documentation of your browser.

For more information about the SL-Ul, see Useful Information about Software Provisioning Manager [page
102].

* |f you want to enable Internet Protocol Version 6 (IPv6), make sure that you set SAP_1Pv6_ACTIVE=1in
the environment of the user with the required authorization [page 70] to run the software provisioning
manager. While running the software provisioning manager, this setting is then also added to the
environment of the <sapsid>adm user.

i Note

By applying this setting the SAP system administrator is responsible for configuring the IP version on
each host of the system landscape, before installing any additional instance to it.

* You need at least 700 MB of free space in the installation directory for each installation option. In addition,
you need 700 MB free space for the software provisioning manager executables. The software provisioning
manager creates an installation directory sapinst_instdir, where it keeps its log files, and which is
located directly in the %ProgramFi les% directory. For more information, see Useful Information about
Software Provisioning Manager [page 102].

* Make sure that you have defined the most important SAP system parameters as described in Basic
Installation Parameters [page 47] before you start the installation.

* Check that your installation host meets the requirements for the installation options that you want to
install.
For more information, see Running the Prerequisite Checker [page 39].

* If you are installing a second or subsequent SAP system in an existing database (MCOD), make sure that
the database is up and running before starting the installation.
For more information, see Installation of Multiple Components in One Database [page 171].

¢ If you want to install an additional application server instance in an existing SAP system, make sure that:

* The service definitions for the SAP start services are configured correctly and refer to the correct
profile files.

* There are no profile backup files with an underscore “_" in their profile name. If so, replace the “_" with
a“’
«* Example

Rename <Drive>:\usr\sap\S14\SYS\profile\S14_D20_wsi6408_12 to
<Drive>:\usr\sap\S14\SYS\profile\S14 DVEBMGS20 wsi6408.12.

* Make sure that the following ports are not used by other processes:
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* Port 4237 is used by default as HTTPS port for communication between the software provisioning
manager and the SL-UL.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST_HTTPS_PORT=<Free Port Number>

* Port 4239 is used by default for displaying the feedback evaluation form at the end of the software
provisioning manager processing.
The filled-out evaluation form is then sent to SAP using HTTPS.
If this port cannot be used, you can assign a free port number by executing sapinst.exe with the
following command line parameter:
SAPINST_HTTP_PORT=<Free Port Number>

¢ If you want to perform the installation in unattended mode, see System Provisioning Using an Input
Parameter File [page 103] which describes an improved procedure using inifile.params.

5.4 Running Software Provisioning Manager

This section describes how to run the software provisioning manager.

Prerequisites

For more information, see Prerequisites for Running Software Provisioning Manager [page 93].

Context

The software provisioning manager has a web browser-based GUI named “SL-Ul of the software provisioning
manager” - “SL-Ul" for short.

This procedure describes an installation where you run the software provisioning manager and use the SL-UI,
that is you can control the processing of the software provisioning manager from a browser running on any
device.

For more information about the SL-Ul, see Useful Information about Software Provisioning Manager [page
102].

Procedure

1. Log on to the installation host using an account with the required user authorization to run the software
provisioning manager [page 70].
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A\ Caution

Do not use an existing <sapsid>adm or the built-in administrator account user.

If your security policy requires that the person running the software provisioning manager is not allowed

to know administrator credentials on the installation host, you can specify another operating system

user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when
starting sapinst.exe from the command line. You must confirm that the user is a trusted one. For more
information, see SAP Note 1745524 #r .

2. Make the installation media available.

For more information, see Preparing the Installation Media [page 75] .

i Note

Even if you use the complete SAP kernel media, the software provisioning manager might prompt you
during the provisioning process for additional archives (*SAR files) due to special Patch Level (PL)
requirements depending on categories such as the product, operating system, and database platform.

<X> of the SAPEXEDB. SAR (for DBTYPE <Y>), but this PL of the SAPEXEDB . SAR is not contained

in the SAP kernel media . In this case you must download the required PL from https:/
launchpad.support.sap.com/#/softwarecenter# following the instructions given in Downloading SAP
Kernel Archives (Archive-Based Installation) [page 83].

3. Start the software provisioning manager from the directory to which you unpacked the Software
Provisioning Manager archive with the following command:

sapinst.exe (ina command prompt)

-\sapinst.exe (in PowerShell)

i Note

If you are using a Stack XML file (see Installation Using a Stack XML
File [page 36]), you must call sapinst.exe with command line parameter
SAPINST_STACK_XML=<Absolute_Path_To_ Stack XML_File>:

sapinst.exe SAPINST_STACK_XML=<Absolute_Path_To_Stack XML_File>(inacommand
prompt)

-\sapinst.exe SAPINST_STACK_XML=<Absolute_Path_To_Stack_ XML_File> (in PowerShell)

If you want to run your installation using a Stack XML file in unattended mode, consider the additional
command line parameters described in System Provisioning Using an Input Parameter File [page 103].

By default, the SL-Ul uses the default browser defined for the host where you run the software
provisioning manager. However, you can also specify another supported web browser available on the
host where you start the software provisioning manager. You can do this by starting the sapinst
executable with command line option SAPINST_BROWSER=<Path to Browser Executable>, for
example SAPINST_BROWSER=Firefox.exe.
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i Note

If you need to assign a virtual host name to the instance to be installed and you do not want to assign
it by entering it as a parameter using the software provisioning manager screens (see SAP System
Parameters [page 48]), you can alternatively assign it as follows:

1. Openacommand prompt or PowerShel I window in elevated mode and change to the directory to
which you unpacked the Software Provisioning Manager archive.

2. Start the software provisioning manager with the following command:
sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name> (in a command prompt)
-\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_ Host_ Name> (in PowerShell)

For more information, see Using Virtual Host Names [page 72].

i Note

If you are running a system copy with parallel export/import using the Migration

Monitor with the R3load socket option and started the export with command line option
SUPPORT_DECLUSTERING=Ffalse, you must start the software provisioning manager for the
installation of the target database instance with command line option SUPPORT_DECLUSTERING=true
for the import during the target system installation.

For more information, see the system copy guides at http:/support.sap.com/sltoolset# | » System

Provisioning # System Copy Option of Software Provisioning Manager # System Copy Guides 3

4. The software provisioning manager now starts and waits for the connection with the SL-UlI.

If you have a supported web browser (see Prerequisites for Running Software Provisioning Manager [page
93]) installed on the host where you run the software provisioning manager, the SL-Ul starts automatically
by displaying the Welcome screen.

If the SL-Ul does not open automatically, you can find the URL you require to access the SL-Ul at the
bottom of the Program Starter window of the software provisioning manager. You find the icon of the
Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the
URL from there.

B o L

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]

B o L e

i Note

If the host specified by <hostname> cannot be reached due to a special network configuration,

proceed as follows:

1. Terminate the software provisioning manager as described in Useful Information about Software
Provisioning Manager [page 102].

2. Restart the software provisioning manager from the command line with the
SAPINST_GUI_HOSTNAME=<hostname> property.
You can use a fully-qualified host name.
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A\ Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://" to avoid
security risks such as SSL stripping .

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst
process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the
certificate.

0
di

pen the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones
splayed in the console output of the software provisioning manager.

Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate
printed in the software provisioning manager console:

1.

Go to the sapinst_exe . xxxxxx.xxxx directory in the temporary directory to which the
software provisioning manager has extracted itself:
Y%userprofile%\.sapinst\

2. Inthe sapinst_exe.xxxxxx.xxxx directory, execute the sapgenpse tool with the

command line option get_my_name -p.

As aresult, you get the server fingerprint or thumbprint from the server certificate.

Accept the warning to inform your browser that it can trust this site, even if the certificate could not
be verified.

The SL-Ul opens in the browser by displaying the Welcome screen.

5. On the Welcome screen, choose the required option:

* Perform preparations

Go to |+ Generic Options  <Database> » Preparations 4 and choose the required task.

To install SAP Host Agent separately, choose | Generic Options » <Database> » Preparations » SAP
Host Agent .

¢ Install an SAP system:

98 PUBLIC

To install an SAP system based on SAP NetWeaver AS ABAP from scratch, choose |+ <Product>
» <Database> j Installation » Application Server ABAP » <System_Variant> J.

To install the application server ABAP for an SAP Process Integration system based on

SAP NetWeaver 7.5 from scratch, choose [+ SAP NetWeaver 7.5 » <Database> » Installation

» Application Server ABAP for SAP Process Integration » <System Variant> 1.

To install the application server ABAP for an SAP Solution Manager 7.2 system from

scratch, choose | SAP Solution Manager 7.2 <Support_Release> » <Database> » Installation
» Application Server ABAP » <System Variant> 1.

To install an SAP system based on SAP NetWeaver AS ABAP as target system of a system copy,
choose | <Product> }» <Database> }» System Copy #» Target System » <System_Variant>

» Based on AS ABAP 1.

To install the application server ABAP for an SAP Process Integration system based on SAP
NetWeaver 7.5 as target system of a system copy, choose [+ SAP NetWeaver 7.5 » <Database>
» Systemn Copy » Target System » <System_Variant> » Based on AS ABAP .
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* Toinstall the application server ABAP for an SAP Solution Manager 7.2 system as target system
of a system copy, choose |r SAP Solution Manager 7.2 <Support_Release> » <Database>
» System Copy » Target System j» <System_Variant> » Based on AS ABAP .
* Install an additional SAP system instance, go to [ <Product> j <Database> » Additional SAP
System Instances ¥ Additional Application Server Instance 3.
* Perform other tasks or install additional components
Go to |+ Generic Options  <Database> J and choose the required task.
6. Choose Next.

i Note

If there are errors during the self-extraction process of the software provisioning manager, you can find
the log file dev_selfex.out in the temporary directory.

7. If the software provisioning manager prompts you to log off from your system, log off and log on again.
The software provisioning manager restarts automatically.

8. Follow the instructions on the software provisioning manager screens and enter the required parameters.

i Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

i Note

If you want to install an ASCS instance with embedded SAP Web Dispatcher [page 30] or with
embedded SAP Gateway [page 32] or both, you must choose the Custorn parameter mode.

When processing the screens for the ASCS instance installation, you are prompted to mark the
corresponding checkbox on the screen Additional Components to be Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters
required for the SAP Web Dispatcher installation on the subsequent screens.

° [ Only valid for 'High Availability': HA (Windows)
High Availability only: If you decide to install an SAP Web Dispatcher or a Gateway in the ASCS
instance, note that a failure of the SAP Web Dispatcher or the Gateway causes failover of the ASCS
instance to another cluster node. The failover cluster monitors all processes that are started by the
SAP start service (sapstartsrv.exe). For an ASCS instance this is: msg_server .exe (message server),
enserver .exe (enqueue server), gwrd.exe (Gateway), and sapwebdisp.exe (SAP Web Dispatcher).
To prevent failover, see SAP Note 2375999 ¥ .

l End of 'High Availability: HA (Windows)

i Note

If you are performing the target system installation in the context of a system copy with parallel export/
import using the Migration Monitor and the target database is declustered - that is you started the
software provisioning manager for the target database instance installation with command line option
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SUPPORT_DECLUSTERING=true as described above - add the following load options parameter in the
SAP System Advanced Load Configuration screen:

-datacodepage <datacodepage of source_system>

The advanced screen for load configuration only appears if you run the software
provisioning manager in Custom parameter mode. You can check the parameter within the
import_monitor_cmd.properties file located in the installation directory, in the loadArgs entry.

For more information, see the system copy guides at http:/support.sap.com/sltoolset# | » System
Provisioning  System Copy Option # Guide for Systems Based on SAP NetWeaver 7.1 & Higher . 3

A\ Caution

The digital signature of installation media and installation archives is checked automatically during the
Define Parameters phase while processing the Media Browser and - if you perform an archive-based
installation - the Software Package Browser screens.

Note that this automatic check is only committed once and not repeated if you modify artifacts such
as SAR archives or files on the media after the initial check has been done. This means that - if you
modify artefacts later on either during the remaining Define Parameters phase or later on during the
Execute Service phase - the digital signature is not checked again.

For more information, see SAP Note 2393060 #& .

After you have entered all requested input parameters, the software provisioning manager displays the
Parameter Summary screen. This screen shows both the parameters that you entered and those that the
software provisioning manager set by default. If required, you can revise the parameters before starting the
installation.

To start the installation, choose Next.

The software provisioning manager starts the installation and displays the progress of the installation.
When the installation has finished, the software provisioning manager shows the message: Execution of
<Option_Name> has completed.

During the installation of an Application Server ABAP for SAP Process Integration 7.5 or SAP Solution
Manager 7.2, the following is automatically accomplished by the software provisioning manager:

® The Java users for the Application Server Java for SAP Process Integration or SAP Solution Manager
are created, which you have to install once the installation of the Application Server ABAP for SAP
Process Integration or SAP Solution Manager is complete.

* The Application Server ABAP for SAP Process Integration or SAP Solution Manager is prepared for
connection to the Application Server Java for SAP Process Integration or SAP Solution Manager.
For details on these users, see the Preparing an External ABAP System as Source for User Data chapter
of the Installation of SAP Systems Based on the Application Server Java of SAP NetWeaver 7.5 and SAP
Solution Manager 7.2 SR2 Java on <OS>: <DB> documentation, which you must use anyway to install
the Application Server Java for SAP Process Integration 7.5 or SAP Solution Manager 7.2 after you have
installed the Application Server ABAP.

If you are performing an Installation Using a Stack XML File [page 36], the Software Update Manager
(SUM) is started by the software provisioning manager at the end of the installation process. A browser
window opens with a link to Ul of the SUM that is already running. Follow the instructions on the SUM

dialogs and in the SUM Guide at https:/support.sap.com/sltoolset® | » System Maintenance 3.
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10. If required install an additional application server instance for a standard (central) or distributed system.
11. If you copied the software provisioning manager software to your hard disk, you can delete these files when
the installation has successfully completed.

12. For security reasons, we recommend that you delete the .sapinst directory within the home directory of
the user with which you ran the software provisioning manager:

Y%userprofile%\.sapinst\

13. The software provisioning manager log files contain IP addresses and User IDs such as the ID of your
S-User. For security, data protection, and privacy-related reasons we strongly recommend that you delete
these log files once you do not need them any longer.

You find the software provisioning manager log files in the sapinst_instdir directory. For more
information, see Useful Information about Software Provisioning Manager [page 102].

5.5 Additional Information about Software Provisioning
Manager

The following sections provide additional information about the software provisioning manager.

Useful Information about Software Provisioning Manager [page 102]
This section contains some useful technical background information about the software provisioning
manager and the software provisioning manager's SL-Ul.

System Provisioning Using an Input Parameter File [page 103]
Provisioning with software provisioning manager, for example installation, of SAP systems in
unattended mode with an input parameter file.

How to Avoid Automatic Logoff by Software Provisioning Manager [page 108]

Restarting Interrupted Processing of Software Provisioning Manager [page 109]
Here you find information about how to restart the software provisioning manager if its processing has
been interrupted.

Entries in the Services File Created by Software Provisioning Manager [page 113]

Troubleshooting with Software Provisioning Manager [page 113]
This section tells you how to proceed when errors occur while the software provisioning manager is
running.

Using the Step State Editor (SAP Support Experts Only) [page 114]
This section describes how to use the Step State Editor available in the software provisioning
manager.
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5.5.1 Useful Information about Software Provisioning

Manager

This section contains some useful technical background information about the software provisioning manager
and the software provisioning manager's SL-UlI.

102

The software provisioning manager has a framework named “SAPinst”. For more information about the
current SAPinst Framework version and its features, see SAP Note 3207613# (SAPinst Framework 753
Central Note).

The software provisioning manager has the web browser-based “SL-Ul of the software provisioning
manager” - “SL-UI" for short.
The SL-Ul uses the SAP Ul Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5
rendering library based on JavaScript. The benefits of this new user interface technology for the user are:
* Zero foot print, since only a web browser is required on the client
* New controls and functionality, for example, view logs in web browser.
As of version 1.0 SP24 Patch Level (PL) 5, the software provisioning manager comes with a new look and
feel of the SL-UI. For more information, see https://blogs.sap.com/2018/11/10/new-look-for-software-
provisioning-manager/ #r .
The SL-Ul connects the web browser on a client with the sapinst executable - which is part of software
provisioning manager - running on the installation host using the standard protocol HTTPS.
For the SL-UlI, the software provisioning manager provides a pre-generated URL in the Program Starter
window. If you have a supported web browser installed on the host where you run the software provisioning
manager, the SL-Ul starts automatically.
By default, the SL-Ul uses the default browser defined for the host where you run the software
provisioning manager. However, you can also specify another supported web browser available on the
host where you start the software provisioning manager. You can do this by starting the sapinst
executable with command line option SAPINST_BROWSER=<Path to Browser Executable>, for
example SAPINST_BROWSER=Firefox.exe.
Alternatively you can open a supported web browser on any device and run the URL from there.
For more information about supported web browsers see Prerequisites for Running Software Provisioning
Manager [page 93].
If you need to run the SL-Ul in accessibility mode, apply the standard accessibility functions of your web
browser.

As soon as you have started the sapinst.exe executable, the software provisioning manager creates
a .sapinstdirectory underneath the <Drive>:\Users\<User> directory where it keeps its logs and
other technical files. <User> is the user which you used to start the software provisioning manager.
After you have reached the Welcome screen and selected the relevant software provisioning manager
option for the SAP system or instance to be installed , the software provisioning manager creates a
directory sapinst_instdir, where it keeps its logs and other technical files, and which is located
directly in the %ProgramFi les% directory. If the software provisioning manager is not able to create
sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the TEMP
environment variable.

All'log files which have been stored so far in the .sapinst folder are moved to the sapinst_instdir
directory as soon as the latter has been created.

The software provisioning manager records its progress in the keydb . xml file located in the
sapinst_instdir directory. Therefore, if required, you can continue with the software provisioning
manager from any point of failure, without having to repeat the already completed steps and without
having to reenter the already processed input parameters. For security reasons, a variable encryption key
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is generated as soon as the sapinst_instdir directory is created by the software provisioning manager.
This key is used to encrypt the values written to the keydb . xml file.

- Recommendation

We recommend that you keep all installation directories until the system is completely and correctly
installed.

* The software provisioning manager extracts itself to a temporary directory (TEMP, TMP, TMPDIR, or
SystemRoot). These executables are deleted after the software provisioning manager has stopped
running.

Directories called sapinst_exe . XxXxXxxX . xxxx sometimes remain in the temporary directory after the
software provisioning manager has finished. You can safely delete them.

The temporary directory also contains the log file dev_selfex.out from the self-extraction process of
the software provisioning manager, which might be useful if an error occurs.

O\ Caution

If the software provisioning manager cannot find a temporary directory, the installation terminates with
the error FCO-00058.

¢ Tosee alist of all available software provisioning manager properties (command line options) and related
documentation, open a command prompt and start the software provisioning manager with command line
parameter -p:
sapinst -p

¢ If you want to perform the installation in unattended mode, see System Provisioning Using an Input
Parameter File [page 103] which describes an improved procedure using inifile.params.

* Ifrequired, stop the software provisioning manager by choosing the Cancel button.
i Note

If you need to terminate the software provisioning manager, choose || File ¥ Exit 3 in the menu of the
Program Starter window.

5.5.2 System Provisioning Using an Input Parameter File

Provisioning with software provisioning manager, for example installation, of SAP systems in unattended mode
with an input parameter file.

Prerequisites

Provisioning of SAP systems can also be done in unattended mode without the user interface of software
provisioning manager. This means that, after inserting the required parameters into a parameter-file and
running the sapinst executable by providing the path to this parameter-file , the installation will run in the
background and no further user interaction is required.
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Context

This section describes the steps that you need to execute in addition to the procedure described in this guide,
when running software provisioning manager in unattended mode using an input parameter file.

Since the new Web-based SL-Ul (see Useful Information about Software Provisioning Manager [page 102]) was
introduced in 2017 there are two ways to run the unattended mode: “observer mode” and “non-observer
mode”.

Observer Mode

If you are running an installation in unattended mode but you are sitting in front of the screen, you might want
to check the progress from time to time. In this case the “observer mode” makes sense.

Start the installation as described below in the Solution section, using the following parameters:

SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true

The software provisioning manager will start the installation in the background AND start a Web Dispatcher
and provide an URL to access the SL-Ul. The user who has started the installation can now connect to the URL
and observe the progress of the installation, for example to look at the logfiles in the Web browser. However, all
parameters will be taken from the input parameter file and can not be changed in the Web browser.

Non-Observer Mode

Choose that mode if you want to run a “scripted” or by other means automated scenario, for example
overnight. In that case it is crucial that the process is started without a Web Dispatcher and therefore without
the software provisioning manager's SL-Ul. Otherwise, the automation could be stuck if software provisioning
manager encounters a situation that requires user interaction.

Start the installation as described below in the Solution section, using the following parameters (use the same
parameters like for Observer Mode, but provide SAPINST_START_GUISERVER=false in addition):

SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true

SAPINST_START_GUISERVER=false

This will start the installation but this time NO Web Dispatcher will be started and no URL to access the SL-Ul
will be provided either. So the user can not follow the processing of the installation in a Web browser and the
installation will run completely in the background.

If the process runs into an error, the software provisioning manager will abort and you have to check for the
reason in the log files.

Restrictions

In exceptional cases, parameters prompted or displayed in the Software Provisioning Manager Ul are not
maintainable in the input parameter file. If one of those parameters, that are only available in the Ul mode of
the Software Provisioning Manager, is needed for your unattended installations, you should create a ticket in
the best fitting component below BC-INS to get the issue analyzed.
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Must Know about the Input Parameter File

* The input parameter file only contains values that you entered in the software provisioning manager's
SL-UL.

¢ Withthe SAPinst 749.0.69 or by other means patch we provide a better encryption of passwords in
software provisioning manager files:
If the input parameter file has parameters which are encrypted with Des25 encryption, the instkey . pkey
file available in the installation directory contains the key for the encryption. The instkey . pkey file must
be always located in the same directory as the input parameter file and is used to decrypt the values of the
encrypted parameters. If you need to copy an input parameter file to another directory, you must also copy
the instkey . pkey file to this directory.

* Not explicitly set parameters are documented as comments in the generated input parameter file.
* Each parameter has got a documentation assigned as a comment on top.

«* Example
Example for a parameter that is not used and therefore commented out:

# Specify whether software provisioning manager is to drop the schema if
it exists. <= Documentation
# HDB_Schema_Check_Dialogs.dropSchema = false

«» Example
Example for a parameter that is used:

# The name of the database schema. <= Documentation
HDB_Schema_Check_Dialogs.schemaName = SAPABAP2

* You have to manually provide the media information, using the following convention:

SAPINST.CD.PACKAGE.<unique_media_name>=<location>

* For each media location you must manually insert a dedicated line in your input parameter file. The
software provisioning manager does not automatically take over the media locations you entered while
processing the Media Browser dialog.

* For <media_name> you can choose any value, but the <location> must be unique.

¢ To find out the required media entries, open the summary.html file which you can find in the
installation directory and go to the Dialog "Media" section.

* Make sure that you enter the full paths to all required media, relative paths are not sufficient.
«» Example
Example on UNIX:

SAPINST.CD.PACKAGE .KERNEL = /mnt/KERNEL
SAPINST.CD.PACKAGE.LOAD = /mnt/LOAD
SAPINST.CD.PACKAGE .RDBMS = /mnt/RDBMS

«* Example

Example on Windows:

SAPINST.CD.PACKAGE .KERNEL = C:\sapdvds\KERNEL
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SAPINST.CD.PACKAGE.LOAD = C:\sapdvds\LOAD
SAPINST.CD.PACKAGE.RDBMS =C:\sapdvds\RDBMS

* |f one media contains several subfolders, you can specify it in one of the following ways:

«* Example
The SAP Export DVDs/media:

Installation Master /usr/local/TESI/SWPM/slinst_d_stream/
IM_0S400_PPC64

Installation Export NW73 (folder EXP1l) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP1

Installation Export NW73 (folder EXP3) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

Installation Export NW73 (folder EXP2) /sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP2

* By specifying each subfolder:

SAPINST .CD.PACKAGE . ExportNW73EXP1=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP1

SAPINST.CD.PACKAGE . ExportNW73EXP2=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

SAPINST.CD.PACKAGE . ExportNW73EXP3=/sapmnt/mediaserver2/
arch04_6/51042309/DATA_UNITS/EXP3

* By specifying only the root-folder:
SAPINST .CD.PACKAGE . ExportNW73=/sapmnt/mediaserver2/arch04_6/51042309

¢ Restriction: Currently you can only specify complete media, not paths to single files like * . SAR
archives.
* When performing a system copy, you need to add one additional media path:

SAPINST.CD.PACKAGE_MIGRATION1 = <full path to ABAP Export media>

* Caution:
If you want to use archives for your installation, you must copy all files that are to be used to a single
directory. In the input parameter file you must specify this directory as a download basket, using the
archives.downloadBasket parameter.
Make sure that there is only one version of the same archive in the directory, for example
SAPEXE_<Version>_SAR

Procedure

1. You plan and prepare the run as described in Planning [page 35] and Preparation [page 67].
2. Create your input parameter file as follows:
1. Start software provisioning manager as described in Running Software Provisioning Manager [page
95].
2. Choose the option you want to run, and follow the instructions on the screens by entering all
parameter values.
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3. Stop after the Parameter Summary screen has been displayed.
4. Findthe input parameter file named “inifile.params” in the installation directory.

* Inthe same directory, you will also find the instkey . pkey file with the keys for the encrypted
parameters. For more information, see Must Know about the Input Parameter File above.

* Inthe same directory, you will also find the summary . html file with the required media locations.
For more information, see Must Know about the Input Parameter File above.
5. If required, you can rename the “inifile.params” file as you wish.
3. Adjust the values of the input parameter file as follows:
1. Edit your input parameter file and modify the parameters according to your needs.
2. Add required media or archives information line by line.

4. ldentify the Product-ID:
* Tostart in unattended mode, you need to know the component ID for the option that are required for
your provisioning scenario.
Proceed as follows:
1. Open the sapinst_dev. login the installation directory.

2. Check for the “product-id”
«» Example

product-id=NW_ABAP_ASCS:NW750.ADA.ABAP

¢ Alternatively, you can check the header of the generated input parameter file.
«* Example

product id "NW_ABAP_ASCS:NW750.ADA.ABAP"

5. Run the software provisioning manager [page 95] with the parameters required for unattended mode:
* Make sure that the instkey . pkey file with the keys for the encrypted parameters is available in the
same directory as the input parameter file. Otherwise the encrypted parameters cannot be decrypted.
For more information, see Must Know about the Input Parameter File above.
* In observer mode: Start the sapinst executable from an empty directory with the following
parameters:
SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true
* In non-observer mode: Start the sapinst executable from an empty directory with the following

parameters:

SAPINST_INPUT_PARAMETERS_URL=<path_to_your_parameterfile>
SAPINST_EXECUTE_PRODUCT_ID=<product-id for the installation>
SAPINST_SKIP_DIALOGS=true

SAPINST_START_GUISERVER=Talse

6. After software provisioning manager has completed, perform follow-up activities as described in Post-
Installation [page 116].
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Related Information

SAP Note 2230669 Provisioning with software provisioning manager - for example installation - of SAP
systems in unattended mode with an input parameter file.#

SAP Note 2849054 Software Update Manager Automation with software provisioning manager#
SAP Note 2742212 Unattended installation fails with "Empty directory name is not allowed." message#
SAP Note 2626837 'isUnicode': Radio group contains an invalid value . Valid values are: false|true |

SAP Note 2669183 ASCS installation failure with Software Provisioning Manager unattended mode (Non-
Observer mode)

SAP Note 2482103 Installation with Software Provisioning Manager in unattended mode using input parameter
file failsite

SAP Note 2974889 Installation with Software Provisioning Manager in unattended mode fails in step getDBInfo
due to missing paramertersi

5.5.3 How to Avoid Automatic Logoff by Software
Provisioning Manager

When you install the SAP system, the installation tool checks whether the user account used for the installation
has the required privileges and authorization.

For a local or domain installation, the account needs to be a member of the local Administrators group.

For domain installations the account can be either a member of the Domain Admins group, or belongs to the
Domain Users group and has the necessary rights to create/modify objects in the domain.

For a list of the required permission, see Performing a Domain Installation without being a Domain
Administrator [page 168]

In both cases, the user account must be authorized to do the following:

* Act as part of the operating system
* Adjust memory quotas for a process
* Replace a process level token

If the user account does not have these rights assigned, the software provisioning manager assigns them and
automatically logs the account off to activate them. To avoid the software provisioning manager logging the
account off, you can set these rights manually before you start the installation.

Procedure

You perform the following steps to assign these rights to the user account used for the installation.

A Caution

Be aware that domain policies override locally defined policies. This means that if you want to grant domain
administrator rights to a user who belongs to the local Administrators group, make sure that you have
also defined domain administrator rights for this user on domain level.
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Press + and choose | Administrative Tools ¥ Local Security Policy 4.

In the Local Security Settings window, choose |[|¢ Local Policies » User Rights Assignment. 3.
Double-click the required right under Policy and choose Add User or Group.

In the Select Users and Groups window, choose the required user and choose Add.
The selected user appears in the box below.

2w o

5. Confirm your entry and then repeat the steps for each remaining policy that the user requires for the
installation.

o

Log off and log on again to apply the changes.

Related Information

Required User Authorization for Running Software Provisioning Manager [page 70]

5.5.4 Restarting Interrupted Processing of Software
Provisioning Manager

Here you find information about how to restart the software provisioning manager if its processing has been
interrupted.

Context

The processing of the software provisioning manager might be interrupted for one of the following reasons:

* Anerror occurred during the Define Parameters or Execute phase:
The software provisioning manager does not abort the installation in error situations. If an error occurs, the
installation pauses and a dialog box appears. The dialog box contains a short description of the choices
listed in the table below as well as a path to a log file that contains detailed information about the error.

* You interrupted the processing of the software provisioning manager by choosing Cancel in the SL-Ul.

A\ Caution

If you stop an option in the Execute phase, any system or component installed by this option is
incomplete and not ready to be used. Any system or component uninstalled by this option is not
completely uninstalled.
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The following table describes the options in the dialog box:

Option Definition

Retry

The software provisioning manager retries the installation from the point of failure
without repeating any of the previous steps.

This is possible because the software provisioning manager records its progress in
the keydb . xml file.

We recommend that you view the entries in the log files, try to solve the problem, and
then choose Retry.

If the same or a different error occurs, the software provisioning manager displays
the same dialog box again.

Stop

The software provisioning manager stops the installation, closing the dialog box and
the software provisioning manager's SL-Ul.

The software provisioning manager records its progress in the keydb . xml file.
Therefore, you can continue with the software provisioning manager from the point of
failure without repeating any of the previous steps. See the procedure below.

Continue The software provisioning manager continues the installation from the current point.

View Log Access installation log files.

The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or
to continue an interrupted installation after an error situation.

Procedure

1. Logon to the installation host as a user with the required permissions as described in Running Software
Provisioning Manager [page 95] .

2. Make sure that the installation media are still available.

For more information, see Preparing the Installation Media [page 75] .

- Recommendation

Make the installation media available locally. For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.

3. Make sure that the installation media are still available.

For more information, see Preparing the Installation Media [page 75] .
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- Recommendation

Make the installation media available locally. For example, if you use remote file shares on other
Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from
media mounted with NFS might fail.
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4. Restart the software provisioning manager by double-clicking sapinst.exe from the directory to which
you unpacked the software provisioning manager archive.

By default, the SL-Ul uses the default browser defined for the host where you run the software
provisioning manager. However, you can also specify another supported web browser available on the
host where you start the software provisioning manager. You can do this by starting the sapinst
executable with command line option SAPINST_BROWSER=<Path to Browser Executable>, for
example SAPINST_BROWSER=Firefox.exe.

5. The software provisioning manager is restarting.

If you have a supported web browser (see Prerequisites for Running Software Provisioning Manager [page
93]) installed on the host where you run the software provisioning manager, the SL-Ul starts automatically
by displaying the Welcome screen.

If the SL-Ul does not open automatically, you can find the URL you require to access the SL-Ul at the
bottom of the Program Starter window of the software provisioning manager. You find the icon of the
Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the
URL from there.

Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]

i Note

If the host specified by <hostname> cannot be reached due to a special network configuration,

proceed as follows:

1. Terminate the software provisioning manager as described in Useful Information about Software
Provisioning Manager [page 102].

2. Restart the software provisioning manager from the command line with the
SAPINST_GUI_HOSTNAME=<hostname> property.
You can use a fully-qualified host name.

A\ Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://" to avoid
security risks such as SSL stripping .

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst
process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the
certificate.

2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones
displayed in the console output of the software provisioning manager.
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Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate
printed in the software provisioning manager console:

1. Gotothe sapinst_exe . xxxxxx.xxxx directory in the temporary directory to which the
software provisioning manager has extracted itself:
%userprofile%\.sapinst\

2. Inthe sapinst_exe . xxxxxx.xxxx directory, execute the sapgenpse tool with the
command line option get_my_name -p.
As a result, you get the server fingerprint or thumbprint from the server certificate.

3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not
be verified.

The SL-Ul opens in the browser by displaying the Welcome screen.

6. From the tree structure on the Welcome screen, select the installation option that you want to continue and
choose Next.

The What do you want to do? screen appears.

7. Onthe What do you want to do? screen, decide between the following alternatives and continue with Next:

Alternative Behavior

Perform a new run The software provisioning manager does not continue the interrupted installa-
tion option. Instead, it moves the content of the old software provisioning man-
ager directory and all software provisioning manager-specific files to a backup
directory. Afterwards, you can no longer continue the old option.

The following naming convention is used for the backup directory:

log_<Day>_<Month>_<Year>_<Hours>_<Minutes>_<Seconds>

< Example

log_01_Oct_2016_13 47 56

i Note

All actions taken by the installation before you stopped it (such as creating
directories or users) are not revoked.

A Caution

The software provisioning manager moves all the files and folders to a new
log directory, even if these files and folders are owned by other users. If
there are any processes currently running on these files and folders, they
might no longer function properly.

Continue with the existing one The software provisioning manager continues the interrupted installation from
the point of failure.
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5.5.5 Entries in the Services File Created by Software
Provisioning Manager

After the installation has finished successfully, the software provisioning manager has created the following
entries for port names in <Drive>:\WINDOWS\system32\drivers\etc\services:

sapdp<Instance_Number> = 32<lInstance_Number>/tcp
sapdp<Instance_Number>s = 47<Instance_Number>/tcp
sapgw<Instance_Number> = 33<Instance_Number>/tcp
sapgw<Instance_Number>s = 48<Instance_Number>/tcp

sapms<SAPSID> = 36<Instance_Number>/tcp (unless you specified another value during the installation)

i Note

* Thereis a port created for every possible instance number, regardless of which instance
number you specified during the installation. For example, for sapgw<lnstance_ Number> =
33<Instance_Number>/tcp the following range of entries is created:
sapgw00 = 3300/tcp
sapgw01l = 3301/tcp
sapgw02 = 3302/tcp

L---1
sapgw98 = 3398/tcp
sapgw99 = 3399/tcp

* If there is more than one entry for the same port number, this is not an error.

5.5.6 Troubleshooting with Software Provisioning Manager

This section tells you how to proceed when errors occur while the software provisioning manager is running.

Context

If an error occurs, the software provisioning manager:

¢ Stops processing

¢ Displays a dialog informing you about the error

Procedure

1. Check SAP Note SAP Note 3207613 (SAPinst Framework 753 Central Note) for known software
provisioning manager issues.
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2. Ifanerror occurs during the Define Parameters or the Execute Service phase, do one of the following:

* Tryto solve the problem:

* To check the software provisioning manager log files (sapinst.log and sapinst_dev. log) for
errors, choose the LOG FILES tab.

i Note

The LOG FILES tab is only available if you have selected on the Welcome screen the relevant
software provisioning manager option for the SAP product to be installed .

If you need to access the log files before you have done this selection, you can find the files in
the .sapinstdirectory underneath the <Drive>:\Users\<User> directory, where <User>
is the user that you used to start the software provisioning manager.

For more information, see Useful Information about Software Provisioning Manager [page
102].

¢ Tocheck the log and trace files of the software provisioning manager's SL-Ul for errors, go to the
directory %userprofile%\.sapinst\

* Then continue by choosing Retry.

* Ifrequired, abort the software provisioning manager by choosing Cancel in the tool menu and restart
the software provisioning manager. For more information, see Restarting Interrupted Processing of
Software Provisioning Manager [page 109].

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*,

For more information about using subcomponents of BC-INS* see SAP Note 1669327 #r .

5.5.7 Using the Step State Editor (SAP Support Experts Only)

This section describes how to use the Step State Editor available in the software provisioning manager.

i Note

Only use the Step State Editor if the SAP Support requests you to do so, for example to resolve a
customer incident.

Prerequisites

* SAP Support requests you to use the Step State Editor.

* Make sure that the host where you run the software provisioning manager meets the requirements listed in
Prerequisites for Running Software Provisioning Manager [page 93].
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Procedure

1. Start the software provisioning manager from the command line as described in Running
Software Provisioning Manager [page 95] with the additional command line parameter
SAPINST_SET_STEPSTATE=true

2. Follow the instructions on the software provisioning manager screens and fill in the parameters prompted
during the Define Parameters phase until you reach the Parameter Summary screen.

3. Choose Next.

The Step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be

executed by the software provisioning manager during the Execute Service phase. By default all steps are

in an initial state. Underneath each step, you see the assigned software provisioning manager component.
For each step you have a Skip and a Break option.

* Mark the checkbox in front of the Break option of the steps where you want the software provisioning
manager to pause.
* Mark the checkbox in front of the Skip option of the steps which you want the software provisioning
manager to skip.
4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step
State Editor dialog.

The software provisioning manager starts processing the Execute Service phase and pauses one after
another when reaching each step whose Break option you have marked. You can now choose one of the
following:

* Choose OK to continue with this step.

* Choose Step State Editor to return to the Step State Editor and make changes, for example you
can repeat the step by marking the checkbox in front of the Repeat option.

* Choose Cancel to abort the software provisioning manager.

5. Continue until you have run through all the steps of the Execute Service phase of the software provisioning
manager.
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6 Post-Installation

6.1 Post-Installation Checklist

This section includes the post-installation steps that you have to perform for the following:

i Note
SAP systems based on SAP NetWeaver 7.4:

You can automate some of these post-installation steps by running task list
SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP task manager for lifecycle management automation
(transaction STCO1). For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated
Initial Setup (Optional) [page 119].

The sections describing these steps are marked with a corresponding note at the beginning.

* Standard, distributed, or high-availability system

* Additional application server instance

More detailed information about the steps are available in the linked sections.

Standard, Distributed, or High-Availability System

i Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a
standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 154] immediately after the installation has finished.
2. You check whether you can log on to the Application Server ABAP [page 118].

3. SAP systems based on SAP NetWeaver 7.4 and higher only: You perform the automated initial setup
[page 119].

i Note

This step is optional.

You install the SAP license [page 121].

You configure the remote connection to SAP support [page 123].

You enable the Note Assistant to apply note corrections [page 124].

You configure the documentation provided on the SAP Help Portal [page 1241].
You perform the consistency check [page 126].

© o N O A

If required, you set up symbolic links for application servers [page 1271].
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10. You configure the Transport Management System [page 128].

11. For production systems it is highly recommended that you connect the system to SAP Solution Manager
[page 130].

12. You apply the latest kernel and Support Packages [page 132].

13. You perform post-installation steps for the application server ABAP [page 1341].

14. If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide
whether you want to switch to the new standalone enqueue server 2 and enqueue replicator 2 [page 136].

15. If you installed the ABAP part of an SAP Solution Manager 7.2 or SAP Process Integration 7.5 system,
enable HTTPS communication with the Java part of the system.
For more information, see SAP Solution Manager 7.2, SAP Process Integration 7.5 only: Enabling HTTPS
Communication for ABAP [page 137].

16. If required, you install additional languages and perform language transport [page 138].

17. You configure the user management [page 139].

i Note

This section does not apply for SAP Process Integration 7.5 and SAP Solution Manager, because for
them the user management with an external ABAP system is mandatory . For SAP Process Integration
7.5 and SAP Solution Manager you have to perform special configuration steps which are described in
the guide you have to use for the installation of the Java stack..

18. You ensure user security [page 140].

19. You perform the client copy [page 143].

20.1f required, you install Database Studio [page 145].

21. If required, you generate the personal security environment (PSE) for SAP MaxDB [page 146].

22.You back up the MaxDB database [page 152].

23.You update the database software to the current release [page 153].

24. SAP systems based on SAP NetWeaver 7.4 and higher only: If required, you change the keys for the
secure storage [page 153].

25.You perform a full system backup [page 154].

26.1f you chose to install an embedded SAP Web Dispatcher within the ASCS instance, you log on to the SAP
Web Dispatcher Management Console [page 155]

27. If you chose to install an embedded SAP Web Dispatcher within the ASCS instance, you configure the SAP
Web Dispatcher [page 157]

28.1f you chose to install an embedded Gateway within the ASCS instance, you configure the SAP Gateway
[page 157].

29.You check the Master Guide for your SAP Business Suite application, SAP Solution Manager system
(section Implementation Sequence) or SAP NetWeaver application (section Configuration of Systems and
Follow-Up Activities) for additional implementation and configuration steps, such as language installation,
monitoring, work processes, transports, SAP license, printers, system logs, and connectivity to system
landscape directory (SLD).

Additional Application Server Instance

1. Ifrequired, you perform a full system backup [page 154] immediately after the installation has finished.
2. You check whether you can log on to the Application Server ABAP [page 118].
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You configure the documentation provided on the SAP Help Portal [page 124].
You ensure user security [page 140].
If required, you set up symbolic links for application servers [page 127].

o ok~ w

You perform a full system backup [page 154].

6.2 Logging On to the Application Server ABAP

You need to check that you can log on to the Application Server ABAP with the standard users, given in the
table below.

Prerequisites

® The SAP systemis up and running.
* You have installed the SAP front-end software.

Context

In a distributed or high-availability system, you check whether you can log on to every instance of the SAP
system that you installed.

i Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 .

User User Name Client
SAP system user SAP* 000, 001, 066
DDIC 000, 001

You access the application server ABAP using SAP Logon.

Procedure

1. Start SAP Logon on the host where you have installed the SAP front-end software as follows:
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* SAP GUI for Windows:
o 1 Press+|§|, and enter SAP Logon in the Search field.
2. Choose SAP Logon.
* SAP GUI for Java:
+ 1. Press|windows]|+[Q] and enter SAP GUI for Java <Release>
2. Choose SAP GUI for Java <Release>.
The SAP Logon appears.

i Note

You can alternatively enter the command gui logon in the SAP GUI installation directory to start
SAP GUI for Java.

2. Create alogon entry for the newly installed system in the SAP Logon.
For more information about creating new logon entries, press .

3. When you have created the entry, log on as user SAP* or DDIC.

6.3 SAP NetWeaver 7.4 and Higher: Performing Automated
Initial Setup (Optional)

After the installation of a new SAP system you have to configure the system to enable its usage. For example,
you have to install an SAP license, create logon groups, and configure the Transport Management System
(TMS) and security settings. If your SAP system is based on SAP NetWeaver 7.4 and higher, you can profit from
an automated initial setup which executes these steps automatically.

Prerequisites

Note that the best point in time when you perform automated initial setup depends on the following:

¢ If you have run the installation using a Stack XML file (also called “up-to-date installation™), we recommend
that you proceed as follows:
1. Perform the complete installation and update process - that is the installation with Software

Provisioning Manager and the update with Software Update Manager.

2. Perform the automated initial setup.
By running first the update and then the automated initial setup, you can profit from latest features and
fixes in the initial setup configuration content.
Background: As of Software Logistics Toolset 1.0 SPS12, the installation procedure with Software
Provisioning Manager 1.0 SPO7 and higher also includes basic configuration activities, such as initial basic
configuration of transport management, which are a prerequisite for the subsequent maintenance process.
In previous SP versions of Software Logistics Toolset 1.0, this prerequisite had to be fulfilled by running
automated initial setup before the update process.
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¢ If you have not run the installation using a Stack XML file (also called “up-to-date installation™), we

recommend that you proceed as follows:

1. Runautomated initial setup directly after the installation, using the automation content provided with
the system load.

2. Apply the Support Packages to benefit from the already performed initial configuration — for example,
using the already configured Transport Management System.

3. Consider running the automated initial setup a second time, especially if you want to benefit from
the latest improvements and fixes offered by the updated automation content provided by the applied
Support Package.

For more information about automated initial setup, see the SAP Community Network at https:/
wiki.scn.sap.com/wiki/display/SL/Automated+Initial+Setup+of+ ABAP-Based+Systems .

Procedure

1. Start the ABAP Task Manager by calling transaction STCOL.
2. Choose task list SAP_BASIS_SETUP_INITIAL_CONFIG.

3. Select the tasks you want to get executed.

For this, the task list offers sophisticated online documentation of the comprised activities.

4. Choose Execute.

You are guided through the configuration steps where you can enter the required values.

Related Information

Installation Using a Stack XML File [page 36]

Installing the SAP License [page 121]

Configuring the Remote Connection to SAP Support [page 123]

Configuring the Change and Transport System [page 128]

Applying the Latest Kernel and Support Package Stacks [page 132]
Performing Post-Installation Steps for the ABAP Application Server [page 134]
Performing the Consistency Check [page 126]
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6.4 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license is
automatically installed.

i Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 119].

Context

A\ Caution

Before the temporary license expires, you must apply for a permanent license key from SAP.

We recommend that you apply for a permanent license key as soon as possible after installing your system.

i Note
The license key is bound to the hardware key of the host where the message server is running.
High Availabiltiy only:

In a high-availability system with Microsoft Failover Clustering, the message server is part of the ASCS
instance that can run on a different cluster node. Therefore you must install the SAP license on both nodes.

You have to do failover from the first cluster node where the ASCS instance is installed to the second
cluster node. Use the hardware key of the second cluster node for the installation of the second SAP
license.

For more information about SAP license keys and how to obtain them, see http://support.sap.com/
licensekey P .

Procedure

Install the SAP license as described in the SAP Library at:

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3

EHP1to 7.52 on Windows: SAP MaxDB
Post-Installation PUBLIC 121


http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Flicensekey
http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Flicensekey

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Pack-
agel
http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74 ¥

® SAP NetWeaver 7.5
http://help.sap.com/nw75 "

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap i

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help ¥ Function-Oriented View 1 Solution Life
Cycle Management > SAP Licenses }

6.5 High Availability: Setting Up Licenses

You need to install a permanent license, which is determined by the hardware environment of the message
server.

Prerequisites

The SAP system is up and running.

Context

SAP has implemented a license mechanism for switchover solutions and clustered environments. Your
customer key is calculated on the basis of local information on the message server host. This is the host
machine where the ABAP central services instance (ASCS instance) runs.

To be able to perform a switchover, the temporary license that is installed automatically with the ASCS
instance is not sufficient. You first need to install a permanent license, which is determined by the hardware
environment of the message server. Since SAP's high-availability (HA) solution stipulates two or more cluster
nodes (host machines) where the message server is enabled to run, you have to order as many license keys
[page 121] as you have cluster nodes.

When we receive confirmation from your vendor that you are implementing a switchover environment, we
provide the required license keys for your system, one key for each machine.
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Procedure

1. To find the hardware ID of the primary host, log on to any application server instance of the SAP system

and call transaction SLICENSE.

2. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and
repeat the previous step.
Repeat this for all remaining nodes in the cluster.

3. To obtain the two license keys, enter the hardware IDs for each cluster node, where message server is
enabled to run: http:/support.sap.com/licensekey #

4. Toimport the files containing the two licenses, log on to any application server instance of the SAP system

and call transaction SLICENSE.

5. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and
repeat the previous step.

Repeat this for all remaining nodes in the cluster.

Results

The license is no longer a problem during switchover. This means you do not need to call saplicense in your

switchover scripts.

6.6 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the Early Watch
Service orthe GoingLive Service. Therefore, you have to set up a remote network connection to SAP.

i Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 119].

For more information, see SAP Support Portal at https://support.sap.com/remote-support.html#.
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6.7 Enabling Note Assistant to Apply Note Corrections

Use the Note Assistant to implement note corrections in your ABAP system.

Context

The Note Assistant allows you to automatically implement note corrections in your ABAP system. For
more information about the Note Assistant, see https://support.sap.com/noteassistantf and https://

help.sap.com/netweaver |  SAP NetWeaver Platform » <Release> j» Application Help » SAP NetWeaver
Library: Function-Oriented View » Solution Life Cycle Management » Software Logistics » Note Assistant 1.

Procedure

1. Follow the instructions in SAP Note 2836302 for enabling the Note Assistant for TCI and digitally signed
SAP Notes.

2. Apply important SAP Notes for SAP_BASIS as described in SAP Note 1668882 #r .

6.8 Configuring Documentation Provided on the SAP Help
Portal

In transaction SR13, you can configure the settings of your backend system to point to documentation that is
provided on the SAP Help Portal.

Context

You can configure your backend system to access documentation that is provided on the SAP Help Portal.
Prerequisites

* The documentation you want to access must be available on the SAP Help Portal.
* The users who access the documentation must have access to the Internet.

* You can configure an ABAP system to connect to only one combination of product and version.

If you cannot fulfill one or more of these prerequisites, you must install the documentation in your local system
landscape using the download packages or media provided.
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i Note

For more information about installing the documentation in your local system landscape, see the

Installation of SAP Library guide.

Procedure

1. Open transaction SR13.
2. Select the tab PlainHtmIHttp.

3. Choose New Entries.

A\ Caution

You have to create entries for both documentation and XML documentation areas for each platform
you are using and each language in which you want to provide documentation.

You must use the exact combination of uppercase and lowercase characters specified in the product

and version.

To find the correct entry for the Path field, see the list of products and versions attached to SAP Note

2652009#% .

4. To create entries for the documentation area, enter the following values:

Name Value to be entered

Variant Enter a name for the variant.

Platform Select the platform relevant for your implementation from
the list of available platforms, for example, WN32.

Area Select Documentation from the list; this will display as

IWBHELP in the table.

Server Names

https://help.sap.com/http.svc/ahp2

Path <product/version>
To find the correct entry for the Path field, see the list of
products and versions attached to SAP Note 2652009 #r .
Language Select the language you need from the list.

5. To create entries for the XML documentation area, enter the following values:

Name Value to be entered

Variant Enter a name for the variant (any name).

Platform Select the platform relevant for your implementation from
the list of available platforms, for example, WN32.

Area Select XML Documentation from the list; this will display

as XML_DOCU in the table.

Server Names

https://help.sap.com/http.svc/ahp2
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Name Value to be entered

Path <product/version>

To find the correct entry for the Path field, see the list of
products and versions attached to SAP Note 2652009 ¥ .

Language Select the language you need from the list.

6. Repeat steps 4 and 5 for each relevant platform and language.
7. Select one entry as the default language for each platform and area.

8. Save your entries.

Results

You have configured the settings to point to documentation that is provided on the SAP Help Portal.

Related Information

Installation of SAP Library
SAP Note 2149786/
SAP Note 2652009

6.9 Performing the Consistency Check

We recommend that you check the consistency of the newly installed SAP ABAP system.

i Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 74 and Higher: Performing Automated Initial Setup (Optional) [page 119].

Prerequisites

* If the installation finished successfully, your SAP system should be up and running. Otherwise, start it as
described in Starting and Stopping the SAP System [page 176].
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* You have logged on to the SAP system [page 118].

Context

When logging on to the system for the first time, you need to trigger a consistency check manually. The
function is then called automatically whenever you start the system or an application server.

The following checks are performed:

* Completeness of installation

* Version compatibility between the SAP release and the operating system
The initial consistency check determines whether:

* Therelease number in the SAP kernel matches the release number defined in the database system

® The character set specified in the SAP kernel matches the character set specified in the database
system

¢ Critical structure definitions that are defined in both the data dictionary and the SAP kernel are
identical. The structures checked by this function include SYST, T100, TSTC, TDCT and TFDIR.

* Accessibility of the message server
¢ Availability of all work process types

¢ Information about the standalone enqueue server and the update service

Procedure

1. Perform a system check:
Call transaction SICK.

You should see the entry SAP System Check | no errors reported

2. Perform a database check:

In the DBA Cockpit (transaction DBACOCKPIT), check for missing tables or indexes by choosing
| Diagnostics » Missing Tables and Indexes 3.

6.10 Creating Symbolic Links on Windows Server for
Application Servers

Use

On Windows Server you can create symbolic links for additional application server instances to simplify their
administration.
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[ Only valid for 'High Availability: HA (Windows)

In a high-availability system, you can additionally create symbolic links for the primary application server
instance.

l End of 'High Availability': HA (Windows)

Symbolic links for application servers let you access from your local host the SYS directory that is located on
the global host, without having to specify its UNC path. Instead you can browse, for example, in the Windows
explorer on your local host to the SYS directory and its subdirectories on the global host.

Procedure

To create symbolic links, perform the following steps:

1. Open a PowerShell command in elevated mode, and enter the following PowerShell command in a single
line:
cmd /c mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS \
\<sapglobalhost>\sapmnt\<SAPSID>\SYS

i Note

Enter a blank before \\<sapglobalhost>\. ...

2. If you use a central transport directory, you can also create the following link in PowerShell:
cmd /c mklink /d <localdisk>:\usr\sap\trans \\<trans_dir_host>\sapmnt\trans

i Note

The transport directory host <trans_dir_host> and the <sapglobalhost> can be identical.

A Caution

The command mkl ink creates the link without checking whether the link target exists or is accessible. If
the link does not work after you created it, make sure that it exists and check the accessibility of the UNC
path.

6.11 Configuring the Change and Transport System

You have to perform some steps in the Transport Management System to be able to use the Change and
Transport System (TMS).

i Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 74 and Higher: Performing Automated Initial Setup (Optional) [page 119].
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i Note

SAP_BASIS_SETUP_INITIAL_CONFIG only covers the configuration of TMS as single system.

i Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 36]) and chose Run TMS
Configuration (for Single System) during the installation, you have already completed this step and and skip
this section.

Context

Procedure

1. Calltransaction STMS in the ABAP system to configure the domain controller in the Transport Management
System (TMS).

For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package 1

|} Application Help > Function-Oriented View > Solution
http://help.sap.com/nw731

Life Cycle Management > Software Logistics > Change

SAP NetWeaver 7.4

http://help.sap.com/nw 74 and Transport System > Change and Transport System —
SAP NetWeaver 7.5 Overview ¥ Basics of the Change and Transport System
http://help.sap.com/nw75#r > Transport Management System — Concept }

SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap i

SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

2. Inaddition, you must configure the system change options.
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For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731
® SAP NetWeaver 74

| Application Help #* Function-Oriented View # Solution
Life Cycle Management > Software Logistics > Change

http://help.sap.com/nw74 M and Transport System # Transport Organizer (BC-CTS-
e SAP NetWeaver 75 ORG) > Requirements for Working with the Transport
http://help.sap.com/nw75#r Organizer > Setting the System Change Option 1
p p.sap

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

3. [Only valid for 'High Availability': HA (Windows) \
In a high-availability system with Microsoft Failover Clustering, you must configure all systems in the TMS
landscape. To do this, implement SAP Note 943334 #% .

| End of 'High Availability': HA (Windows) |

4. Call transaction SE38 to schedule a dispatcher job for transport programs by executing report RDD IMPDP.

You schedule the transport dispatcher in the current client. This is equivalent to the execution of job
RDDNEWPP in transaction SE38

6.12 Connecting the System to SAP Solution Manager

Here you find information about how to connect your newly installed SAP system to the SAP Solution Manager
in your system landscape.

i Note

You can skip this section if your newly installed SAP system is itself a SAP Solution Manager system.

Prerequisites

An SAP Solution Manager system must be available in your system landscape. For more information, see
http://help.sap.com/solutionmanager .
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Context

SAP Solution Manager gives you central access to tools, methods, and preconfigured content that you can use
to evaluate and implement your solutions.

When your implementation is running, you can use SAP Solution Manager to manage, monitor, and update
systems and business processes in your solution landscape, and also to set up and operate your own solution
support.

Procedure

You connect a technical system to SAP Solution Manager by the following steps:
1. Onthe technical systems of your landscape, data suppliers are implemented, for example, with
transaction RZ70 for Application Server ABAP and with Visual Administrator for Application Server Java.

For more information, see the SAP Solution Manager Application Help:

* If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures » Landscape Management Database (LMDB) ¥ Setting Up the Landscape
Management Infrastructure ¥ Importing Landscape Data, CIM Model, and CR Content J

* If your SAP Solution Manager release is 7.1:
http://help.sap.com/solutionmanager# | » Version 71 SPS <No> ¥ Application Help (English)
» SAP Solution Manager Operations » Managing System Landscape Information » Managing Technical
System Information  Register Technical Systems Automatically by Data Suppliers 3

2. The data suppliers send information about the hardware and installed software to a central System
Landscape Directory (SLD). Updates are sent to the SLD as well. Alternatively, systems can send
information directly to the LMDB in SAP Solution Manager, without an SLD, as described in http://

help.sap.com/solutionmanager® | » Version 72 SPS <No> » Application Help (English) » Technical
Infrastructures ¥ Landscape Management Database (LMDB) ¥ Setting Up the Landscape Management
Infrastructure » Importing Landscape Data, CIM Model, and CR Content 1.

For more information, see Handling Technical Systems' Data - System Landscape Directory
at https://support.sap.com/en/tools/software-logistics-tools/landscape-management-process/system-
landscape-directory.htm| e,

3. Fromthe SLD, this information is regularly synchronized with SAP Solution Manager where it is managed
in the Landscape Management Database (LMDB).

For more information, see the SAP Solution Manager Application Help:

¢ If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures » Landscape Management Database (LMDB) » Setting Up the Landscape
Management Infrastructure » Importing Landscape Data, CIM Model, and CR Content
» Synchronization with an SLD J
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¢ If your SAP Solution Manager release is 7.1:
http://help.sap.com/solutionmanager# | » Version 71 SPS <No> » Application Help (English) » SAP
Solution Manager Operations # Managing System Landscape Information j Setting Up the Landscape
Management Infrastructure » Connecting LMDB to System Landscape Directory (SLD) 3
4. Inthe LMDB, you complete the information from the SLD manually.

For more information, see the SAP Solution Manager Application Help:

¢ If your SAP Solution Manager release is 7.2:
http://help.sap.com/solutionmanager# | » Version 7.2 SPS <No> » Application Help (English)
» Technical Infrastructures ¥ Landscape Management Database (LMDB) ¥ Managing Technical System
Information 3

* If your SAP Solution Manager release is 7.1:
Managing Technical System Information and Managing Product System Information at http://

help.sap.com/solutionmanager# | » Version 7.1 SPS <No> » Application Help (English) » SAP

Solution Manager Operations » Managing System Landscape Information 3

Related Information

Setting Up the Landscape Management Infrastructure
Importing Landscape Data, CIM Model, and CR Content
Synchronization with an SLD

Managing Technical System Information

Handling Technical Systems' Data - System Landscape Directory

6.13 Applying the Latest Kernel and Support Package
Stacks

We strongly recommend that you apply the latest kernel and Support Package stacks before you start
configuring your SAP system.

i Note

If you are using a Stack XML file (see Installation Using a Stack XML File [page 36]), you already
downloaded the stack.xml file and the delta archives. If you then already called the Software Update
Manager (SUM) from the software provisioning manager and applied the Support Package Stacks after the
installation had finished, you can skip this section.
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Context

For more information about release and roadmap information for the SAP Kernel versions, and how this relates
to SAP system support packages - including important notes on downward compatibility and release dates -
see the central SAP Kernel notes:

Central SAP Notes

2083594 # - SAP Kernel Versions and SAP Kernel Patch Levels

3116151#% - SP Stack Kernel Schedule Forecast

1744209#% - SAP Kernel 720, 721 and 722: Versions and Kernel Patch Levels
1969546#% - Release Roadmap for Kernel 74x and 75x

1802333#% - Finding information about regressions in the SAP kernel
19466#% - Downloading SAP kernel patches

2966761#F - Overview of SAP Kernel Correction Archives

2966621 - Overview of Kernel-Related Software Components

953653 - Rolling Kernel Switch

The white paper Update Strategy for the Kernel of the Application # Server ABAP in On Premise Landscapes
provides SAP recommendations on how to patch the SAP kernel.

i Note

If you have installed an SAP Solution Manager 7.2 system, you must apply at least Support Package Stack
(SPS) 01. You cannot use SAP Solution Manager 7.2 with SPS 0O0.

Procedure

* Download and apply the latest Kernel and Support Package stacks using the Software Update Manager
(SUM) as described in the Software Update Manager documentation at: https://support.sap.com/en/
tools/software-logistics-tools/software-update-manager.htm| #

* |f you want to update the kernel manually, proceed as described below:

a. Logon as user <sapsid>adm to the hosts of the SAP system instances to be updated.

b. Download the latest kernel for your operating system and database platform as described in SAP Note
1946674 .

c. Back up the kernel directory that is specified by the profile parameter DIR_CT_RUN.

d. Extract the SAR files of the kernel Support Packages of the target SP level to a temporary directory
using the SAPCAR tool.

e. Copy or move the extracted programs from the temporary directory to the local kernel directory.
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6.14 Performing Post-Installation Steps for the ABAP
Application Server

This section describes the post-installation steps you have to perform for the ABAP application server.

i Note
SAP systems based on SAP NetWeaver 7.4 or higher only:

You can automate this step by running task list SAP_BASIS_SETUP_INITIAL_CONFIG in the ABAP
task manager for lifecycle management automation (transaction STCO1). For more information, see SAP
NetWeaver 74 and Higher: Performing Automated Initial Setup (Optional) [page 119].

Prerequisites

You have logged on to the ABAP application server as described in Logging On to the Application Server [page
118].

Context

You have to perform the following post-installation steps for the ABAP application server:

* Upload and set system profiles using transaction RZ10

* Configure the number of work processes

* Create logon and RFC server groups using transactions SMLG and RZ12
* Create operation modes using transaction RZ04

¢ Schedule standard jobs using transaction SM36

* Configuration of SLD data supplier using transaction RZ70

* Perform load generation using transaction SGEN

For more information, see the appropriate sections below.

Procedure

¢ Upload and Set System Profiles using Transaction RZ10

You upload system profiles, such as default profile and instance profile, from the file system into the
database of the target system using transaction RZ10.
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For more information about how to maintain SAP system profiles, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731

® SAP NetWeaver 74
http://help.sap.com/nw74 F

® SAP NetWeaver 7.5
http://help.sap.com/nw75F

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View >
Application Server > Application Server ABAP >
Administration of Application Server ABAP }

Configure the number of work processes

SAP systems are installed with a minimum number of work processes. This is only an initial configuration
to get you started after the installation. It is not detailed enough for a production system because the
optimal number of each type of work process depends on the system resources and on the number of
users working in each SAP system application. For more information about how many work processes to
configure and how to set the number, see SAP Note 39412 #r .

Create Logon and RFC Server Groups using Transactions SMLG and RZ12
You create the following:

* Logon groups using transaction SMLG

* RFC server groups using transaction RZ12
Specify the following:

* Name of the logon or RFC server group
* Instance name (application server)

* Group type attributes are optional

If required, you create the RFC server group paral lel_generators.
Create Operation Modes using Transaction RZ04

You check for existing operation modes and - if required - create a new operation mode using transaction
Rz04.
Specify the following:

* Name of the operation mode
* Short description
¢ QOptional: monitoring properties variant

Select the corresponding checkbox to assign the operation mode to the following:

* Time table (assignment only from 0-24 h)
* Current application server instance
Schedule Standard Jobs using Transaction SM36
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You schedule SAP standard jobs using transaction SM36.

If a standard job is already scheduled, it is kept. Only missing jobs are scheduled.
¢ Configure the SLD Data Supplier using Transaction RZ70
a. Make sure that the SLD and the SLD bridge (the receiving thread of the SLD, which runs on a Java EE
engine) are running.
b. Configure the System Landscape Directory (SLD) data supplier with default settings, using transaction
RZ70.

SLD configuration is a prerequisite for the connection of an SAP system to SAP Solution Manager.

For more information, see Connecting the System to SAP Solution Manager [page 130]
* Perform Load Generation using Transaction SGEN

You generate the ABAP loads using transaction SGEN. ABAP loads are platform-dependent programs that
are generated during runtime and stored in database tables. Using transaction SGEN you can generate
ABAP loads of a number of programs, function groups, classes, and so on.

Choose one of the following generation modes:

* Generate All Objects
All existing objects of all software components are generated synchronously. Job RSPARGENERSM
starts the generation directly after all ABAP objects have been prepared for generation and have been
stored in table GENSETC. Be aware that this is a time-consuming process.

i Note

Make sure that you have sufficient space available on your database. The generation of all existing
objects requires around 2 - 9 GB of free space.

* Prepare All Objects for Generation
All objects to be generated are prepared for generation and stored in table GENSETM. You can start the
generation of these objects later with transaction SGEN. Choose this strategy if object generation is to
be done outside the configuration task due to performance issues.

6.15 Systems Based on SAP NetWeaver AS for ABAP 7.52
only: Switching to Standalone Enqueue Server 2 and
Enqueue Replicator 2

If you installed a high-availability SAP system based on SAP NetWeaver AS for ABAP 7.52 , you can switch to
“Standalone Enqueue Server 2" and “Enqueue Replicator 2".

When installing an SAP system based on SAP NetWeaver AS for ABAP 7.52 or lower, Software Provisioning
Manager 1.0 installs the ASCS instance with the classic “Standalone Enqueue Server” and the ERS instance
with the classic “Enqueue Replication Server” by default. However, if you installed an SAP system based on
SAP NetWeaver AS for ABAP 7.52 , you can switch to" Standalone Enqueue Server 2" and “Enqueue Replicator
2"

For more information, see https://help.sap.com/nw752abap# ||» Application Help » SAP NetWeaver Library:
Function-Oriented View » SAP NetWeaver Application Server for ABAP Infrastructure » Components of SAP
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NetWeaver Application Server for ABAP » Standalone Enqueue Server 2 ¥ Switching to the Standalone Enqueue
Server2 1.

Related Information

Enqueue Replication Server in a Microsoft Failover Cluster [page 195]
Configuring the First Cluster Node [page 205]

6.16 SAP Solution Manager 7.2, SAP Process Integration 7.5
only: Enabling HTTPS Communication for ABAP

For secure communication between the SAP systems connected to the ABAP stack, further post-installation
steps are required to fully enable HTTPS communication.

Prerequisites

* You have installed the application server ABAP for an SAP Solution Manager 7.2 or SAP Process Integration
7.5.

*  You entered the HTTPS port that is to be configured in the application server instance profile when
processing the Communication Port for ABAP screen. For more information, see Additional Parameters
when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2.

Procedure

Proceed as described in the SAP Note 510007 # .

Related Information

Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 60]
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6.17 Installing Additional Languages and Performing
Language Transport

This section describes how to install and transport additional languages.

i Note

You do not have to perform these steps or at least some of these steps if you are using a Stack XML file (see
Installation Using a Stack XML File [page 36]) and processed the Install Additional Languages screen during
the installation.

Context

If you have problems during the language installation, see SAP Note 2456868 ¥ .

Procedure

1. Configure the language settings by using transaction 118N and choosing |+ 118N Customizing ¥ 118N
System Configuration J or by executing report RSCPINST directly.

For more information, see SAP Note 42305
2. Perform the language transport using transaction SMLT:
i Note

German is already available in the system. Do not transport it via SMLT.

a. Classify the language.
b. Schedule the language transport.
c. Schedule the language supplementation.

Next Steps

i Note

You can also install additional languages later, but if you install any Support Packages in the meantime, you
have to do one of the following:

* Install the Support Packages again.

® Usethe report RSTLAN_IMPORT_OCS to extract the language-relevant information from each Support
Package.
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For information about the language transport, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731F%

® SAP NetWeaver 74
http://help.sap.com/nw74 ¥

® SAP NetWeaver 7.5
http://help.sap.com/nw75#r

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help ¥ Function-Oriented View i Solution
Life Cycle Management > Software Logistics > Change and
Transport System # Language Transport (BC-CTS-LAN) 4

6.18 Configuring the User Management

After the installation has completed, configure the user management of your SAP system.

i Note

For SAP Process Integration 7.5 and SAP Solution Manager configuring the user management with an
external ABAP system is mandatory. For more information, see Preparing an External ABAP System as
Source for User Data in the Java installation guide for your operating system and database .

For SAP Process Integration 7.5 and SAP Solution Manager go to P/ 7.5: Configuring the Process Integration
System After the Installation respectively Configuring an SAP Solution Manager System in the Java
installation guide for your operating system and database.

Context

For Solution Manager and Process Integration 7.5, your UME has been configured with the ABAP part of the
system during the target system installation. For other SAP system products this configuration is optional. For
more information, see Preparing an External ABAP System as Source for User Data in the Java installation guide
for your operating system and database .

Procedure

After the installation of your SAP system has finished, you must decide whether you want to do the following:
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¢ Add the system to Central User Administration (CUA)
* Use Lightweight Directory Access Protocol (LDAP) synchronization

For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

®  SAP NetW 7.3 including Enh t
etieaver 72 including Ennancemen |} Application Help >Function—Oriented View: English >Security

Package 1

https://help.sap.com/nw731 % > Identity Management > Identity Management for System Landscapes
e SAP NetWeaver 74 > Integration of User Management in Your System Landscape

https://help.sap.com/nw74 Fr > Adding an ABAP System to Your System Landscape ]

® SAP NetWeaver 7.5
https://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP
7.51 innovation package
https://help.sap.com/nw75labap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap P

6.19 Ensuring User Security

You need to ensure the security of the users that the software provisioning manager created during the
installation.

The tables below at the end of this section list the following users:

* Operating system users

* SAP system users

During the installation, the software provisioning manager by default assigned the master password [page 48]
to all users created during the installation unless you specified other passwords.

- Recommendation

The Master Password feature can be used as a simple method to obtain customer-specific passwords for
all newly created users. A basic security rule is not to have identical passwords for different users. Following
this rule, we strongly recommend individualizing the values of these passwords after the installation is
complete.

- Recommendation

In all cases, the user ID and password are encoded only when transported across the network. Therefore,
we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL)
protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog
and RFC.
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A Caution

Make sure that you perform this procedure before the newly installed SAP system goes into production.

For the users listed below, take the precautions described in the relevant SAP security guide.

You can find the security guide in the Security section of the product page for your SAP product at https:/
help.sap.com/ ¥

Operating System and Database Users

After the installation, operating system users for SAP system, database, and SAP Host Agent are available as
listed in the following table:

Operating System and Database Users

User Type User Comment
Operating system user <sapsid>adm SAP system administrator
sqd<dbsid> SAP MaxDB database administrator
SAPService<SAPSID> User to run the SAP system
SAP MaxDB database users SAP<SAPSID> SAP MaxDB database owner
CONTROL SAP MaxDB database manager opera-
tor
SUPERDBA SAP MaxDB database system adminis-
trator
SAP Host Agent User
User Type User Comment
Operating system user sapadm SAP Host Agent administrator is the user for central

monitoring services.

You do not need to change the password of this user
after the installation.

This user is for administration purposes only.

You are not able to log on as sapadm as this user is
locked.
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SAP System Users

After the installation, ABAP system users are available. The following table shows these users with the SAP
system clients in which they are available, together with recommendations on how you can ensure the security

of these users.

i Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 .

SAP System Users

User User Name Comment
SAP system user SAP* User exists in at least SAP system clients 000, 001,
and 066.
DDIC User exists in at least SAP system clients 000 and
00L.
EARLYWATCH User exists in at least SAP system client 066.

Application Server Java Admin-
istrator

i Note

This user has only been cre-
ated if you have installed the
application server ABAP for
an SAP Process Integration
(PI) 7.5 system or for an
SAP Solution Manager 7.2
system.

The name that you gave this

user during the installation or the
default name J2EE_ADMIN (see
SAP System Parameters [page
48])

This user exists in at least clients 000 and 001 of the
ABAP system and in the User Management Engine
(UME) of the Java system. It has administrative per-
missions for user management.

The password of this user is stored in secure storage.
Therefore, whenever you change the password of the
administrator password, you must also change the
password in secure storage.

- Recommendation

We recommend that you use strong password
and auditing policies for this user.

Application Server Java Guest

i Note

This user has only been cre-
ated if you have installed the
application server ABAP for
an SAP Process Integration
(PI) 7.5 system or for an
SAP Solution Manager 7.2
system.

The name that you gave this

user during the installation or the
default name J2EE_GUEST (see
SAP System Parameters [page
48])

This user exists in at least clients 000 and 001 of the
ABAP system and in the User Management Engine
(UME) of the Java system. It is used for anonymous
access.
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User User Name Comment

Communication user for Appli-  The name that you gave this user This user exists in at least clients 000 and 001 of the
cation Server Java during the installation or the de-  ABAP system and in the User Management Engine
fault name SAPJSF (see SAP Sys- (UME) of the Java system. It is used for a remote
i Note tem Parameters [page 48]) function call (RFC) between the ABAP system and

This user has only been cre- the Java system.

ated if you have installed the
application server ABAP for
an SAP Process Integration
(PI) 7.5 system or for an
SAP Solution Manager 7.2
system.

6.20 Performing the Client Copy

To get a production client, you have to perform a copy of the SAP reference client.

Context

The software provisioning manager creates three ABAP clients during the installation, client 000, client 001,
and client 066.

i Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For
more information, see SAP Note 1749142 #r .

Use client 000 as source client for the client copy.

i Note

SAP SCM: If you want to mark the client 001 as not relevant for liveCache, run report /SAPAPO/
OM_NON_LC_RELEVANT_CLT or /SLCA_NON_LC_RELEVANT_CLIENT using transaction SE38.

Procedure

1. Maintain the new client with transaction SCC4.

2. Activate kernel user SAP*:
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a. Setthe profile parameter login/no_automatic_user_sapstar to 0.
b. Restart the application server.
Log on to the new client with kernel user SAP* and password PASS.
Copy the client with transaction SCCL and profile SAP_CUST.
Check the log files with transaction SCC3.

Create the required users. These users must have at least the authorizations required for user
administration and system administration. Create a user SAP* with all required authorizations for this
user. If you want to have other users for system administration, you can also create user SAP* without
authorizations.

o o~ W

7. Deactivate kernel user SAP*:

a. Reset login/no_automatic_user_sapstar to 1.
b. Restart the application server.

Next Steps

For more information about the client copy and about how to perform it, see the SAP Library at :

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731 %

® SAP NetWeaver 74
http://help.sap.com/nw74 ¥

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Application
Server » Application Server ABAP » Administration of
Application Server ABAP > Change and Transport System
> BC - Client Copy and Transport ]
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6.21 Installing or Upgrading Database Studio for SAP
MaxDB

This section describes how to install or upgrade Database Studio for SAP MaxDB and SAP liveCache. Database
Studio is the database administration tool for SAP MaxDB. With Database Studio you can administer MaxDB
databases version 7.6 and newer.

Prerequisites

* You can install Database Studio on Linux or Windows in your network, even if your database runs on a
different operating system. You can then remotely administer the database on a different host.
The instructions below refer mainly to the Windows version.

i Note

To run Database Studio on Linux, you need to meet the requirements for the SAP MaxDB database
server.

* Your PC must meet the following minimum requirements:

* Software requirements:
Operating System Requirements for Database Studio 7.9 and higher

Operating System Database Studio 7.9.08 Database Studio 7.9.09 and Higher

Windows Server X64 X64

* Hardware requirements:
* RAM: 512 MB (recommended RAM: 1 GB)
* Processor speed: 1.5 GHz
* Freedisk space: 200 MB
* Monitor: 1024x768 pixels, 256 colors

* You can obtain the required files by downloading them from:
https://launchpad.support.sap.com/#/softwarecenter# | Databases » SAP MaxDB }» Database Patches
» MAXDB GUI COMPONENTS/TOOLS » MAXDB DATABASE STUDIO 79 1

* Database Studio 7.9.09 comes with the SAP Java Runtime SAPJVM.
You no longer need to download the Java runtime.

* Database Studio 7.9.08 is still available for downloading.
To check your Java version, enter the following command:
java -version
To download Java, go to http://java.com/en/download # .
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Context

For more information about Database Studio, see https://help.sap.com/maxdb# | <Version> » Application
Help » SAP MaxDB Library * Tools » Database Studio 3.

i Note

Database Studio replaces Database Manager GUI and SQL Studio, which were available in previous
releases.

For up-to-date information about installing Database Studio, see SAP Note 1097311 # .

For more information about Database Studio, including troubleshooting, see SAP Note 1097311# and
1795588 #r .

Procedure

1. Start the installation or upgrade by simply executing the downloaded SDBSETUP . EXE (Windows clients) or
SDBSETUP (Linux clients) file.
The Installation Manager starts.

2. Follow the Installation Manager steps to install or upgrade Database Studio.

3. If you are prompted to restart your computer after the installation, make sure that you first shut down any
databases that are running.

6.22 Secure Sockets Layer Protocol for Database Server
Communication

The SAP MaxDB database server supports the Secure Sockets Layer (SSL) / Transport Layer Security (TLS)
protocol. You can use this protocol to communicate between the database server and its client, here the
Application Server (AS).

SSL guarantees encrypted data transfer between the SAP MaxDB database server and its client applications.
In addition, the server authenticates itself to the client. You need to install SAP’s cryptographic library -
SAPCRYPTOLIB. For more information on software versions, see SAP Note 2243688 .

A\ Caution

There is a performance cost for SSL since the data has to be encrypted, which requires time and
processing power.

To use SSL you need to install the SAP Cryptographic Library [page 147] and generate the personal security
environment [page 148] (PSE) on the server (SSL Server PSE) and on the client (SSL Client PSE). In addition,
you need to configure the SSL communication between the application server and the database server [page
1517
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Related Information

Installing the SAP Cryptographic Library [page 147]
Generating the Personal Security Environment [page 148]
Configuring the SSL Communication between the Application Server and the Database Server [page 151]

6.22.1 Installing the SAP Cryptographic Library

This section describes how to install the SAP Cryptographic Library.

Prerequisites

Prerequisites
Download the appropriate installation package for your operating system and liveCache version from:

https://launchpad.support.sap.com/#/softwarecenter# | Support Packages & Patches » SAP
TECHNOLOGY COMPONENTS ¥ SAPCRYPTOLIB » COMMONCRYPTOLIB <version> J

Context

The SAP Cryptographic Library supplies the cryptographic functions required to build a database server-
client connection using the Secure Sockets Layer (SSL) protocol. Therefore, you need to install the SAP
Cryptographic Library on the host machine of the SAP MaxDB database server and the SAP Application Server
(AS).

The installation package consists of the following:

* The SAP Cryptographic Library:
¢ SAPliveCache >=7.9.09: CommonCryptoLib (CCL)
* SAPliveCache < 7.9.09: SAPCRYPTOLIB

¢ Configuration tool sapgenpse . exe

The installation package is called SAPCRYPTOLIBP_<patch_level>-<platform_id>.SAR. For example,
CCL 8.4.45 on 64-bit AlX is called SAPCRYPTOL IBP_8445-20011699. SAR.

For more information on the CCL, see SAP Note 1848999 .

You use the configuration tool to generate key pairs and PSEs.
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Procedure

1

Unpack the installation package for the SAP Cryptographic Library using sapcar . exe, which you can find
for example on your installation master media, using the following command:

sapcar -xvf <name of your package>

i Note

The remainder of the procedure (as described below) does not apply to client applications such as SQL
Studio, which do not recognize an independent directory. In this case, you must copy the sapcrypto
installation package to the installation directory of the application

. Copy the sapcrypto library to the l'ib subdirectory of the independent program directory.

You can find the value of the independent program directory by entering the following command:
dbmcli dbm_getpath IndepProgPath

Example

The independent program directory might be called the following:

/sapdb/programs/lib

Copy the configuration tool sapgenpse . exe to the directory <independent program>\lib.

4. Create a subdirectory called sec under the independent data directory.

Example
The result might look as follows:

/sapdb/data/sec

Make sure that the directory and the files that the sec directory contains — including the SSL Server PSE -
belong to the user Icown and the group Icadm, and that the rights are restricted to 0660.

6.22.2 Generating the Personal Security Environment

This section describes how to generate the SSL Server PSE and the SSL Client PSE.

Context

The information required by the database server or client application to communicate using Secure Sockets
Layer is stored in the Personal Security Environment (PSE). The required information differs according to
whether SSL PSE is for the server or client:

148

SSL Server PSE

This PSE contains the security information from the database server, for example, the public-private
cryptographic key pair and certificate chain. To install the SSL Server PSE, you need to generate the

PSE. You can either do this for a single database server or system-wide. The SSL Server PSE is called
SDBSSLS. pse.
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¢ SSL Client PSE
The client requires an anonymous certificate called SDBSSLA . pse, which contains the list of the public
keys of trustworthy database servers.

Procedure

1. You generate the SSL Server PSE [page 149]
2. You generate the SSL Client PSE [page 151]

6.22.2.1 Generating the SSL Server PSE

Proceed as follows to generate the SSL Server PSE.

Context

i Note

You need to know the naming convention for the distinguished name of the database server. The syntax
of the distinguished name, which you enter in the procedure below, depends on the Certification Authority
(CA) that you are using.

Procedure

1. Change to the <global programs>\lib directory.

2. Setup the following environment variable:
SECUDIR=<global data>\sec

3. Enter <global program>/lib inthe environment variable LD_LIBRARY_PATH.

4. Create a SSL Server PSE, SDBSSLS. pse, and generate a certificate request file, certreq, in the directory
defined by SECUDIR (see step 2):

sapgenpse gen_pse -v -r <SECUDIR>\certreq -p SDBSSLS.pse “<your distinguished
name>"’

For each database server that uses a server-specific PSE, you must set up a unique certificate request. If
you are using a valid system-wide SSL Server PSE, you only need to set up a single certificate request for
all servers.

5. Send the certificate request to the CA for signing. You can either send it to the SAP CA or to another CA.
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You must make sure that the CA offers a certificate corresponding to the PKCS#7 certificate chain format.
Thawte CA at the Thawte website offers a suitable certificate, either SSL Chained CA Cert or PKCS#7
certificate chain format.

The CA validates the information contained in the certificate request, according to its own guidelines, and
sends a reply containing the public key certificate.

6. After you have received the reply from the CA, make sure that the contents of the certificate request have
not been destroyed during download.

For example, if you requested the certificate on a UNIX system and stored it on a Windows front end, the
formatting (that is, line indents and line breaks) is affected.

To check the contents, open the certificate request with a text editor (such as Notepad) and repair the line
indents and the line breaks.

«* Example
This is an example of a certificate request:
M11BPzCBgQIBADAAMIGTMAOGCSgGS Ib3DQEBAQUAA4GNADCB1QKBgQD/3021T+/Y
+EQxonzZbaRrk9sTalknlmgx3YAUe/gEaGdflwvuYkbOgjMk81iM/
Jb9BJId8srMPyoBy9jMC7v5u7+TZWmWa6R jnvClvYGgMw I DAQABOAAWDQYJKoZ IhveNAQEFBQ
ADgYEA
Xx2zuaTAOKPAGmxUKY IWdasUpim4vhfaHa7ZDBwipvKJ8akYCT
+dpmVjhcph9E7cUjL80/6Rup5cnLAAOSFhVE5MS62zNJa9YYSNIXP+5/

MPF6Q4ayJOVryTkSpbbPrWLbKh1Dds97LQVuQ/myK I AHECwyW6t7SAFIWN4POFdxmKo=
----- END CERTIFICATE REQUEST-----

=, Sample Code
————— BEGIN CERTIFICATE REQUEST-----
wpignSw7U9FWneyWz3Wi 10S18aFCYkRoOOwWCpD8UwcaC4dds4uGT6h12WIJ0/FOtUg
7. Import the reply to the SSL Server PSE:
a. Copy the text to a temporary file called srcert.
b. Enter the following command:
sapgenpse import_own_cert -c srcert -p SDBSSLS.pse

You have generated the SSL Server PSE. You can now start the XServer as usual (if it is already running,
you must stop and restart it).

8. To check whether the SSL functionality is working correctly, view the trace file niserver_<local
computer name>.trace inthe <global data>\wrk directory.
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6.22.2.2 Generating the SSL Client PSE

Proceed as follows to generate the SSL Client PSE.

Procedure

1. Change tothe <global programs>\lib directory.
2. Set up the following environment variable:
SECUDIR=<global data>\sec

3. Create an anonymous client SSL Client PSE, SDBSSLA . pse in the directory defined by SECUDIR (see
previous step):

sapgenpse gen_pse -v -noreq -p SDBSSLA.pse

You can leave the distinguished name empty.

Before you can establish an SSL connection to a database server, the server certificate must be entered in

the PK list of the anonymous client certificate.
4. To see the database server certificate, enter the following command:

,»X_ping -n <servermode> -c[apture]

You can check whether to trust the database server certificate. The client certificate is not affected by this.
5. Start the import with this command:

»X_ping -n <servermode> -i[import]

6. To administer the PSE, use the configuration tool sapgenpse. For more information, enter the following
command:

sapgenpse -h

i Note

For applications such as SQL Studio replace the global data or global program in the above description
with the relevant installation directory.

6.22.3 Configuring the SSL Communication between the
Application Server and the Database Server

Set the connection information for each database connection for which SSL is to be used.

Procedure

Using transaction dbco, set the connection information for each database connection for which SSL is to be
used as follows:
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* Connection information for database connection <name>
maxdb:remotes://<host>/database/<SI1D>-<SID>

* Connection information for database connection <name>+
@DBM_SSL :<host>-<SID>

For more information, see SAP Note 2190094 #r .

Example

Database connection: Test

<host>: 1ul2345

<SID>: WB9

Connection information for database connection Test:
maxdb:remotes://1ul2345/database/WB9-WB9
Connection information for Test+:

@DBM_SSL : 1u12345-WB9

6.23 Backing Up the SAP MaxDB Database

You need to define backup media and back up the SAP MaxDB database using Database Manager GUI
(DBMGUI).

Prerequisites

* You have finished client maintenance.
* You have installed Database Studio [page 145].
* You can find more information on backing up the database at:
http://help.sap.com/maxdb | SAP MaxDB 7.9 » SAP MaxDB Library ¥ Glossary # Backup 3

Procedure

1. Define the backup template as described in | Glossary » Backup Templates 1 in the above
documentation.

2. Back up the database as described in | Glossary » Data Backup 3 and Log Backup in the above
documentation.
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6.24 Updating the Database Software to the Current Release

After the installation and before you start production operation, we strongly recommend you to update the
database software.

Procedure

Download the latest SAP MaxDB patches from https://launchpad.support.sap.com/#/
softwarecenter/#& | Databases » SAP MaxDB 3.

For more information about upgrading to a SAP MaxDB patch from a SWDC Support Package, see SAP Note
735598 .

6.25 SAP Systems Based on SAP NetWeaver 7.4 and Higher:
Changing Keys for the Secure Storage

The secure storage in the file system and the secure storage in the database have been encrypted with a
randomly generated individual encryption key or with a default key.

In the first case, you have made a backup of the individual key because you need this value in case of failure to
recover the data.

No matter what you chose during installation, you can change the encryption key at any time using the
respective maintenance tool.

- Recommendation

SAP recommends using an individual encryption key.

* Forthe secure storage in the file system, the key change is described in the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 74
http://help.sap.com/nw74

® SAP NetWeaver 7.5
http://help.sap.com/nw75F

® SAP NetWeaver Application Server for

|} Application Help > Function-Oriented View > Security > System
Security > System Security for SAP NetWeaver AS ABAP Only
» Secure Storage in the File System (AS ABAP) 4

ABAP 7.51 innovation package

https://help.sap.com/nw75labap
® SAP NetWeaver AS for ABAP 7.52

https://help.sap.com/nw752abap i
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¢ Forthe secure storage in the database, the key change is described in the SAP Library at:

SAP Release and SAP Library Quick Link

SAP Library Path (Continued)

SAP NetWeaver 7.4
http://help.sap.com/nw74 P

SAP NetWeaver 7.5
http://help.sap.com/nw75 "

SAP NetWeaver Application Server for
ABAP 7.51 innovation package
https://help.sap.com/nw75labap
SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Security > System
Security ¥ System Security for SAP NetWeaver AS ABAP Only
> Secure Storage (ABAP) > Key Management > Using Individual

Encryption Keys > Generating Encryption Keys 3

More Information

See also the entry Individual Encryption Key for the Secure Storage in table SAP System Parameters in SAP
System Parameters [page 48].

6.26 Performing a Full System Backup

You must perform a full system backup, including the operating system disk, system state, and all other disks,
after the configuration of your SAP system. If required, you can also perform a full system backup after the
installation (recommended). In addition, we recommend you to regularly back up your database.

Prerequisites

* You are logged on as user <sapsid>adm.

* You have shut down the SAP system and database.
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Procedure

For more information about backing up your SAP system on Windows, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

* SAP NetWeaver 7.3 including Enhancement Package 1 |} Application Help > Function-Oriented View > Solution Life

http://help.sap.com/nw731#

® SAP NetWeaver 74
http://help.sap.com/nw74 Fi

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
http://help.sap.com/nw751abap

® SAP NetWeaver AS for ABAP 7.52
http://help.sap.com/nw752abap

and Restoring your SAP System on Windows }

Cycle Management > Backup and Recovery > Backing Up

6.27 Logging on to the SAP Web Dispatcher Management
Console

This section describes how to log on to the SAP Web Dispatcher.

Context

i Note

This step is only required if you chose to install an embedded SAP Web Dispatcher instance within the
ASCS instance.

You must log on to the SAP Web Dispatcher Management Console to do the following:

* Check whether the SAP Web Dispatcher was installed successfully,
* Change the password of the webadm user,

¢ Access monitoring and administration tools.

Procedure

1. Open aweb browser.
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2. Enter the following URL, depending on whether you use HTTP or HTTPS:

http(s) ://<Webdispatcher_Host>:<HTTP(S)_PORT>/sap/wdisp/admin/public/
default._html

«* Example
https://plx282:44300/sap/wdisp/admin/public/default_html

3. Logon as user webadm with the password that you entered during the input phase of the installation.

The SAP Web Dispatcher Monitor screen appears.

4. We recommend that you change the password of webadm immediately after the installation for security
reasons.

For more information on how to change passwords of existing users using the Admin Handler, see the
SAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Pack-
agel
http://help.sap.com/nw731

|} Application Help > Function-Oriented View > Application
Server } Application Server Infrastructure > Components of
SAP NetWeaver Application Server » SAP Web Dispatcher

> Administration of the SAP Web Dispatcher > Area menu

> Section "HTTP Handler” }

® SAP NetWeaver 74
http://help.sap.com/nw74
® SAP NetWeaver 7.5
http://help.sap.com/nw75
* SAP NetWeaver Application Server for ABAP 7.51 > Administration of the SAP Web Dispatcher > Using the
innovation package Web Administration Interface > Area menu > Section "HTTP
https://help.sap.com/nw75labap Handler” }
® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap i

|} Application Help > Function-Oriented View > Application
Server ¥ Application Server Infrastructure > Components of

SAP NetWeaver Application Server # SAP Web Dispatcher

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 30]
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6.28 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

i Note

This step is only required if you chose to install an embedded SAP Web Dispatcher instance within the
ASCS instance.

You can find the configuration information in the SAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package |} Application Help > Function-Oriented View > Application
1

http://help.sap.com/nw731#r
® SAP NetWeaver 74

http://help.sap.com/nw74
® SAP NetWeaver 7.5

http://help.sap.com/nw75F

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap
SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

Server > Application Server Infrastructure > Components of

SAP NetWeaver Application Server > SAP Web Dispatcher 1

Related Information

ASCS Instance with Embedded SAP Web Dispatcher [page 30]

6.29 Gateway Configuration

You have to configure the gateway to be able to use it.

i Note

This step is only relevant if you installed a gateway embedded in the ASCS instance. For more information,
see ASCS Instance with Embedded Gateway [page 32].
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You can find all relevant configuration information in the gateway documentation in the SAP Library at:

SAP Release and SAP Library Quicklink SAP Library Path (Continued)

* SAP NetWeaver 7.3 including Enhancement Package [+ Application Help  SAP NetWeaver Library: Function-

1 Oriented View > Application Server > Application Server
http://help.sap.com/nw731# Infrastructure # Connectivity # Gateway 4

® SAP NetWeaver 74 | Application Help ¥ SAP NetWeaver Library: Function-
http://help.sap.com/nw74 Oriented View > Application Server > Application Server

® SAP NetWeaver 7.5 Infrastructure ¥ Components of SAP NetWeaver Application
http://help.sap.com/nw75!‘hr Server > Gateway 1

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap i

Related Information

ASCS Instance with Embedded Gateway [page 32]
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7 Additional Information

The following sections provide additional information about optional preparation, installation, and post-
installation tasks.

There is also a section describing how to delete an SAP system.

71 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol
(LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the
directory.

A\ Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648 to
enable LDAP directory service integration of your SAP system with Active Directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory
products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables
important information in a corporate network to be stored centrally on a server. The advantage of storing
information centrally for the entire network is that you only have to maintain data once, which avoids
redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this
feature. For example, a correctly configured SAP system can read information from the directory and also store
information there.

i Note

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

* The communication protocol between the SAP system and the directory
* How datain the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take
advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows
server, you can configure the SAP system to use the information available there. In the following text,
directories other than the Active Directory that implement the LDAP protocol are called generic LDAP
directories.
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This section does not provide information about the use of LDAP directories with the LDAP Connector. For
more information about using and configuring the LDAP Connector for an ABAP system, see the SAP Library
at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package |" Application Help > Function-Oriented View > Security
1

http://help.sap.com/nw731 P

® SAP NetWeaver 74
http://help.sap.com/nw74# Administration > Directory Services > LDAP Connector }

> Identity Management > User and Role Administration of
Application Server ABAP > Configuration of User and Role

® SAP NetWeaver 7.5
http://help.sap.com/nw75

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap P

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

Prerequisites

You can only configure the SAP system for Active Directory services or other LDAP directories if these are
already available on the network. The Active Directory is automatically available on all domain controllers. A
generic LDAP directory is an additional component that you have to install separately on a UNIX or Windows
server.

Features

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory
by using:

* SAP Logon

* The SAP Microsoft Management Console (SAP MMC)
For more information about the automatic registration of SAP components in LDAP directories and the
benefits of using it in SAP Logon and SAP MMC, see the documentation SAP System Information in
Directory Services at:
https://archive.sap.com/documents/docs/DOC-14384 ¥

* The SAP Management Console (SAP MC)

SAP Logon

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the sapmsg. ini
configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon
to use the LDAP directory, it queries the directory each time Server or Group selection is chosen to fetch
up-to-date information on available SAP systems.
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To use LDAP operation mode, check that the sapmsg - ini file contains the following:
[Address]

Mode=LDAPdirectory

LDAPserver=

LDAPnode=

LDAPoptions=

Distinguish the following cases:

* If you use an Active Directory, you must set LDAPoptions=*“DirType=NT5ADS”. For more information,
see the SAP system profile parameter Idap/options.

* You must specify the directory servers (for example, LDAPserver=pcintel6 p24709) if one of the
following is true:

* Theclientis not located in the same domain forest as the Active Directory

* The operating system does not have a directory service client (Windows NT and Windows 9X without
installed dsclient).
For more information, see the SAP system profile parameter 1dap/servers.

* For other directory services, you can use LDAPnode to specify the distinguished name of the SAP root
node. For more information, see the SAP system profile parameter ldap/saproot.

SAP MMC

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central
location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been
prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various
sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read
system information straight from the directory that automatically registers changes to the system landscape.
As a result, up-to-date information about all SAP application servers, their status, and parameter settings is
always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together
with Active Directory services. You can keep track of significant events in all of the systems from a single

SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such
changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances
both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the
instances running on Unix.

SAP MC

You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from
a central location.
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For more information about the SAP MC and about how to configure it to access LDAP directories, see the
documentation SAP Management Console in the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731 %

® SAP NetWeaver 74
http://help.sap.com/nw74#

® SAP NetWeaver 7.5
http://help.sap.com/nw75 "

® SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|} Application Help > Function-Oriented View > Solution Life
Cycle Management » SAP Management Console 3

Configuration Tasks for LDAP Directories

This section describes the configuration tasks for the Active Directory or other (generic) LDAP directories.

¢ Configuration Tasks for Active Directory
To enable an SAP system to use the features offered by the Active Directory, you have to configure the
Active Directory so that it can store SAP system data.
To prepare the directory, you use the software provisioning manager to automatically:

A Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648#%
to enable LDAP directory service integration of your SAP system with Active Directory.

¢ Extend the Active Directory schema to include the SAP-specific data types

¢ Create the domain accounts required to enable the SAP system to access and modify the Active
Directory. These are the group SAP_LDAP and the user sapldap.

* Create the root container where information related to SAP is stored
* Control access to the container for SAP data by giving members of the SAP_LDAP group permission to
read and write to the directory
You do this by running the software provisioning manager [page 95] and choosing: | Generic Installation
Options » <Database> » Preparations » LDAP Registration j» Active Directory Configuration 3.

i Note

You have to configure the directory server only once. Then all SAP systems that need to register in this
directory server can use this setup.

* Configuration Tasks for Generic LDAP Directories
To configure other LDAP directories, refer to the documentation of your directory vendor. The software
provisioning manager software contains schema extensions for directory servers Netscape/iPlanet
(Idregns4 . txt, Idregns5.txt) and OpenlLDAP slapd (Idregslapd.schema). Both files are located
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in the directory \<Unpack_Directory>\COMMON\ADS. After you have applied the schema extension, you
need to create a root container to store the SAP-related information and create a directory user that the
SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/iPlanet directory server, see the documentation SAP
System Information in Directory Services at:

https://archive.sap.com/documents/docs/DOC-14384 ¥

Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP
system by setting some profile parameters in the default profile.

To do this, run the software provisioning manager [page 95] once for your system and choose:

O\ Caution

SAP recommends that you no longer use the LDAP configuration options provided by the software
provisioning manager, because current security guidelines make it unsafe to run SAP applications on a
domain controller. Instead, SAP recommends that you follow the instructions in SAP Note 3251648
to enable LDAP directory service integration of your SAP system with Active Directory.

| Generic Installation Options » <Database> » Preparations » LDAP Registration » LDAP Support 3

If you use a directory server other than Microsoft Active Directory and/or non-Windows application
servers, you have to store the directory user and password information by using Idappasswd
pf=<any_instance_profile>. Theinformation is encrypted for storage in DIR_GLOBAL and is therefore
valid for all application servers. After restarting all application servers and start services, the system is
registered in your directory server. The registration protocols of the components are dev_lIdap*. The
registration is updated every time a component starts.

7.2 SAP Directories

This section describes the directories that are available in an SAP system.

[ Only valid for 'High Availability': HA (Windows)

If you want to install a high-availability system, see also Directories in a Microsoft Failover Cluster Configuration
[page 199].

l End of 'High Availability': HA (Windows)

The software provisioning manager automatically creates the following directories during the installation:

\usr\sap
This directory is created on the:

¢ Global host and shared with the network share sapmnt

[Only valid for 'High Availability': non-HA
In a non-high-availability-system, you can install the primary application server instance or the (A)SCS
instance on the global host or on any other host.

l End of 'High Availability': non-HA

|

On global hosts, the \usr\sap directory contains general SAP software, global, and local (instance-
specific) data.
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For this, the software provisioning manager creates the global directory usr\sap\<SAPSID>\SYS,
which physically exists only once for each SAP system. It consists of the following subdirectories:

¢ global - contains globally shared data
* profile - contains the profiles for all instances
* exe - contains executable replication directory for all instances and platforms
During the installation of an SAP system distributed over several hosts, you can now specify that

the SAP Global directories are installed on a host different from the ASCS instance host. For more
information, see SAP Note 3349121#% .

* Local host and shared with the name saploc.

[ Only valid for 'High Availability': HA (Windows)
In a high availability system this directory is located on a local disk. You have at least two disk drives
with a usr\sap directory structure.

| End of 'High Availability': HA (Windows)

On local hosts, the \usr\sap\<SAPSID>\<Instance_Name> directory contains copies of the SAP
software and local (instance-specific) data.

i Note

¢ Since SAP traces for the instance are created in \usr\sap, make sure that there is sufficient
space available in this directory. Changes in SAP profiles can also affect the disk space.

* The executables on the local host are replicated from those on the global host every time
the local instance is started. The SAP copy program sapcpe compares the binaries in the
<Platform> directory on the global host and the binaries in the exe directory on the
application server. If the binaries in the exe directory are older than those in the <Platform>
directory, sapcpe replaces them with the newer version of the global host.

Other application servers access the global data using the Universal Naming Convention (UNC) path
\\<SAPGLOBALHOST>\sapmnt. The SAP programs access their instance-specific data with the UNC path
\\<SAPLOCALHOST>\saploc. If the UNC path points to a local directory, the local path (and not the UNC
path) is used to access the directory.

The parameters SAPGLOBALHOST and SAPLOCALHOST have the same values on the global host.

[ Only valid for 'High Availability': HA (Windows)
i Note

In a high-availability system, file shares pointing to directories on shared disks are only visible or can be
accessed with the virtual host name of the cluster group the shared disks belong to.

l End of 'High Availability': HA (Windows)

* \usr\sap\trans
The transport directory contains SAP software for the transport of objects between SAP systems. The
software provisioning manager by default creates it on the SAPGLOBALHOST.
If you want to have it created on another host, or if you want to use an already existing transport host of
your SAP system landscape, you can specify another host during the installation. In this case, you have
to prepare that host to allow the new SAP system to use it as transport host. For more information, see
Preparing the SAP System Transport Host [page 73].
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Directory Structure

The following figures show how the physical directory \usr\sap is shared on the global host in a standard and
in a distributed system. In both cases, the UNC paths are used as follows:

* \\<SAPGLOBALHOST>\sapmnt to access global directories

* \\<SAPLOCALHOST>\saploc to access local instance-specific data
i Note
There are the following instance names available in an SAP system:
ABAP central services instance: ASCS<Instance_Number>

SAP systems based on SAP NetWeaver 7.3 EHP1 to 7.4: Primary application server instance:
DVEBMGS<Instance Number>

SAP systems based on SAP NetWeaver 7.5 and higher: Primary application server instance:
D<Instance_Number>

Additional application server instance: D<Instance_Number>

| Only valid for 'High Availability': HA (Windows) |

High Availability only: Enqueue Replication Server instance: ERS<Instance_Number>
| End of 'High Availability': HA (Windows) |

Directory Structure on the Global Host in a Standard (Central) ABAP System for SAP Systems Based on
SAP NetWeaver 7.5 and higher

On the global host in a standard (central) ABAP system for SAP systems based on SAP NetWeaver 7.5
and higher, all application server instances, including the primary application server instance, are named
D<Instance_Number>.
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<Drive>

\\<SAPGLOBALHOST>\sapmnt
(UNC path)

usr

\\<SAPLOCALHOST>\saploc
(UNC path)

10
\% - /

<SAPSID> trans
sSYS ASCS<No> D<No>
global work work
profile log log
exe data data

| exe
uc

<platform>

uc = Unicode

_______ » Replication by sapcpe

Directory Structure on the Global Host in a Standard (Central) ABAP System for SAP Systems Based on SAP NetWeaver 7.5

and higher

Directory Structure on the Global Host in a Standard (Central) ABAP System for SAP Systems Based on

SAP NetWeaver 7.3 EHP1 to 74

For the global host in a standard (central) ABAP system for SAP systems based on SAP NetWeaver 7.3 EHP1 to
7.4, the primary application server instance is named DVEBMGS<Instance_Number>.
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<Drive>

\\<SAPGLOBALHOST>\sapmnt \\<SAPLOCALHOST>\saploc

(UNC path) (UNC path)
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| exe exe
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Directory Structure on the Global Host in a Standard (Central) ABAP System for SAP Systems Based on SAP NetWeaver 7.3

EHPl1to 74
=
Access to Access to
<Drive> Global Directories <Drive> Global Directories
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Directory Structure for a Distributed ABAP System
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SYS ASCS<No> ERS<No> <Instance_Name> uc: Unicode
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On global host:
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Directory Structure for a High-Availability ABAP System

7.3 Performing a Domain Installation Without Being a
Domain Administrator

It is not required to perform the installation of the SAP system with a user who is a member of the Domain
Admins group. For security reasons most customers do not provide this permission to SAP or database
administrators. If the Domain Admin right has been granted, you can start any SAP installation because the
user will have all necessary rights to install a standard, distributed or high-availability system.

An alternative is to ask the domain administrator to grant the required permissions to the user which installs
SAP or the database. This domain user must be a member of the local Administrators group. In most cases the
domain administrator will define an OU (Organizational Unit) structure, where all SAP systems and their related
domain objects belong to.

To perform the installation with a domain user, the user account must meet the following requirements:

1. Create/Delete/Modify Users and Groups within OUs only. Ask the AD administrator about the company's
OU concept.

2. Create/Delete/Modify Computer Objects within this OU. This is required for users which install SAP
or database applications in Failover Clusters, SAP Landscape Management environments or other high-
availability (HA) environments.
Optional rights might be necessary related to your company'’s security policy, for example:

3. Create/Delete/Modify DNS server records within a specific DNS zone, where the Windows hosts with SAP
software belong to.

4. Create/Delete/Modify Organizational Unit objects within a specific OUs only.

For standard and distributed installations (not HA installations!) the domain administrator can prepare the user
and group objects in the domain for you. In this case, the domain user which will be used for the installation
does not need any of the above permissions.
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The required objects in the domain are:

1. Domain group SAP_<SAPSID>_GlobalAdmin
The group scope should be GLOBAL, the group type should be SECURITY.
2. Two new SAP system users <sapsid>adm and SAPService<SAPSID>.

3. The users <sapsid>adm and SAPServiceSAPSID must be members of the domain group
SAP_<SAPSID>_GlobalAdmin.

i Note

The software provisioning manager creates the operating system user for the SAP Host Agent by default as
alocal user that is not

a member of the local Administrators group. If you want to create this user manually as a domain user,
you must perform the following steps:
Creating the SAP Host Agent User and Group Manually

1. Create the new global group SAP_GlobalAdmin
2. Create the SAP system user sapadm.
3. Add the user sapadm to the newly created group SAP_GlobalAdmin.

However, for security reasons we strongly recommend that you create this user as a local user.

7.4 Checking and Changing the Paging File Settings on
Windows Server

This section describes how to check and change the paging file size on Windows Server with PowerShell.

The PowerShell commands also work in previous Windows versions where PowerShell is available.

i Note

Some paging file operations require a reboot of the server to activate the changes you made. Wmi-
commands do not indicate whether a reboot is required or not. Therefore, we recommend rebooting your
system every time you change the paging file settings with PowerShell.

Prerequisites

Always start the PowerShell in elevated mode (run as administrator).

Procedure
Checking the Size of a Paging File
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1. Start Windows PowerShell.
2. Check whether the default value Automatic manage pagefile size for all devices is activated.

i Note

We do not support automatically managed page file sizes.

To check this, enter the following command:
(Get-WmiObject Win32_Pagefile) —eq $null
If Automatic manage pagefile size for all devices is enabled, the output value is True.
If necessary, disable Automatic manage pagefile size for all devices with the following command:
$sys = Get-WmiObject Win32_Computersystem —EnableAllPrivileges
$sys.AutomaticManagedPagefile = $false
$sys.put()
3. Check the size of the paging files with the following command:
Get-WmiObject WIN32_Pagefile | Select-Object Name, InitialSize, MaximumSize,
FileSize
The output looks like the following:

Name InitialSize
MaximumSize FileSize

C:\pagefile.sys 0 0
41943040000

E:\pagefile.sys 40000 80000
41943040000

In this example, in the first line, the InitialSize and MaximumSize values of a paging file are O, which means
that the paging file size is system managed (not recommended).
In the second line, the paging file size has a minimum and a maximum size (recommended).

Changing the Size of a Single Paging File

Changing the InitialSize and MaximumSize values of a paging file to a size other than O, will automatically
switch off system managed size.

In the following example, we change the size of the paging file on C: to the InitialSize of 40 GB and to the
MaximumSize of 80 GB.

Use the following commands in a PowerShell:

$Pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_.name -eq
“C:\pagefile.sys”}

$Pagefile.InitialSize = 40000
$Pagefile_MaximumSize = 80000
$Pagefile.put()

Typically, you choose the same value for InitialSize and MaximumSize.

i Note

The sum of all paging files InitialSize values must be equal to or higher than the value recommended for
your SAP system.
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Creating a Second Paging File on Another Disk

You might want to create a second or additional paging files to improve system performance, or if your disk
does not have enough space.

To do so, enter the following commands in a PowerShell:
$Pagefile = Get-WmiObject Win32_PagefileSetting
$pagefile.Name = “E:\pagefile.sys”
$pagefile.Caption = “E:\pagefile.sys”
$pagefile._Description = “’pagefile.sys” @ E:\”

$pagefile.SettinglD ="pagefile.sys @ E:”

$pagefile.InitialSize = 80000
$pagefile.MaximumSize = 80000
$pagefile.put()

Deleting a Paging File on a Specific Device

To delete a paging file, enter the following commands in a PowerShell:

$pagefile = Get-WmiObject Win32_PagefileSetting | Where-Object {$_ .name -eq
“E:\pagefile.sys”}

$pagefile.delete()

7.5 Installation of Multiple Components in One Database

You can install multiple SAP systems in a single database. This is called Multiple Components in One Database
(MCOD).

-> Recommendation
MCOD is generally available and there is no intention to de-support this installation feature.
However, SAP recommends that customers should not use the MCOD feature when installing new systems.
The major drawbacks are as follows:
* Previous-point-in-time (PPT) recovery of a single system within an MCOD installation becomes a highly

complex and time-consuming procedure.
* SAP Landscape Management (LaMa) is generally not supported for MCOD installations. For more
information, see SAP Note 1709155 .
* There are strong dependencies, for example on the database version used for the MCOD system.
* Downtime - planned or unplanned - always affects all systems sharing the same database.

Exception: In case of a dual-stack split you can use the “Keep Database” option thus keeping ABAP and
Java stack in one database. There, the PPT recovery problem does not apply because both stacks belong
logically together and would always be recovered jointly anyhow. However, keep in mind that even for this
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specific case the introduction of SAP Landscape Management would require a split into separate database
subsystems.

Additional information is available in SAP Note 2146542 #r.

MCOD is available with all SAP components and all the major databases for the SAP system. No extra effort
is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is
not an additional installation option. Instead, it is an option of the database instance installation.

With MCOD we distinguish two scenarios:

¢ The installation of an SAP system in a new database

* The installation of an additional SAP system in an existing database (MCOD)

Prerequisites

* For more information about MCOD and its availability on different platforms, see Multiple Components in
One Database (MCOD) at: https://wiki.scn.sap.com/wiki/pages/viewpage.action?pageld=448466580 s .

® Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP
instances only.

* Improved sizing required
You calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP
system. You can do the same for memory resources and disk space.
You can size multiple components in one database by sizing each individual component using the Quick
Sizer tool and then adding the requirements together. For more information about the Quick Sizer, see
http://sap.com/sizing .

Features

* Reduced administration effort

¢ Consistent system landscape for backup, system copy, administration, and recovery

* Increased security and reduced database failure for multiple SAP systems due to monitoring and
administration of only one database

* Independent upgrade
In an MCOD landscape, you can upgrade a single component independently from the other components
running in the same database, assuming that the upgraded component runs on the same database
version. However, if you need to restore a backup, be aware that all other components are also affected.

i Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the
installation documentation.
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Constraints

¢ We strongly recommend that you test MCOD in a test or development system. We recommend that you
run MCOD systems in the same context. We do not recommend that you mix test, development, and
production systems in the same MCOD.

* Inthe event of database failure, all SAP systems running on the single database are affected.

* Automated support in an MCOD landscape for the following administrative tasks depends on your
operating system and database:

* Copying a single component from an MCOD landscape to another database at database level.

* Uninstalling a single component from an MCOD landscape requires some additional steps. You can
use a remote connection to SAP support to request help with these tasks. For more information, see
http://support.sap.com/remoteconnection .

* You cannot install a Unicode ABAP system with a non-Unicode ABAP system in one database.

° [ Only valid for 'High Availability': HA (Windows)
You cannot install multiple components in one database with Microsoft Failover Clustering. For more
information, see High Availability with Microsoft Failover Clustering [page 188].

l End of 'High Availability': HA (Windows)

* For the first SAP system, the database system ID can be different from the SAP system ID.
* Forthe second SAP system, you must use the same <DBSI1D> as for the first SAP system.

¢ If you decide to turn off database logging during the database load phase of the installation, you need to
plan downtime for all MCOD systems sharing the database.

7.6 Installing the SAP Host Agent Separately

The SAP Host Agent is installed automatically during the installation of new SAP instances with SAP kernel 7.20
or higher (embedded installation). If you need to install the SAP Host Agent separately, use the documentation
Installation of SAP Host Agent on Windows - Using Software Provisioning Manager 1.0 at:

https:/support.sap.com/sltoolset# [ » System Provisioning » Install a System using Software Provisioning
Manager » Installation Option of Software Provisioning Manager 1.0 SP <Current Version> } Installation
Guides - Standalone Engines and Clients » SAP Host Agent J

7.7  Splitting Off an ABAP Central Services Instance from
an Existing Primary Application Server Instance

With the installation option Split Off ASCS Instance from existing Primary Application Server Instance, you can
move the message server and the enqueue work process from an existing primary application server instance
to a newly installed ABAP central services instance (ASCS instance). The new ASCS instance is installed while
the split is done.
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Prerequisites
The existing SAP system of the primary application server instance must meet the following requirements:

* |t was upgraded from an SAP system release based on SAP NetWeaver lower than 7.1.
* |tdoes not yet have an ASCS instance

Context

[ Only valid for 'High Availability": HA (Windows)
i Note

This installation option is not supported in a high-availability system.

| End of 'High Availability': HA (Windows)

Before the Split

The primary application server instance includes:

* ABAP dispatcher and work processes (dialog, batch, spool, enqueue, or update)
* Gateway

* Internet communication manager (ICM)

* Internet graphics service (IGS)

* ABAP message server

After the Split

An ABAP central services instance (ASCS instance) has been split off from the existing primary application
server instance.

The primary application server instance now includes:

* ABAP dispatcher and work processes (dialog, batch, spool, or update)
* Gateway
* Internet communication manager (ICM)

* Internet graphics service (IGS)

The newly created ABAP central services instance (ASCS instance) includes:

* ABAP message server

* ABAP standalone enqueue server
The ABAP enqueue work process is now replaced with the ABAP standalone enqueue server.

i Note

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone
Enqueue Server 2"”: Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server” by
default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS
instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new
“Standalone Enqueue Server 2" after the installation has completed. For more information, see https://
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help.sap.com/nw752abap# |+ Application Help » SAP NetWeaver Library: Function-Oriented View
» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for

ABAP » Standalone Enqueue Server 2 » High Availability with Standalone Enqueue Server 2 4, and
Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2
and Enqueue Replicator 2 [page 136] .

The Effect of the Split

The following graphic provides an overview of the components contained in the primary application server
instance before and after the split, along with the newly created ASCS instance:

SAP Global Host with SAP Global Host with
PAS PAS and ASCS
PAS PAS

ABAP Dispatcher
+

ABAP Dispatcher
+

Work Processes
Work Processes

Enqueue Work

Process Gateway

ICM

Gateway 1GS

ICM
IGS

ASCS

Message Server

Message Server

Enqueue Server

PAS = Primary Application Server Instance

ASCS = Central Services Instance for ABAP

Splitting Off an ASCS Instance in an ABAP System

Procedure

1. Plan the basic parameters, as described in SAP System Parameters [page 48]:
* Choose an instance number for the ASCS instance to be created.
* Note that the message server port is not changed during the split.

2. Check the hardware and software requirements for the ASCS instance to be created as described in
Hardware and Software Requirements [page 38].

3. Specify basic SAP System Parameters [page 48] for the ASCS instance to be created.
4. Check the prerequisites [page 93] and start the software provisioning manager [page 95] on the host
where the ASCS instance is to be created.

5. On the Welcome screen, choose |* Generic Options ¥ <Database> » Split Off ASCS Instance from Existing
Primary Application Server Instance 3.

6. Follow the instructions on the software provisioning manager screens and enter the required parameters.
i Note

To find more information on each parameter during the Define Parameters phase, position the cursor

on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.
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9.

10.

11.

12.

After you have entered all requested input parameters, the software provisioning manager displays the
Parameter Summary screen. This screen shows both the parameters that you entered and those that the
software provisioning manager set by default. If required, you can revise the parameters before starting the
installation.

To start the installation, choose Start.

O\ Caution

All SAP system instances are stopped during the split procedure.

The software provisioning manager starts the installation and displays the progress of the installation.
When the installation has successfully completed, the software provisioning manager shows the dialog
Execution of Split Off ASCS Instance from existing Primary Application Server Instance has completed.

Restart the application server instances [page 176] (primary application server instance and additional
application server instances if they exist) that were not already restarted by the software provisioning
manager.

Check whether you can log on to the application servers [page 118].
Ensure user security [page 140] for the operating system users of the newly created ASCS instance.

If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide
whether you want to switch to standalone enqueue server 2 and enqueue replication server .

If required, perform an installation backup [page 154].

7.8 Starting and Stopping the SAP System

You use this procedure to start and stop the SAP system or single instances after the installation with the SAP
Microsoft Management Console (SAP MMC) or SAPControl.
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A Caution

Note the following restrictions about starting and stopping the database instance with the SAP MMC or
SAPControl:

|On|y valid for 'High Availability': non-HA

In a non-high-availability system, you can use the SAP MMC or SAPControl to start the database instance.
To stop the database instance, however, you must use the relevant database administration tools.
| End of 'High Availability': non-HA |
| Only valid for 'High Availability': HA (Windows) |

In a high-availability system, you can neither start nor stop the database instance with the SAP MMC or
SAPControl. For more information, see Starting and Stopping the SAP System in an HA Configuration
[page 213].
| End of 'High Availability': HA (Windows)

Prerequisites

The user who wants to start and stop the SAP system with the SAP MMC, must be a member of the local
administrators group.

Procedure

Starting and Stopping the SAP System with the SAP MMC

With the SAP MMC, you can start or stop installed SAP instances — except the database instance — locally on
the host that you are logged on to. If the SAP MMC is configured for central system administration, you can
start or stop the entire system from a single host.

i Note

* To stop the database instance you must use the relevant database administration tools.
* You can also start and stop a UNIX system with the SAP MMC.
* The SAP MMC is not available on Windows Server Core.
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For more information about the SAP MMC, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

SAP NetWeaver 7.3 including Enhancement Package 1
http://help.sap.com/nw731F%

SAP NetWeaver 7.4
http://help.sap.com/nw74 ¥

SAP NetWeaver 7.5
http://help.sap.com/nw75#r

SAP NetWeaver Application Server for ABAP 7.51
innovation package
https://help.sap.com/nw751abap P

SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap

|+ Application Help # Function-Oriented View # Solution Life
Cycle Management > SAP Microsoft Management Console:
Windows 1

To start or stop the SAP system — except the database instance — with the SAP MMC, perform the following
steps:

1
2.

Start the SAP MMC on the SAP system host.

Right-click the SAP system node and choose Start or Stop.
All SAP instances listed under the system node start or stop in the correct order.

To stop the database instance, use the relevant database administration tools.
If the SAP system is installed on multiple hosts, you have the following options to start or stop your system:

* You start or stop the SAP instances — except the database instance — using the SAP MMC on each
host.
* You add the remote instances to the SAP MMC configuration to start or stop all instances from a single
SAP MMC.
To do so, do one of the following:
* You configure the SAP MMC manually. For more information, see Changing the Configuration of the
SAP MMC in the SAP MMC documentation.
* You use the automatic LDAP registration. For more information, see Configuring SAP MMC for
Active Directory Services in the SAP MMC documentation.

Starting and Stopping the SAP System with SAPControl

To start or stop the SAP system — except the database instance — with SAPControl (sapcontrol .exe),
perform the following steps:
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To start or stop the complete SAP system with SAPControl, open a PowerShell in elevated mode, and enter
the following command:

sapcontrol -prot PIPE -nr <Instance_Number> -function StartSystem

sapcontrol -prot PIPE -nr <Instance_Number> -function StopSystem

To start or stop a single instance with SAPControl, open a PowerShell in elevated mode, and enter the
following command:

sapcontrol -prot PIPE -nr <Instance_Number> -function Start

sapcontrol -prot PIPE -nr <Instance Number> -function Stop

To stop the database instance, use the relevant database administration tools.
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7.9 Configuring the Windows Server Firewall after SAP
installation

Use

In Windows Server the firewall is configured to allow only a small set of Windows-specific inbound IP
connections.

Therefore, we recommend that you do not turn on the Windows firewall after you have installed your SAP
system. Instead, we recommend that you secure network access to your SAP system with the physical firewall
or arouter Access Control List (ACL) within your datacenter.

If, for some reason, you want to use the Windows Server firewall, you have to configure the Windows firewall
and define a set of Inbound Rules for the TCP/IP port numbers that are used by your system. Otherwise, your
SAP system might not operate.

For more information about the port numbers used, see the documentation TCP/IP Ports of All SAP Products
at:https://help.sap.com/viewer/ports.

Ports listed with the default value Not active in this document are not configured.

[ Only valid for 'High Availability': HA (Windows)
A Caution

In a high-availability system, you have to configure the firewall on all cluster nodes.

l End of 'High Availability': HA (Windows)

Prerequisites

You turn on the disabled firewall [page 68] as follows:

¢ Open Windows PowerShell in elevated mode, and enter the following command:
Set-NetFirewal IProfile "public”,"domain"”,"private" -enabled true

* Youturnonthe disabled firewall as follows:
Open Windows PowerShell in elevated mode, and enter the following command:
Set-NetFirewal IProfile "public”,"domain","private"” -enabled true

Procedure

This procedure provides an example how to set Inbound Rules for the ports of an ABAP server that was
installed with the following settings:

Instance number 00
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Port type TCP

Ports 3200, 3300, 4800, 8000, 3600, 50013, 1433, 1434

* Open Windows PowerShell in elevated mode, and enter the following command:
New-NetFirewal lRule -DisplayName “SAP ABAP Server 00" -Direction Inbound
-Protocol TCP -LocalPort 3200,3300,4800,8000,3600,50013,1433,1434 -Action Allow

* Youturn on the disabled firewall as follows:
Open Windows PowerShell in elevated mode, and enter the following command:
Set-NetFirewal IProfile "public",domain","private" -enabled true

i Note

If you want to use, for example, a different IP scope for port 50013, which is used by the connection
SAP Start Service — SAP Management Console, you can restrict the IP access to a small number of SAP
administrators. Then delete this port from the SAP ABAP Server OO rule and create a new rule for port
50013 with a more restrictive scope.

710 SAP System Security on Windows

In a standard SAP system installation, the software provisioning manager automatically performs all steps
relevant for security. Although the software provisioning manager makes sure that the system is protected
against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems
with multiple application servers in a Windows domain. This section describes the user accounts and groups

that the software provisioning manager creates during a domain installation and shows how these are related
to the SAP directories.

User Accounts

The software provisioning manager creates the following accounts for SAP system administration:

User account Description

<sapsid>adm This is the SAP system administrator account that enables interactive administration of
the system.

SAPService<SAPSID> This is the user account that is required to start the SAP system. It has the local user

right to log on as a service.

The advantage of the additional SAPService<SAPSID> account is that it does not allow
interactive logon, which prevents abuse of the account. Therefore, you do not need to
set an expiration date for the password and you do not have to set the option user must
change password at next logon.
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User account Description

sapadm This is the user for the SAP Host Agent. By default it is a local user and not a member
of the local Administrators group. You can change this user into a domain user on the
Parameter Summary screen. For security reasons, however, SAP strongly recommends
to create this user as a local user.

The SAP Host Agent contains all of the required elements for centrally monitoring any
host with the Alert Monitor or the SAP NetWeaver Administrator.

Domain and Local Groups

The only function of a domain group is to group users at the domain level so that they can be placed in the
appropriate local groups.

Only local groups are created and maintained on each local host. A local group can only be given permissions
and rights to the system where it is located. The system is part of a particular domain, and the local group can
contain users and domain (global) groups from this domain.

During a domain installation, the software provisioning manager creates the following domain and local groups:

Group Description

SAP_<SAPSID>_GlobalAdmin  This domain (global) group is a domain-level SAP administration group for organizing
SAP system administrators.

SAP_SAP_GlobalAdmin This domain group for the SAP Host Agent is only created if you create the SAP Host
Agent user sapadm as a domain user.

SAP_<SAPSID>_LocalAdmin This local group is created on each host.

SAP_SAP_LocalAdmin If you create the SAP Host Agent user as domain user, the group
SAP_SAP_LocalAdminis also created.

SAP_LocalAdmin This local group is created on all hosts, but is particularly important for the trans-
port host. Members of the group have full control over the transport directory
(\usr\sap\trans) that allows transports to take place between systems.

The SAP_<SAPSID>_GlobalAdmin groups of all the SAP systems that are part of the
transport infrastructure are added to the SAP_LocalAdmin group. Therefore, the users
<sapsid>adm and SAPService<SAPSID> of all systems in the transport infrastruc-
ture are members of the SAP_LocalAdmin group and have the required authorizations
necessary to initiate and execute transports.

SAP Directories

The software provisioning manager protects the SAP directories under \usr\sap\<SAPSID> by only granting
the group SAP_<SAPSID>_LocalAdmin full control over these directories.

The following graphic illustrates the users and groups that are created by the software provisioning manager
for the <sapsid>adm and SAPService<SAPSID> users in a system infrastructure consisting of two SAP
systems.
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User Groups and Accounts

i Note

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP
system, only the following are members of all SAP system object ACLs:

® Local group SAP_<SAPSID>_ LocalAdmin
* Group Administrators
* User SYSTEM

More Information

Automatic Creation of Accounts and Groups [page 182]

711 Automatic Creation of Accounts and Groups

The software provisioning manager automatically creates the accounts and groups required for the secure
operation of the SAP system with Windows during the installation, as described in SAP System Security on
Windows [page 180].

Features

The following figures show the steps that the software provisioning manager performs to create the users and
groups and assign the required rights to SAP directories.
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The first figure shows the users that are created during a domain installation, with the SAP Host Agent
operating system users being local users.

Creation of Accounts

Domain users for SAP system Local user for
<sapsid>adm SAP Host Agent
SAPService<SAPSID> sapadm

Creation and Modification of Domain Group in the Domain

Creation of domain group SAP_<SAPSID>_GlobalAdmin

3

Addition of <sapsid>adm, SAPService<SAPSID>to SAP «SAPSID> GlobalAdmin

Creation and Modification of Local Groups and Users on Each Host

Creation of local groups SEP_<SAPSID> LocalAdmin, SAP_SAP LocalBAdmin

{

Creation of local group SAP_SAP GlobalAdmin

J

Addition of domain group SAP_<SAPSID> GlobalZdmin
to local group SAP_<SAPSID> LocalAdmin

}

Addition of sapadm to SAP_SAP GlobalAdmin and SAP SAP LocalAdmin

Creation of local group SAP_LocalRdmin

}

Addition of domain group SAP_<SAPSID> GlobalZdmin
to local group SAP LocalAdmin

]

Addition of local user sapadm to local group sAP_LocalAdmin

Addition of SAP <SAPSID> GlobalAdmin group
tolocal group sa?_Localadmin on the transport host

Creating Users and Groups

Foradministrators and SAP_Localadmin groups
assignment of full control over:
usr
usr\sap
usr\sap\trans
usr\sap\prfclog

For Administrators and SAP <SAPSID> LocalAdmin groups
assignment of full control over:
usr\sap\<SAPSID>

Assigning Rights to SAP Directories
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712 Uninstalling an SAP System or Single Instances

This section describes how to uninstall a complete SAP system or single SAP instances with the Uninstall
option of the software provisioning manager.

Prerequisites

You have installed your SAP system with standard SAP tools according to the installation documentation.

You are logged on with a user account that has the required authorization to run the software provisioning
manager and the SAP system. For more information, see Required User Authorization for Running
Software Provisioning Manager [page 70].

O\ Caution

Do not use the <sapsid>adm user to delete the SAP system.

Make sure that the SAP system, or single instance, or standalone engine, or optional standalone unit to
be deleted is down and that you are not logged on as one of the SAP system users. Also check that all
SAP-related processes are stopped. If there is a lock on one of the SAP system objects, the uninstall fails.

i Note

You do not have to stop the SAP Host Agent. The SAP Host Agent is stopped automatically during the
uninstall process.

When starting the uninstall, make sure that there are no SAP system user sessions still open.

Context

Note the following when deleting an SAP system or single instances:
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You cannot delete an SAP system remotely.

If you delete network-wide users, groups or service entries in an environment with Network Information
System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service
entries to be deleted are no longer required.

During the uninstall process, all file systems and subdirectories of the selected SAP system or single
instance are deleted. Before you start uninstalling, check that you have saved a copy of all files and
directories that you want to keep to a secure location.

The uninstall process is designed to remove as much as possible of the SAP system to be deleted. If an
item cannot be removed, a message informs you that you have to remove this item manually. You can do
this either at once or after the uninstall process has finished. As soon as you confirm the message, the
uninstall process continues.

If you uninstall an SAP instance and you plan to install another SAP instance with the same System ID,
first reboot the Windows host to clear all user cached information. For more information, see SAP Note
2296310% .

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on Windows: SAP MaxDB
PUBLIC Additional Information


http://help.sap.com/disclaimer?site=https://me.sap.com/notes/2296310

Procedure

1. Start the software provisioning manager as described in Running Software Provisioning Manager [page
95].

2. Onthe Welcome screen, choose:
| Generic Installation Options » <Database> » Uninstall » Uninstall SAP Systems or Single Instances 3

3. Follow the instructions on the software provisioning manager screens to delete a complete SAP system or
single instances.

i Note

To find more information on each parameter during the Define Parameters phase, position the cursor
on the required parameter input field , and choose either or the HELP tab. Then the available help
text is displayed in the HELP tab.

The following table provides information about deleting a complete system or single instances with the
software provisioning manager.

Deletion of Remarks

Standard system You can delete a standard system (where all instances reside on the same host) in one
software provisioning manager run.
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Deletion of

Remarks

Distributed or high-availability
system

If you want to delete a distributed or high-availability system, you have to run the
software provisioning manager to delete the required instances locally on each of the
hosts belonging to the SAP system in the following sequence:

A Caution

Only select checkbox Uninstall all instances of the SAP system from

this host when removing the last remaining instance of the SAP sys-

tem. Otherwise the contents of mounted global directories under \
\<sapglobalhost>\<sapmnt>\<SAPSID>/ such as instance profiles and
kernel executables, are also deleted.

1. Additional application server instances, if there are any

2. Primary application server instance
If the software provisioning manager stops responding while trying to delete the
primary application server instance, close the software provisioning manager
with Cancel and Exit. Log off and log on again. To complete the uninstall process
of the primary application server instance, restart the software provisioning man-
ager.

3. Database instance
Since the software provisioning manager only stops local instances automati-
cally, make sure that before deleting the database instance of a distributed
system, you stop all remaining instances. You must stop the instance with the
message server only after having entered all software provisioning manager pa-
rameters for the deletion of the database instance.
Choose whether you want to drop the entire database or only one or more
database schemas. If you drop the entire database, the software provisioning
manager also asks whether you want to remove the database software.

4. ABAP Central services instance (ASCS)

Additional application server

If you want to delete additional application server instances of an existing SAP system,
you have to run the software provisioning manager to delete them locally on each
additional application server instance host.

Standalone SAP Host Agent

The SAP Host Agent is automatically uninstalled from a host together with the last
remaining SAP system instance.

If you want to uninstall a standalone SAP Host Agent, deselect Profiles Available and
select Uninstall Standalone SAP Host Agent on the General SAP System Parameters
screen.

When you have finished, delete the relevant directory structure on the global host.

Delete the local user group SAP_<SAPSID>_LocalAdmin manually as follows:

* Open a PowerShell in elevated mode and enter the following command:
net localgroup SAP_<SAPSID>_LocalAdmin /delete

PUBLIC

If required, you can delete the directory \usr\sap\trans and its contents manually.

The software provisioning manager does not delete \usr\sap\trans because it might be shared.
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7. Toremove obsolete SLD data, see the following document: https://wiki.scn.sap.com/wiki/display/SL/
More+on+System+Landscape+Directory | How-to Manage House-Cleaning in the System Landscape
Directory - Duplicate System Entries 3
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8 High Availability with Microsoft Failover
Clustering

You can install a high-availability SAP system with Microsoft Failover Clustering. The Failover Clustering
software improves the availability of the system and protects it against failure and unplanned downtime,
enabling 24-hour operation, 365 days a year.

With high availability, you enable critical system components, known as “Single Points of Failure (SPOFs)",
to be automatically switched from one machine to the other, if hardware or software problems arise on one
machine. With the help of this switchover — or failover — the system can continue functioning.

Apart from enabling failover when hardware problems occur, you can also use Failover Clustering to avoid
downtime when you perform essential system maintenance. If you need to maintain one host (failover
cluster node), you can deliberately switch the cluster resources to the other host (failover cluster node) and
temporarily operate it there while maintenance is in progress. When maintenance work is finished, you can
easily move the resources back to their original node and continue operating them there.

When you are setting up the SAP system with Microsoft Failover Clustering, you combine standard installation
steps, described earlier in this documentation, with cluster-specific steps, described here.

You have the following options to install a high-availability SAP system with Microsoft Failover Clustering:

* You install the SAP related parts (for example: ASCS instance, additional standalone Gateways, Web
Dispatcher instance, etc.) in one Microsoft Failover Cluster.

* You install the SAP related parts (for example: ASCS instance, additional standalone Gateways, Web
Dispatcher instance, etc.) in two Microsoft Failover Clusters.

You have the following options to install the database instance with a high-availability SAP system:

* You install the database instance on a different host or cluster on either the same or a different operating
system.

* You use third-party high-availability solutions to improve the availability of your database instance.

Important Information

To install a new SAP system with Microsoft Failover Clustering, you have to perform a number of extra steps
specially required for the cluster and configure the SAP system so that it can take advantage of the cluster
functionality:

* Since the correct configuration of network addresses is absolutely essential for the cluster to function
properly, you have to perform a number of additional steps that are necessary to set up and check address
resolution.

¢ Since the cluster hardware has at least two nodes that have access to all local and shared storage devices,
you have to install some components on all nodes and pay attention to special rules for distributing
components to local or shared disks.

* You have to install and configure the ASCS instance to run on two cluster nodes in one Microsoft Failover
Cluster.
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i Note

If you have an existing SAP system and plan to migrate to a failover cluster with new hardware, you install
the SAP system using a system copy.

For more information about the system copy, see the System Copy Guide for your SAP system at:

http://support.sap.com/sltoolset# | System Provisioning ¥ System Copy Option 3§

The system copy guide does not include the cluster-specific information, which is described here.

Terminology

* Inthis documentation the hosts in a Microsoft Failover Cluster are referred to as first cluster node and
additional cluster node(s):

* Thefirst cluster node is the cluster node where you perform the general installation of an SAP system,
for example where the database or ASCS instance is to be installed.

* The additional cluster node is the node where you configure the already installed SAP instances to run
in Microsoft Failover Clustering.

8.1 Checklist for a High-Availability System

This section includes the steps that you have to perform for your SAP system using Microsoft Failover
Clustering. Detailed information about the steps is available in the relevant section.

Planning

1. You check that you have completed the same planning activities [page 35] as for a non-HA system,
including the hardware and software requirements [page 38].

You decide how to set up your SAP system components in an HA configuration [page 191].

You decide how to distribute SAP system components to disks for HA [page 196].

You read Directories in an HA Configuration [page 199].

You read IP Addresses in an HA Configuration [page 200].

You obtain IP addresses for HA [page 202].

SR e

Preparation

1. You check that you have completed the same preparations [page 67] as for a non-HA system.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.3
EHP1to 7.52 on Windows: SAP MaxDB
High Availability with Microsoft Failover Clustering PUBLIC 189


http://help.sap.com/disclaimer?site=http%3A%2F%2Fsupport.sap.com%2Fsltoolset

2. To make sure that all preparation steps have been correctly performed, check that you can move the disk
resources from one cluster node to another so that they are only accessible from a single node at any time.

Installation

1. You make sure that:

1. You are logged on as a domain administrator user or a domain user, who has the necessary rights on
all cluster nodes. For a list of the required permissions, see Performing a Domain Installation without
being a Domain Administrator [page 168].

i Note

In Failover Cluster configurations, make sure that the account of the cluster (<clustername>$) has
full rights in the OU (Organizational Unit) on which your Domain administrator configures the SAP
users and the SAP group.

If these rights are missing, the software provisioning manager will try to add the cluster network
name resource to the SAP cluster group. However, because the cluster itself has no rights to add
the related computer object (CNO) to the OU, the software provisioning manager will stop and
show the error message <access denied>.

2. You do not use the user <sapsid>adm unless specified.

3. Ifyou are prompted during the installation process, log off and log on again.
You configure the first cluster node [page 205].

You install the SAP MaxDB database on the first cluster node [page 206].

You configure the SAP MaxDB database on the additional cluster node [page 2071].

You install the database instance on the first cluster node [page 207] of the host where the database
instance is to run.

R w

<

You configure the additional cluster node [page 208].

~

You install the primary application server instance [page 209].
8. You install at least one additional application server instance [page 210].

Post-Installation

1. Youinstall the permanent SAP licenses on all cluster nodes.
2. You perform the post-installation checks for the enqueue replication server.
3. You perform the same post-installation steps [page 116] as for a non-HA system.

Additional Information

* Moving Cluster Groups, or Services and Applications, or Roles [page 212]
* Starting and Stopping the SAP System in a HA Configuration [page 213].
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8.2 Planning

The following sections provide information about how to plan the installation of the SAP system for Microsoft
Failover Clustering. For a complete list of all steps, see section Planning in the Installation Checklist for a
High-Availability System [page 189].

8.2.1 System Configuration with Microsoft Failover
Clustering

The following chapters provide information about the configuration of your SAP system with Microsoft Failover
Clustering. It describes the components you have to install for an SAP system running in a Microsoft Failover
Cluster, and how to distribute them on the specific host. For more information, see:

* SAP System Components in a Microsoft Failover Cluster [page 191]

* Enqueue Replication Server in a Microsoft Failover Cluster [page 195]

8.2.11 SAP System Components in a Microsoft Failover
Cluster

In a Microsoft Failover Cluster configuration, you have the following mandatory components for your SAP
system:

SAP System Components in an Failover Cluster Configuration

Number of Components per SAP Sys-
Component tem Single Point of Failure

ASCS instance (message servicesand 1 yes
engueue services)

Database instance 1 yes

Application server instance (primary 1-<n> no
application server, additional applica-
tion server)

* To protect the SPOFs (ASCS instance and database instance), you have to use Microsoft Failover
Clustering.
If a hardware or software problem occurs on the first cluster node, the clustered ASCS instance and the
clustered database automatically fail over to another node.
If you need to maintain the cluster node where the ASCS instance and database are running, you can
switch these instances to another node. When maintenance work is finished, you move the ASCS and
database instance back to the original node.

* To protect system components that are non-SPOFs, for example application servers, you have to install
them as multiple components. In this case, you must install at least two application servers (the primary
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application server instance and one additional application server instance) on two different hosts. You have
the following options:

* Youinstall the primary application server and the additional application server instance on the cluster
nodes of a Microsoft Failover Cluster. You install them on a local disk. Any additional application server
instances are installed on hosts outside of the Microsoft failover cluster.

If you have to maintain a cluster node, you have to stop the primary application server or the
additional application server instance on that node. When you have finished maintenance, you restart
the instances.

i Note

If you install the primary application server and the additional application server instance on the
cluster nodes, you must perform the hardware sizing for the failover cluster host, as in this case
the application server is always running on this host. This increases system load and might impact
performance.

Note that, as usual in a failover cluster setup, the ASCS and database instances also switches to
run on the failover cluster host in the event of failover, which temporarily also increases system
load.

* Youinstall the primary application server and all additional application server instances on hosts,
which are not part of a Microsoft Failover Cluster.

SAP System Components in One Microsoft Failover Cluster

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in one
Microsoft Failover Cluster with two nodes.

The first figure shows an Microsoft Failover Cluster configuration where the non-SPOFs components (primary
application server instance, additional application server instance) are installed locally on the cluster nodes.
Any additional application server instances are installed outside the Microsoft Failover Cluster on separate
hosts.
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First Cluster Node Additional Cluster

Node
PAS AAS

Application
Server Instance

SAP Group Host
_________ > ASCS

AAS

————————— b — o O O . O . .
Failover ABAP :_ Active after failover :
Schema Schema = T B

PAS = Primary Application Server Instance ERS = Enqueue Replication Server Instance
AAS = Additional Application Server Instance ASCS = ABAP Central Services Instance

DB = Database Instance

ERS Cluster ERS Additional

ABAP System

The following figure shows an HA configuration, where the non-SPOFs components (primary application server
instance, additional application server instance) are installed on separate hosts that are not part of the failover

cluster.
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SAP System Components in Two Microsoft Failover Clusters

Besides installing your SAP system in one Microsoft Failover Cluster, you can also set up two failover clusters
and distribute the SPOF system components on these clusters to protect them against system failure.

The following figure shows an example where the database instance for the SAP system is installed in one
Microsoft Failover Cluster, and the ASCS instance is installed on the second failover cluster. The application
servers (primary application server instance, additional application server instance) can either be installed on a
local disk on the cluster nodes or on separate hosts that are not part of the Microsoft Failover Cluster.
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8.21.2 Enqueue Replication Server in a Microsoft Failover
Cluster

The enqueue replication server contains a replica of the lock table (replication table) and is an essential
component in a high-availability setup. It is installed on the two cluster nodes where the ASCS instance is
installed and configured to run, even if you have more than two cluster nodes.

In normal operation the enqueue replication server is always active on the host where the ASCS instance is not
running.

If an enqueue server in a Microsoft Failover Cluster with two nodes fails on the first cluster node, the enqueue
server on the additional cluster node is started. It retrieves the data from the replication table on that node and
writes it in its lock table. The enqueue replication server on the first cluster node then becomes inactive. If the
first cluster node is available again, the enqueue replication server on the second cluster node becomes active
again.

The following figure shows the enqueue replication server mechanism in an Microsoft failover cluster
configuration with two nodes:

i Note

“enqueue server” versus “enqueue server 2”, “enqueue replication server” versus “enqueue
replication server 2”: Software Provisioning Manager 1.0 installs the “enqueue server” and “enqueue
replication server” by default for all SAP system releases in the ASCS instance. However, if you have
installed an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to" enqueue server
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2" and “ enqueue replication server 2" after the installation has completed. For more information, see
https://help.sap.com/nw752abap# | Application Help » SAP NetWeaver Library: Function-Oriented View
» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for

ABAP » Standalone Enqueue Server 2 » High Availability with Standalone Enqueue Server 2 3, and Systems
Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2 and Enqueue
Replicator 2 [page 136] .

ABAP System

Failover
First Cluster Node Cluster Additional Cluster

Node

Enqueue Replication
Server Instance

Engueue Replication
Server Instance

SAP Group
ABAP Central Services ABAP Central Services
e m e — = >
Instance Instance
Failover

Enqueue Replication Server Mechanism on One Microsoft Failover Cluster with Two Nodes

8.2.2 Distribution of SAP System Components to Disks for
Failover Clustering

When planning the Microsoft Failover Cluster installation, keep in mind that the cluster hardware has two
different sets of disks:

* Local disks that are connected directly to the cluster nodes

* Shared disks that can be accessed by all cluster nodes via a shared interconnect

i Note

Shared disk is a synonym for the cluster resource of Resource type Physical disk.

You need to install the SAP system components in both the following ways:

¢ Separately on all cluster nodes to use the local storage on each node

* Onthe shared storage used in common by all cluster nodes
You install the following on different shared disks:

¢ Database instance files, if the database instance is installed in the failover cluster
* ASCS instance

¢ Single quorum device, if used
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A Caution

You must not install any SAP or database components on the quorum disk.

The following figure shows a cluster configuration for an SAP system, where the (A)SCS and database instance
are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system
executables, and the quorum resource (if used) to different disks. Only with this distribution of files to distinct
disks is it possible to move the SAP system and database as separate entities in a failover situation.

First Node Shared Storage Additional Node

? ?

Quorum
(if used)

Database directories:
DB data and logs
Global data directory
Private data directory A4
of MaxDB server

software

Y VVY

» Windows » Windows

» Failover cluster software - # Failover cluster software

» MaxDB software: > (AISCS instance files » MaxDB software:

; > SAP executables ;

global program directory, > SAP global directories global program directory,
instance-dependent directory, instance-dependent directory,
and private data directory of and private data directory of
MaxDB client software MaxDB client software

> Files of primary application # Files of primary application
server server

» (Enqueue replication server) # (Enqueue replication server)

Distribution of SAP System Components for an SAP System in a Failover Cluster

i Note
The following software on the local disks must have the same drive letter and path on both nodes:

* Global program software
® Instance-dependent software

Quorum Configurations on Windows

On Windows, there are several quorum configurations available. The configuration to use mainly depends
on the cluster setup, such as the number of cluster nodes, the storage type (single or distributed), and the
number of data centers. For more information, see the Windows documentation.
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The default quorum configuration is called Node and Disk Majority for clusters with more than two nodes.

With a quorum configuration, each node and the witness maintain its own copy of the cluster configuration
data. This ensures that the cluster configuration is kept running even if the active node fails or is offline.

A Caution

If you do not use the default quorum configuration for your operating system, contact your hardware
partner, who can help you to analyze your needs and set up your cluster model. SAP supports these
configurations if they are part of a cluster solution offered by your Original Equipment Manufacturer (OEM),
or Independent Hardware Vendor (IHV).

Geographically Dispersed Cluster (Geospan)

The standard cluster configuration consists of two cluster nodes and a shared storage with all technical
components located in the same data center. In a geographically dispersed cluster, also known as a geospan
cluster, the cluster nodes are distributed across at least two data centers to avoid the full outage of a data
center in the event of disaster.

A geospan configuration requires a more sophisticated storage architecture since a standard shared storage
can only be located in one data center and might therefore be a single point of failure (SPOF). To prevent the
disk storage becoming a SPOF, you have to configure the storage system in each data center and to replicate
its content to the storage system of the other data center.

Replication can either be synchronous or asynchronous, depending on the:

* Functionality of the storage subsystem
* Acceptable amount of data loss during a failover

* Physical layout of the storage area network
This includes the distance between the storage systems, signal latency, capacity, and speed of the network
connection.

* Customer budget
* Functionality supported by the database vendor

The database components in geospan configurations are often no longer part of the cluster and the database is
replicated by pure database techniques, such as shadow database, log shipping, and mirrored database.

Distribution of Database Files in a RAID Configuration

A Caution

Microsoft does not support a host-based RAID configuration (Dynamic Disks) on shared disks.

The following figure shows a secure method to distribute the database directories to different RAID volumes.
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Database Mirroring Hardware Mirroring

RAID 5 RAID 5
RAID 0 Logs Logs RAID 1
RAID 0 Mirrored Logs

Database RAID Volumes

8.2.3 Directories in a Microsoft Failover Cluster
Configuration

The following tables show the directories where the main software components for a high-availability system
are stored:

Directories on Local Disks on Cluster Nodes

Component Default Directory

A supported operating system [page 40] %windir®

Microsoft Failover Clustering software %windir%\Cluster

Application server <Local_Drive>:\usr\sap\<SAPSID>\<Instance>

Enqueue replication server <Local_Drive>:\usr\sap\<SAPSID>\ERS<Instance_
Number>

Diagnostics Agent (optional) <Local_Drive>:\usr\sap\<DASID>\SMDA<Instance_
Number>

SAP Host Agent %Program Files%\SAP\hostctrl

SAP MaxDB global programs <Drive>:\sapdb\program

SAP MaxDB instance-dependent software <Drive>:\sapdb\<DBSID>\db

Directories on Shared Disks

Component Default Directory

Cluster quorum resource (if used) <Drive>:\Cluster
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Component Default Directory

SAP global and instance directories <Drive>:\usr\sap ...

During the installation of an SAP system distributed
over several hosts, you can now specify that the SAP
Global directories are installed on a host different from
the ASCS instance host. For more information, see SAP

Note 3349121/ .

SAP MaxDB data volumes <Drive>:\sapdb\<DBSID>\sapdata\. ..
SAP MaxDB database log volumes <Drive>:\sapdb\<DBSID>\saplog\. ..
SAP MaxDB mirrored database log volumes <Drive>:\sapdb\<DBSID>\saplog\. ..
SAP MaxDB global data <Drive>:\sapdb\data

SAP MaxDB private data <Drive>:\sapdb\<DBSID>\data

8.2.4 Hostnames in a Failover Cluster Configuration

A part of the installation process that is unique to Microsoft Failover Clustering is the configuration of host
names and IP addresses in the network. This is a particularly important task because the addressing plays
a key role in the switchover procedure. Addressing must be set up correctly so that the system can take
advantage of the cluster functionality and switch between nodes when hardware problems arise.

This section explains the different types of IP addresses and their function in the switchover mechanism of one
Microsoft Failover Cluster with two cluster nodes.

Types of IP Addresses

In a proper configured cluster with at least two nodes, there are at least seven IP addresses and corresponding
host names for your SAP system. You have two IP addresses for each cluster node, one IP address for the
cluster, one address for the SAP cluster group and one for the database cluster group.

Some of the addresses are assigned to the network adapters (network interface card, NIC) whereas others are
virtual IP addresses that are assigned to the cluster groups.

Physical IP Addresses Assighed to Network Adapters

A Microsoft Failover Cluster configuration has at least two networks:

* A public network that is used for the communication between the primary application server, additional
application servers, and the LAN.
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* A private network that is used internally for communication between the nodes of the cluster, also called
heartbeat.

The following figure shows a Microsoft Failover Cluster with two nodes and illustrates the adapters required
for the public and private networks, and their corresponding physical IP addresses. A physical IP address, in
contrast to a virtual one, is stationary and permanently mapped to the same adapter.

First Cluster Node Failover Additional Cluster
Cluster Node

IP1 1P 2

Adapter 1 s—— 4————p Adapter 2

Adapter 3 Adapter 4

.

Adapters and IP Addresses Required for Public and Private Networks in an Microsoft Failover Cluster with Two Nodes

Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example,
on the left-hand node in the figure above, you might assign the IP addresses of the public and private network
adapters as follows:

IP Addresses and Host Names

Network Adapter IP Address Host Name
Adapter 1 (private network) 10.1.1.1 clusA priv
Adapter 3 (heartbeat network) 192.168.1.1 clusA

A Caution

* The IP address and host name of the public network adapter is also the IP address and name of the
machine. In our example, this means that the machine that is the cluster node on the left in the figure
has the name clusA.

* Do not confuse the host name with the computer name. Each node also has a computer name, which
is usually the same as the host name.
The computer name is displayed in the node column of the Failover Cluster Management. However,
it is not required for the TCP/IP communication in the cluster. When you configure IP addresses and
corresponding names, keep in mind that it is the host names that are important for the cluster, not the
computer names.
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Virtual IP Addresses Assigned to Cluster Groups

After you have installed the SAP system and fully configured the cluster, the critical system resources are
bound together in three different groups.

Each of these groups requires a virtual IP address and network name that is permanently mapped to the group
and not to a particular node. The advantage of this is that, whenever a group is moved between nodes, its IP
address and network name move together with the group.

An HA configuration has the following groups:

* SAP cluster group for each clustered SAP system
¢ Database cluster group for each clustered SAP system
* Cluster group

The following figure illustrates how the virtual IP addresses of the database group and SAP group can move
from one node to the other during a failover.

Failover Cluster

First Cluster Additional
Node Cluster Node

Virtual IP1
Cluster Group

—_—
Virtual IP 2
ASCS Cluster Group
Virtual IP 3
Cm—

Database Cluster Group

—

Failover of Virtual IP Addresses

8.2.5 Obtaining IP Addresses for a Microsoft Failover Cluster
Configuration

This chapter describes how to obtain the IP addresses for the network adapters (cards) that are required to
install and run your high-availability system.

Context

For a clustered system, you have to configure IP addresses correctly. During the installation procedure you
have to assign at least seven IP addresses and host names. You normally obtain these names and addresses
from the system administrator.
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Procedure

Ask the system administrator to give you the addresses and host names listed in the tables below, which
show an example for a configuration with one Microsoft failover cluster with two nodes. You need to enter the
addresses and host names later during the installation process.

The column Defined During indicates at which stage of the installation of the operating system and the SAP
system the addresses are defined in the system.

A Caution

Use the names exactly as specified by the system administrator.

i Note

In the following tables we are still using the terminology cluster group, and not the Windows Server

terminology Roles.

Physical IP Addresses

Example for Physical

Example for Physical

Component IP Address Host Name Purpose Defined During
First cluster node: 10111 clusA_priv Address for internode  Windows installation
communication on the
adapter for heartbeat vnicatt
heartbeat network
network
First cluster node: 129.20.5.1 clusA Address of the first Windows installation
) cluster node for com-
adapter for public net- o ) _
munication with appli-
work
cation servers and LAN
(this is the same as
the address of the first
cluster node)
Additional cluster 10.11.2 clusB_priv Address for internode  Windows installation
node: communication on the
heartbeat network
adapter for heartbeat eartbeat networ
network
Additional cluster 129.20.5.2 clusB Address of the addi- Windows installation

node:

adapter for public net-

work

tional cluster node for
communication with
application servers and
LAN (this is the same
as the address of

the additional cluster
node)
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Virtual IP Addresses

Example for Virtual IP

Example for Host

Component Address Name Purpose Defined During
Cluster group 129.20.5.3 clusgrp Virtual address and Failover cluster soft-
name of the cluster ware configuration
group. It identifies the
cluster and is used
for administration pur-
poses.
Database cluster 129.20.5.4 dbgrp Virtual address and Execution of HA-wizard
group name for accessing the or database-specific
group of database re-  cluster scripts
sources, regardless of
the node it is running
on
SAP cluster group 129.20.5.5 sapgrp Virtual address and Configuration of SAP

name for accessing the
group of SAP resour-
ces, regardless of the
node it is running on

system for high availa-
bility with the software
provisioning manager
on the first node

8.3 Preparation

This section provides information about how to prepare the installation of the SAP system for Microsoft
Failover Clustering. For a complete list of all steps, see section Preparation in the Installation Checklist for a
High-Availability System [page 189].

1. You check that you have completed the same preparations [page 67] as for a non-HA system.

2. To make sure that all preparation steps have been correctly performed, check that you can move the disk
resources from one cluster node to another so that they are accessible from a single node at any time.

84

Installation

The following sections provide information about how to install the SAP system in a high-availability
environment. For a complete list of all steps, see section Installation in the Installation Checklist for a High-
Availability System [page 189].

Due to a SAP MaxDB technical restriction, the use of passwords longer than nine characters is not possible in
an MSCS environment. For more information, see SAP Note 2319006 .
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8.4.1 Configuring the First Cluster Node

When you run the First Cluster Node option, the software provisioning manager:

* Creates the saploc share, pointing to a local disk
¢ Creates the sapmnt share, pointing to a local disk
¢ Installs the ABAP central services instance (ASCS) and prepares this host as the SAP global host

i Note

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone
Enqueue Server 2"”: Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server” by
default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS
instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new
“Standalone Enqueue Server 2" after the installation has completed. For more information, see https://

help.sap.com/nw752abap# |+ Application Help » SAP NetWeaver Library: Function-Oriented View
» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for

ABAP » Standalone Enqueue Server 2 » High Availability with Standalone Enqueue Server 2 4, and
Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2
and Enqueue Replicator 2 [page 136] .

* Creates the SAP cluster group and adds the ASCS instance to the SAP cluster group
* Installs the enqueue replication server instance (ERS instance) for the ASCS instance

i Note

ERS instance with “Enqueue Replication Server” versus ERS instance with new “Enqueue
Replicator 2”: Software Provisioning Manager 1.0 installs the ERS instance with the classic “Enqueue
Replication Server” by default for all SAP system releases. However, if you have installed the

ERS instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch

to “ Enqueue Replicator 2" after the installation has completed. For more information, see https:/
help.sap.com/nw752abap# |+ Application Help ¥ SAP NetWeaver Library: Function-Oriented View

» SAP NetWeaver Application Server for ABAP » Components of SAP NetWeaver Application Server for
ABAP » Standalone Enqueue Server 2 3, and Systems Based on SAP NetWeaver AS for ABAP 7.52
only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2 [page 136].

¢ Installs the SAP Host Agent

A Caution

When you reboot during the conversion to Failover Clustering, resources fail over to the other cluster node.
Therefore, after each reboot you have to return the system to the state it was in before the reboot.

Prerequisites

* You must install the ASCS instance on a shared disk, and the ERS instance and SAP Host Agent on a local
disk.
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i Note

If you are installing the ABAP stack for a SAP NetWeaver 7.5 Process Integration (PI) system, make sure
that you install the ASCS instance on a separate shared cluster disk from the SCS instance.

Procedure

1. Run the software provisioning manager [page 95] and on the Welcome screen, choose | <Product>

» <Database> » SAP Systems » <System> » High-Availability System ¥ First Cluster Node 3.

i Note

If the software provisioning manager prompts you to log off from your system, log off and log on again.
2. Enter the required parameter values.

i Note

* For more information about the input parameters, position the cursor on a parameter and press
in the software provisioning manager.

* |If you have a Microsoft cluster configuration with more than two nodes in one cluster, apply SAP
Note 1634991

* Onthe screen SAP System MSCS Cluster do not select this checkbox:
Support of multiple SAP systems in one MSCS cluster?

More Information

Moving Cluster Groups, or Services and Applications, or Roles [page 212]

8.4.2 Installing the Database on the First Node

Perform the following steps to install the database on the first node:

1. Make sure that all shared disks of the cluster are available on this node.
2. Run the software provisioning manager [page 95] and in the Welcome screen, choose | <Product>
» <Database> » SAP Systems j» <System> ¥ High-Availability System » MaxDB Database 3.
3. Ifyou are installing the SAP MaxDB database with the software provisioning manager for the first time and
it prompts you to log off, do the following:
1. Choose OK and log on again.
2. Perform step 1 above.
3. Select Run a new installation and choose OK..
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4. Follow the instructions in the software provisioning manager dialogs and enter the required parameter
values.

i Note

* Make a note of the disk drives that you choose during the installation, since you need to enter
these during the installation on additional nodes

* For more information about the input parameters, position the cursor on a parameter and press
in the software provisioning manager.

A\ Caution

Make sure that you distribute the SAP MaxDB software and logs correctly to local and shared disks as
described in Directories in a Microsoft Failover Cluster Configuration [page 199].

8.4.3 Configuring the Database on the Additional Node

Perform the steps below to configure the database on the additional cluster node.

A Caution

Do not attempt to move the shared disks from node A to node B. The software provisioning manager does
this automatically. It is not possible to move the shared disks before the installation starts.

1. Onthe additional cluster node, run the software provisioning manager [page 95] and in the
Welcome screen, choose [ <Product> j» <Database> » SAP Systems » <System> » High-Availability

System » MaxDB Database Configuration 3.
2. Follow the instructions in the software provisioning manager dialogs and enter the required parameter
values.

A\ Caution

* Make sure that you enter the same drive as you did on the first database node [page 206].

* Make sure that you distribute the SAP MaxDB software and logs correctly to local and shared disks
as described in Directories in a Microsoft Failover Cluster Configuration [page 199].

i Note

For more information about the input parameters, position the cursor on a parameter and press the
key in the software provisioning manager.

8.4.4 Installing the Database Instance

This procedure describes how to install the database instance on the first cluster node.
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Prerequisites

* The SAP cluster group is Online on the first cluster node.

¢ The MaxDB cluster group is Online on the first cluster node.

Procedure

Perform the following steps on the first cluster node.

1. Run the software provisioning manager [page 95] and on the Welcome screen, choose [ <Product>
» <Database> » SAP Systems » <System> » High-Availability System ¥ Database Instance J.
2. Follow the instructions in the software provisioning manager dialogs and enter the required parameter
values.
1. For the profile directory you have to use the UNC path of the virtual ASCS ASCS instance and SCS
host name, for example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
In an HA-system, the virtual host name of the ASCS ASCS instance and SCS instance is the same as
the SAP global host name.
2. When the software provisioning manager prompts you for the database host, make sure that you enter
the virtual database host name.

i Note

For more information about the input parameters, position the cursor on a parameter and press the key
in the software provisioning manager.

8.4.5 Configuring the Additional Cluster Node

Prerequisites

* You have already performed the First Cluster Node [page 205] option.

Context

When you run the Additional Cluster Node option it:

¢ Configures the additional cluster node to run the SAP cluster group

* Creates the saploc share, pointing to a local disk

* Installs the enqueue replication server instance (ERS) for the ASCS instance
* Installs the SAP Host Agent
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A Caution

You must install the instances and SAP Host Agent on a local disk.

Procedure

1. Run the software provisioning manager [page 95] and on the Welcome screen, choose |# <Product>
» <Database> » SAP Systems j» <System> ¥ High-Availability System » Additional Cluster Node 7.

i Note

If the software provisioning manager prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

i Note

For more information about the input parameters, position the cursor on the parameter and press
in the software provisioning manager.

A\ Caution

Do not accept default values, as they may come from SAP systems that already exist on the cluster.

Related Information

Moving Cluster Groups, or Services and Applications, or Roles [page 212]

8.4.6 Installing the Primary Application Server Instance
Use

You have the following options to install the primary application server instance:

* You install the primary application server instance on a cluster node.
The MaxDB cluster group is online on this node if it is located in the same cluster as the primary
application server instance.

* Youinstall the primary application server instance on a host outside of Microsoft Failover Cluster.
In this case, you have to install the database client software on this host.
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Procedure

1. Run the software provisioning manager [page 95] and on the Welcome screen, choose |¢ <Product>
» <Database> » SAP Systems » <System> ¥ High-Availability System ¥ Primary Application Server
Instance .

2. If the software provisioning manager prompts you to log off, choose OK and log on again.

3. Follow the instructions in the software provisioning manager dialogs and enter the required parameter
values.

i Note

* For more information about the input parameters, position the cursor on a parameter and press
in the software provisioning manager.

* |fyouinstall the primary application server instance on an cluster node, make sure that on the
screen General SAP System Parameters for the:

* Profile Directory, you use the UNC path (not the local path) of the SAPGLOBALHOST host name,
for example:, for example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
In a high availability system, the virtual host name of the ASCS instance is the same as the SAP
global host name.

i Note

If you are installing a SAP NetWeaver 7.5 Process Integration (PIl) system, make sure that
the virtual host names for the ASCS instance and the SCS instance are different.

* |Installation Drive, you choose the local disk where you want to install the primary application
server instance.

4. Check that the primary application server instance is running.

8.4.7 Installing the Additional Application Server Instance

You have to install at least one additional application server instance for Microsoft Failover Clustering.
You have the following options, to install the additional application server instance:

* You install the additional application server instance on a cluster node.
The MaxDB cluster group is online on this node if it is located in the same cluster as the additional
application server instance.

* Youinstall the additional application server instance on a host outside of the failover cluster.
In this case, you have to install the database client software on this host.
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Procedure

1. Run the software provisioning manager [page 95] and on the Welcome screen, choose |¢ <Product>
» <Database> » SAP Systems j» <System> » High-Availability System ¥ Additional Application Server
Instance .

2. If the software provisioning manager prompts you to log off, choose OK and log on again.

3. Follow the instructions in the software provisioning manager dialogs and enter the required parameter
values.

i Note

* For more information about the input parameters, position the cursor on a parameter and press
in the software provisioning manager.

* |f youinstall the additional application server instance on an cluster node, make sure that on the
screen General SAP System Parameters for the:

* Profile Directory, you use the UNC path (not the local path) of the SAPGLOBALHOST host name,
for example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
In a high availability system, the virtual host name of the ASCS instance is the same as the SAP
global host name.

* Installation Drive, you choose the local disk where you want to install the additional application
server instance.

* Additional application server instance, you enter the same instance number as for the primary
application server.

4. When you have finished, change the instance profile of the additional application server instance so that
the number of its work processes equals the number of work processes of the primary application server
instance.

5. Ifrequired, install more additional application server instances outside of the failover cluster.

i Note

Make sure that on the screen General SAP System Parameters for the Profile Directory, you use the
UNC path of the virtual ASCS host name, for example:

\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.

In a HA-system, the virtual host name of the ASCS instance is the same as the SAP global host name.

8.5 Post-Installation

To complete and check the installation of the SAP system for a high-availability configuration, you need to
perform the following steps:

1. You install the permanent SAP licenses on all cluster nodes.
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2. After a new installation of a clustered ASCS instance, make sure that you update the saprc.dl 1 (part
of the NTCLUST . SAR) package in c:\windows\system32 as soon as possible. For more information, see
SAP Note 1596496 ¢

3. For information about Rolling Kernel Switch on Windows Failover Clusters, see SAP Note 2199317 .

4. You perform the post-installation checks for the enqueue replication server.
For more information, see the SAP Library at:

SAP Release and SAP Library Quick Link SAP Library Path (Continued)

® SAP NetWeaver 7.3
http://help.sap.com/nw73#

® SAP NetWeaver 7.3 including Enhancement
Package 1 Enqueue Server > Installing the Standalone Enqueue Server >

|} Application Help > Function-Oriented View > Application

Server » Application Server Infrastructure # Standalone

http://help.sap.com/nw731# > Replication Server: Check Installation 3

® SAP NetWeaver 7.4
http://help.sap.com/nw74 P

® SAP NetWeaver 7.5
http://help.sap.com/nw75 SAP NetWeaver Application Server > Standalone Enqueue

|} Application Help > Function-Oriented View > Application

Server ¥ Application Server Infrastructure  Components of

* SAP NetWeaver Application Server for ABAP 7.51 Server » Installing the Standalone Enqueue Server »

innovation package > Replication Server: Check Installation }
https://help.sap.com/nw75labap

® SAP NetWeaver AS for ABAP 7.52
https://help.sap.com/nw752abap &

5. If required, you perform the general post-installation steps [page 116] listed in this guide.

8.6 Additional Information

The following sections provide additional information about:

* Moving Cluster Groups, or Services and Applications, or Roles [page 212]
* Starting and Stopping the SAP System in a Microsoft Failover Cluster Configuration [page 213].

8.6.1 Moving Cluster Groups, or Services and Applications, or
Roles

Use

When you reboot during the conversion to Microsoft Failover Clustering, cluster resources fail over to the other
cluster node. Therefore, you have to return the system to the state it was in before the reboot, and move the
resources back to the original node.
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To move the database, or ASCS from one cluster node to the other, you use the following:

To move the database, or ASCS from one cluster node to the other, you use either the Failover Cluster Manager
tool or PowerShell.

i Note

Microsoft changed the term “cluster groups” in the Failover Cluster Manager tool to Roles. If you use
PowerShell, the term “cluster group” is still used for all cluster operations.

Procedure

Moving Roles, or Services and Applications, or Groups
To move the roles or services and applications, proceed as follows:

e 1. Tomove arole, open PowerShell in elevated mode, and enter the following command:
move-clustergroup '<role name>"

2. Repeat these steps for each role that you want to move.
* Moving Roles or Cluster Groups
To move the roles proceed as follows:

1. To move arole, open PowerShell in elevated mode, and enter the following command:
move-clustergroup -name "<role name>"

2. Repeat these steps for each role that you want to move. If you have more than 2 nodes in your cluster,
you can specify the specific cluster node for the move:
move-clustergroup -name "<role name>"-Node "<cluster node name>"-Wait O

8.6.2 Starting and Stopping the SAP System in a Microsoft
Failover Cluster Configuration

An SAP System in an HA configuration is typically configured into two HA groups: one cluster resource group
contains the database resources, the other group contains the SAP ASCS instance.

i Note

When starting a whole SAP system, you first need to start the database instance and then the remaining
SAP instances.

When stopping a whole SAP system, you first need first to stop all SAP instances and then the database
instance.

With the SAP MMC, or SAPControl you can start and stop all SAP instances whether they are clustered or not,
except the database instance.

With certain HA administration tools (Cluster Administrator , Failover Cluster Manager , or PowerShell), you can
only start or stop clustered SAP instances, such as the ASCS instance, or the database instance.
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Procedure

Starting and Stopping a Complete System or a Single Instance with SAP MMC or SAPControl

With the SAP MMC, or the command line tool SAPControl, you can start or stop the complete SAP system or a
single clustered or non-clustered SAP instance, except the database instance.

To start or stop the database instance, you have to use the tools described in “Starting and Stopping the
clustered ASCS and Database Instance”.

For more information about SAP MMC or SAPControl, see Starting and Stopping the SAP System [page 176].

i Note

* Touse SAP MMC or SAPControl for starting or stopping a clustered SAP instance, the ""'SAP <SAPSI1D>
<Instance_Number> Service" resource of the clustered instance must be online. Therefore, SAP
recommends keeping the ""'SAP <SAPSID> <Instance_Number> Service" cluster resource always
online, and using the SAP MMC or SAPControl to start or stop a clustered instance.

* You can also start SAPControl in the PowerShell.

Starting and Stopping the clustered ASCS and Database Instance

With certain HA administration tools, such as PowerShell, or Failover Cluster Manager , you can only start or
stop clustered SAP instances, such as the ASCS instance or the database instance. For all other non-clustered
instances, such as additional application server instances or the primary application server instance, you must
use the SAP MMC or SAPControl.

* Using PowerShell

To start or stop the clustered ASCS instance or the database instance with PowerShell do the following:

1. To start the clustered database instance, open PowerShell in elevated mode, and enter the following
command:
start-clusterresource <database resource>

2. To start the clustered ASCS instance, open PowerShell in elevated mode, and enter the following
command:
start-clusterresource ""SAP <SAPSID> <Instance_Number> Instance"

3. To stop the clustered ASCS instance, open PowerShell in elevated mode, and enter the following
command:
stop-clusterresource "SAP <SAPSID> <Instance_Number> Instance"

4. To stop the clustered database instance, open PowerShell in elevated mode, and enter the following
command:
stop-clusterresource <database resource>

¢ Using the Failover Cluster Manager
With the Failover Cluster Manager, you can only start or stop clustered instances such as the ASCS
instance or the database instance.
For all other non-clustered instances, such as additional application server instances or the primary
application server instance, you must use the SAP MMC or SAPControl.
To start or stop the clustered ASCS instance or the database instance with the Failover Cluster Manager do
the following:

1. Start the Failover Cluster Manager by choosing | Start » Administrative Tools » Failover Cluster
Manager 3.
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2. To start the database instance, right-click the database instance <Database_Resource>, and choose
Bring this resource online.

3. Tostart the ASCS instance, select the relevant service and application SAP <SAPSID>.
In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID>
<Instance_Number> Instance, and choose Bring this resource online.

4. To stop the ASCS instance, select the relevant service and application SAP <SAPSID>.
In the right-hand pane, under Other Resources, right-click the resource SAP <SAPSID>
<Instance_Number> Instance, and choose Take this resource offline.

5. To stop the database instance, right-click the database instance <Database_Resource>, and choose
Take this resource offline.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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